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Send Us Your Comments

Oracle® Retail Fiscal Management User Guide, Release 14.2

Oracle welcomes customers' comments and suggestions on the quality and usefulness 
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example:

■ Are the implementation steps correct and complete?

■ Did you understand the context of the procedures?

■ Did you find any errors in the information?

■ Does the structure of the information help you with your tasks?

■ Do you need different information or graphics? If so, where, and in what format?

■ Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell 
us your name, the name of the company who has licensed our products, the title and 
part number of the documentation and the chapter, section, and page number (if 
available).

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number 
(optional).

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services. 

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at http://www.oracle.com.

Note: Before sending us your comments, you might like to check 
that you have the latest version of the document and if any concerns 
are already addressed. To do this, access the Online Documentation 
available on the Oracle Technology Network Web site. It contains the 
most current Documentation Library plus all documents revised or 
released recently.
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Preface

The Oracle Retail Fiscal Management (ORFM) User Guide explains the Oracle Fiscal 
Management System that handles the fiscal operations and requirements of the 
Brazilian fiscal system.

This guide describes the ORFM user interface. It provides step-by-step instructions to 
complete most tasks that can be performed through the user interface.

Audience
This User Guide is for users and administrators of Oracle Retail Product. This includes 
merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
For more information, see the following document in the Oracle Retail Fiscal 
Management Release 14.2 documentation set: 

■ Oracle Retail Fiscal Management Release Notes

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name



xiv

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for 
example, 14.1) or a later patch release (for example, 14.1.3). If you are installing the 
base release, additional patch, and bundled hot fix releases, read the documentation 
for all releases that have occurred since the base release before you begin installation. 
Documentation for patch and bundled hot fix releases can contain critical information 
related to the base release, as well as information about code changes since the base 
release.

Improved Process for Oracle Retail Documentation Corrections
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in 
the case of Data Models, to the applicable My Oracle Support Documentation 
container where they reside.

This process will prevent delays in making critical corrections available to customers. 
For the customer, it means that before you begin installation, you must verify that you 
have the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.ht
ml

An updated version of the applicable Oracle Retail document is indicated by Oracle 
part number, as well as print date (month and year). An updated version uses the 
same part number, with a higher-numbered suffix. For example, part number 
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all 
previous versions.

Oracle Retail Documentation on the Oracle Technology Network
Oracle Retail product documentation is available on the following Web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-10
0266.html

(Data Model documents are not available through Oracle Technology Network. You 
can obtain them through My Oracle Support.)

Conventions
The following text conventions are used in this document:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Overview

This user guide provides you information on how to effectively use Oracle Retail 
Fiscal Management (ORFM). 

This chapter contains the following information:

■ Brazil Localization Overview

■ About Oracle Retail Fiscal Management

■ Business Processes

Brazil Localization Overview
The movement of merchandise has to be accompanied by a fiscal document called 
Nota Fiscal (NF). The shipping location has to generate the NF. When the truck arrives 
at its destination, and before the physical receiving of the merchandise, the NF has to 
be validated against the Purchase Order (PO) and the Brazilian fiscal system, in order 
to ensure that all the taxes are applied correctly.

An introduction to Nota Fiscal (NF) and Nota Fiscal Eletrônica (NF-e) can be found in 
the Oracle Retail Fiscal Management Implementation Guide.

About Oracle Retail Fiscal Management 
ORFM system enables you to verify the merchandise costs, quantities, and taxation 
details before payment. In ORFM, data can be entered manually, through Electronic 
Data Interchange (EDI), and the new electronic Invoice Receiving Layer (IRL). It 
integrates all the fiscal operations of the Brazilian fiscal system into RMS. It deals with 
creation of, and the receiving process of Nota Fiscal (NF), in addition to the issuing 
and printing of NF.

Business Processes
ORFM supports the following fiscal business operations:

■ PO Receiving – This is the regular buying process of a retailer. The retailer issues a 
purchase order (PO) when buying the merchandise from a supplier. When the 
merchandise is received, this merchandise is matched against the related PO in 
order to verify that the receiving merchandise has the items that the retailer has 
bought from the supplier. The retailer issues a PO when buying the merchandise 
from a supplier.

In case of discrepancies, the ORFM application supports resolving the cost, 
quantity and tax discrepancy. For more information on how the application 
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resolves the discrepancies, refer to the Discrepancy Identification and Resolution 
Process.

■ Transfers – Transfer is the movement of merchandise from one location to another, 
either a warehouse or a store. When the transfer is issued, ORFM creates and 
issues the related NF (based on the transfer information) for the merchandise to be 
transferred out. After the merchandise is shipped and received in the other 
location, another inbound NF is created to receive the merchandise in the 
receiving location.

■ Return to Vendor (RTV) – This business process needs the creation and issue of a 
NF in order to return the merchandise to the supplier. The ORFM application 
issues a NF for the merchandise to be sent back to the supplier.

■ Return from customers or Return Merchandise Authorization (RMA) – When 
customer returns merchandise, the retailer issues a RMA in order to receive the 
merchandise in the store. Since this operation involves the movement of 
merchandise, a NF has to be issued to receive it.

■ Triangulation Purchase Order – Triangulation is a process where in the retailer 
creates the PO with the main supplier to whom the payment is made. However, 
another supplier (a distributor or facilitator) delivers the stock on behalf of the 
main supplier (referred to as the delivery supplier).

Discrepancy Identification and Resolution Process
In the inbound PO process, additional validations and matching of quantity, tax and 
cost need to be carried out before physical receiving of merchandise. If there are any 
discrepancies during fiscal receiving, the retailer must resolve and validate the 
correctness of the NF before approving the physical receipt. 

The overall discrepancy identification and resolution process can be further divided 
into the following sub-processes:

■ Validation Process – The validation process includes validating the NF for errors 
like incorrect CFOP, header totals, etc. If there are errors on the NF, it is logged in 
the Error Log window. The NF has to be manually edited to resolve these errors, 
and the NF has to be re-validated. The validation process has the following three 
steps:

– Data Integrity Validation – In this process, all the NF totals are matched with 
the unit cost and quantity entered. This process takes into account the line 
item level and header level discounts, non-merchandise cost, insurance, 
miscellaneous expenses, and taxes while comparing the totals. If the data 
integrity validation fails, the NF will be in Error status.

– Tax Engine Call for Tax Breakup – A call is made to the Tax Engine for 
comparing the taxes on NF with system calculated taxes. The taxes returned 
by Tax Engine are stored at the individual item level. In case of any error 
during the Tax Engine call, status of the NF is changed to Error, and it has to 
be validated again.

■ Discrepancy Identification – In this process, the unit cost and quantity of each item 
and the taxes on the NF are compared with the corresponding values in the 
system. Any discrepancy identified during this process, the discrepancy indicators 
are marked appropriately on the NF header. The quantity or cost discrepancy 
between the purchase order and NF, and tax discrepancy on the NF and the tax 
returned by Tax Engine is identified during this process. For tax discrepancy, the 
ORFM application validates that the NF has used the correct tax rules to calculate 
the taxes.
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■ Discrepancy Resolution Process – Any discrepancies identified during the 
discrepancy identification process are available in the Discrepancy Resolution 
window. These discrepancies have to be resolved manually. In a centralized 
operation it is mandatory to resolve quantity discrepancies in order to proceed 
with physical receiving. In case of a de-centralized operation it is mandatory to 
resolve all discrepancies (cost, quantity and tax) in order to proceed with physical 
receiving to complete the receiving process.

■ Generation of Return NF, and Merchandise without NF Report – If the NF 
quantity is greater than the related PO quantity, a return NF is generated, which is 
for the supplier to take back the exceeded stock. Sometimes, the merchandise is 
returned at the point of receipt in order to reduce shipping costs. The calculation 
of Return NF quantity and Merchandise without NF quantity is done after the 
physical receiving is done. 

■ Generation of Correction Letter – A correction letter is generated when the PO 
cost/quantity/tax is different from the NF cost/quantity/tax, and the PO 
cost/quantity/tax is considered to be correct. The correction letter, with the PO 
values as the NF values, is automatically generated after all the discrepancies are 
resolved, depending on the discrepancy resolution action.
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2Foundation Data

ORFM has its own Foundation Data and shares with Merchandising. The foundation 
data has to be configured for the proper functioning of the ORFM application.

This chapter covers the following sections:

■ Foundation Data Setup

■ System Options

■ Tolerance Parameter

■ Location Fiscal Numbers

Foundation Data Setup
ORFM Foundation Data Setup includes setting up the utilization codes, related 
parameters, and document type codes.

Requisition Types
Requisition Type indicates the type of transaction that ORFM supports. ORFM 
supports the following requisition types:

■ Purchase Order (PO) – applicable when there is movement of merchandise from a 
supplier to retailer’s location.

■ Transfer (intra-company) – applicable when there is movement of merchandise 
from one location to another, either a warehouse or a store.

■ Intercompany Transfer – applicable when there is a movement of merchandise 
between companies.

■ Return to Vendor (RTV) – applicable when the merchandise is returned to the 
vendor. 

■ Repairing – applicable when merchandise is sent out to the external finisher or the 
supplier for finishing work (such as printing, dyeing, and embroidery) or repair 
(in the case of damaged goods).

■ Return Merchandise Authorization (RMA) – applicable when the retailer to pick 
up merchandise that is being returned from the customer.

■ Inventory Adjustment (STOCK) – applicable when it is necessary to adjust 
quantity in inventory quantity for one or more item/locations.

■ Direct NF (DNF) - applicable when used to distinguish StandAlone NFs from 
Other NFs created within ORFM.



Foundation Data Setup

2-2 Oracle® Retail Fiscal Management User Guide

■ Free Form NF (FFNF) - applicable when the user wishes to add generic 
items/services that are not present in RMS to the NF or use fiscal entities that are 
not defined in RMS. This is a StandAlone NF that is not related to any RMS 
transaction.

■ Customer Order Drop Ship - applicable to support customer orders which will be 
shipped directly from the supplier to the customer, often referred to as drop ship 
orders. 

■ Sales - applicable to support any customer order transaction.

■ Return NF (RNF) - applicable to support automatic return to vendor NF 
generated, based on discrepancy treatment at receiving.

■ PO for Rural Producer (RPO) - applicable to support generation of Entry NF 
called 'contra-nota' for Rural Producers and ORFM issues an electronic Nota Fiscal 
(NF-e) to entry goods.

Nature of Operation
Nature of Operation (NOP) is a term used in Tax Engine. The nature of operations 
represents the transactions used to deduce the Código Fiscal de Operações e 
Prestações (CFOP) codes in tax rules. There can be more than one utilization for the 
same NOP. For each Tax Engine call to retrieve taxes, ORFM returns the NOP related 
to the transaction to Tax Engine.

Mode
Mode indicates whether the NF is being created for inbound, or outbound operations. 
The possible values for Mode are Inbound (Entry), and Outbound (Exit).

Utilization Code Maintenance
All merchandise in ORFM is associated with a utilization code. This code provides 
information about the transaction type and the NF related to the transaction. This 
information is used to determine the appropriate taxes for the merchandise as well as 
the impact on warehouse stock and on costs.

Each utilization code is linked to a Requisition Type, a NOP, and one or more 
document types.

Adding Utilization Code
To add a Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Fiscal 
Configuration. 

1. In the Contents Of Fiscal Configuration, select Fiscal Utilization. 

2. In the Contents Of Fiscal Utilization window, click Edit. The Fiscal Utilization 
Setup window opens.

Note: ORFM and RMS are integrated with Tax Engine to get the tax 
break up for the NF. Tax Engine requires NOP to derive the CFOP 
before tax calculations. Therefore, ORFM maintains the list of NOP 
and enables you to link utilization and NOP.
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Figure 2–1 Fiscal Utilization Setup Window 

3. On the Fiscal Utilization Setup window, click Add. A highlighted blank row 
appears.

4. Enter the Utilization Code, and Description. The Utilization Code is the unique 
identifier for each utilization. The Description column describes the fiscal 
utilization.

5. Select the Requisition Type from the list in the Requisition.Type column. The 
requisition types available are: Purchase Order, Transfer, Return to Vendor, Return 
Merchandise Authorization, Stock Out, PO for Rural Producer, InterCompany 
Transfers, Repairing, Return NF, Direct NF, FreeForm NF, Customer Order 
Dropship, and Sales.

6. Select the Issue type from the list in the Issue column. The issue types are: Issue or 
Include. The drop-down is enabled if the Requisition Type is either, Direct NF or 
Free from NF. The drop-down value of Issue indicates that the utilization code is 
relevant for cases wherein the Retailer is issuing the NF. When utilization codes 
classified as Issue are used for StandAlone NF creation, the Fiscal number, Serial, 
and Sub Serial Number fields are populated based on Location sequencing Logic. 
The drop-down value Include, indicates that the NF is issued by an external 
system. StandAlone NFs using utilization code classified as Include will have a 
mode type of entry and it allows for manual entry of the Fiscal number 
information.

7. Select the Nature of Operation.

8. Enter the mode of operation (Entry or Exit).

Deleting Utilization Code
1. On the Fiscal Utilization Setup window, select the utilization you want to delete, 

and click Delete. The following message is displayed:

Note: Click View in the Contents Of Fiscal Utilization window to 
view the fiscal utilization codes. In the View mode, the multi-record 
block is non-editable, and the Add and Delete buttons are disabled.
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Figure 2–2 Message Window

2. Click Yes to delete the utilization.

Fiscal Utilization Options
The Fiscal Utilization Options menu consists of the following items:

■ Document Type

■ Parameters

■ Reason Code

Document Type
The utilization code is linked to one or more document types, and each fiscal 
document type has to be associated with a utilization code.

Adding Doc Type  

To add Doc Type to the Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal 
Configuration.

1. In the Contents Of Fiscal Configuration window, select Fiscal Utilization. 

2. In the Contents Of Fiscal Utilization window, click Edit. The Fiscal Utilization 
Setup window opens.

3. In the Fiscal Utilization Setup window, select the Utilization Code for which Doc 
Types are being defined.

4. From the Options menu, select Doc Type. The Fiscal Utilization Document Type 
window opens.

Note: You can delete the utilization codes only if they are not 
associated with any NF.

Note: Click View in the Contents Of Fiscal Utilization window to 
view the fiscal utilization codes. In the View mode, the multi-record 
block is non-editable, and the Add and Delete buttons are disabled.
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Figure 2–3 Fiscal Utilization Document Type Window

5. Click Add. A highlighted blank row is displayed. 

6. From the Doc Type ID LOV, select the value. 

7. Click OK to exit the window.

Deleting Doc Type  

To delete document types, do the following in the Fiscal Utilization - Document Type 
window:

1. Select the doc type that you want to delete. Click Delete in the Fiscal Utilization - 
Document Type window.

A message appears. Click Yes to delete the document type.

2. Click OK to exit the window.

Parameters
Parameters are defined for each of the utilization codes.

To associate the parameters with the utilization codes, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal 
Configuration.

In the Contents Of Fiscal Utilization, select Edit. The Fiscal Utilization Setup window 
opens.

1. On the Fiscal Utilization Setup window, click the Options menu.

2. Select Parameters. The Fiscal Utilization Attributes window opens.
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Figure 2–4 Fiscal Utilization Attributes Window

3. Select or deselect the check boxes to configure the parameters for every Utilization 
Code. 

Table 2-1 provides the list of parameters, and their description.

Table 2–1 Parameters of Fiscal Utilization Attributes

Field Description

Complementary NF Indicates this utilization is used to Complementary NF when 
you select the Complementary NF check box, the 
Complementary NF Type list is enabled.

This field can be editable only if there is no NF using this 
utilization code. After this, this parameter will be dimmed.

Complementary NF Type Choose the Complementary NF type from the Complementary 
NF Type list:

■ Triangulation

■ Non-Merchandise cost

■ Cost/Tax Correction

■ Exit CNF

■ Transfers

ICMS-ST Recovery Select this check box to indicate that the particular transaction 
maintains records for recovery of the Imposto sobre Circulação 
de Mercadorias e Serviços - Substituição Tributária (ICMS-ST) 
tax.

This flag is used for entry or exit transactions and when it is 
selected, the flag for entry or exit utilization is selected, the 
FlagGravaHistorico field is sent as the following values:

■ If PO Receiving, location with ST control ON, NF status = 
Approved and utilization = "ICMS-ST Recovery": 
FlagGravaHistorico = 2.

■ If NF Issuing, location has ST control ON and utilization = 
"ICMS-ST Recovery": FlagGravaHistorico = 3.

Item Utilization This field is sent to Tax Rules when populating the Freight 
Object. Click the Item Utilization LOV to obtain the following 
values. 

■ Commercialization (C): item intended to commercialization

■ Industrialization (I): item intended to industrialization
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Reason Code
The Reason Code is created by the retailer for inventory adjustment, only when 
Requisition Type is STOCK operations for other Requisition Types, this option will be 
dimmed.

A utilization can have any number of Reason Codes attached to it. However, the 
Reason Code cannot be attached to utilization if the Reason Code is already attached 
to any other Utilization ID. The Reason Code LOV shows only the Reason Codes that 
are not attached to any type of utilization ID.

To associate Reason Code with the Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal 
Configuration.

1. On the Fiscal Utilization Setup window, click the Options menu.

2. Select the inventory adjustment for which you want to add the Reason Code. From 
the Options menu, select Reason Code. The Fiscal Utilization Reason Codes 
window opens.

Automatic NF Approval Select this check box to validate and approve the fiscal 
documents automatically. 

Automatic NF approval is relevant only for outbound NFs 
generated by ORFM. The user can set it by utilization, so, it is 
possible to approve all intra-company NFs automatically but 
manually approve RTV NFs.

Allow Receiving This indicator is only used for inbound NFs. 

Select this check box to enable the schedule submission message 
flow to the Warehouse Management System (RWMS) or the 
Store Inventory Management System (SIM).

In case of complementary NFs, since there is no physical 
receiving, this indicator is disabled.

NF e Manifest Indicates if utilization has NF-e manifest for inbound NFs.

Choose NF Select this check box to choose the referential Fiscal Document. 
This indicator is relevant for RTV related utilizations only.

Import Order NF Select this check box if this utilization ID is for a PO NF that will 
supports Importation transactions.

If the Import Order Type is Direct Import, the Complementary 
NF cannot be setup as Triangulation as there is no Triangulation 
for Direct Import Order currently supported in the system.

Import Order Type Choose the Import Order Type from the Import Order Type list: 

■ Direct Import 

■ Import on behalf of Third Parties

■ Import By Order

Table 2–1 (Cont.) Parameters of Fiscal Utilization Attributes

Field Description
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Figure 2–5 Fiscal Utilization Reason Codes Window

3. Click Add. In the highlighted row that appears, select the reason code from the 
list.

4. Click OK. The reason code is associated with the inventory adjustment. 

To delete the reason code, do the following in the Fiscal Utilization Codes Reason 
Codes window:

1. Select the reason code that you want to delete. Click Delete in the Fiscal 
Utilization Codes Reason Codes window. A message appears. Click Yes to delete 
the reason code.

2. Click OK to exit the window.

Fiscal Document Types Maintenance
The document type codes are defined by the fiscal authorities and each NF must have 
a document type code at the header level.

To associate Fiscal Document Types with a Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal 
Configuration.

1. In Contents Of Fiscal Configuration window, select Fiscal Document Types.

2. In Contents Of Fiscal Document Types, click Edit. The Fiscal Document Type 
window opens.
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Figure 2–6 Fiscal Document Type Window

3. Select the document type from the list. The list contains the all possible Fiscal Doc 
Types. The list displays the Fiscal Document Type ID and Description.

4. Click Add to add a fiscal document type. A new highlighted row is displayed.

5. The Description field displays the Fiscal Document Type description.

6.  Click OK to exit the window.

To delete the document type, do the following:

1. Select the document type that you want to delete. Click Delete. A confirmation 
message appears.

2. Click Yes to delete the document type. 

3. Click OK to exit the window.

Fiscal Doc Type
To associate the document type with the Utilization Code, do the following: 

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal 
Configuration.

1. Select the document type to which you want to associate a Utilization Code. 

2. Click Util button in the Fiscal Document Type window. The Fiscal Doc Type 
Utilization window opens.
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Figure 2–7 Fiscal Doc Type Utilization Window

3. Click Add in the Fiscal Doc Type Utilization window.

4. A new row appears. Select the Utilization Code from the list. 

5. Click OK to save your changes and exit the window.

To delete the utilization, do the following:

1. To delete a utilization, select the utilization, and click Delete. 

2. Confirm the deletion in the message that appears. Click OK to exit the window.

System Options
Set up the system configuration variables using the System Setup link.

General System Options

Variable ALLOW_SUBMIT_DATE

Description Check Entry_Or_Exit Date and Exit Hour fields for all NF in a 
schedule during submit for receiving process is greater than system 
date

Valid Value Y: If greater than system date, user will be not able to submit schedule 
for receiving

N: If greater than system date, user will be able to submit schedule for 
receiving.

Variable CLEAR_CALC_STG_TABLES_ONLINE

Description Behavior to clear stage tables for data from tax call.

Valid Value Y: The delete the stg data Online after each tax call

N: The delete will be done in purge batch process later

Variable DEBIT_MEMO_TRAN_CODES
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Description Tran Codes which must be posted as look up code CREDIT in AP 
header staging.

Valid Value Valid RFM Tran codes separated by comma.

Variable DEFAULT_ACTION_REQ_PARM

Description Default Action Required Parametrization list.

Valid Value Default value: ARBS

Variable DEFAULT_COST_TAX_NOP

Description Default cost tax calls NOP.

Valid Value Valid NOP. Default 001 when tax engine is TaxWeb.

Variable DEFAULT_COUNTRY

Description Default supplier country

Valid Value Default value: BR

Variable DEFAULT_CURRENCY

Description Default currency code

Valid Value Default value: BRL

Variable DEFAULT_NOP

Description Default Nature of Operation used when there is no NOP is defined in 
Purchase transactions.

Valid Value Valid NOP. Default 001 when tax engine is TaxWeb

Variable DEFAULT_REF_MESSAGE_ICMS_ST

Description ICMS-ST retido anteriormente, Base Cálculo R$ %s1, Valor Retido R$ 
%s2.

Valid Value

Variable DEFAULT_RETAIL_TAX_NOP

Description Default Nature of Operation used when there is no NOP is defined in 
Sales transac-tions.

Valid Value Valid NOP. Default 002 when tax engine is TaxWeb

Variable ENABLE_DEBUG

Description Indicates whether to save the debug messages on the debug table 
(FM_DEBUG)
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Valid Value Y: Enable

N: Disable

Variable ENABLE_LOG_RFM_TAX

Description Log tax payload from third-party tax engine into RFM log tables for 
RFM tax.

Valid Value Y: Enable

N: Disable

Variable ENABLE_LOG_RMS_TAX

Description Log tax payload from third-party tax engine into RFM log tables for 
RMS tax.

Valid Value Y: Enable

N: Disable

Variable ENABLE_PREV_CFOP_TAXCALL

Description Enables on FM_T_EXT_TAXES_SQL.LOAD_NF_OBJECT the 
execution of cursor C_GET_ORIG_CFOP_TSF.

Valid Value Y: Enable

N: Disable

Variable EXT_TAX_PROVIDER

Description Indicates which external tax provider is integrated with the system.

Valid Value TAXWEB

Variable FM_NOTIFY_RIB_INTEGRATION

Description Indicates if status integration uses RIB

Valid Value Y: Enable

N: Disable

Variable HOUR_FORMAT

Description Format to represent fields of hour. Must be HH24:MI or HH:MI AM.

Valid Value Default Value: HH24:MI

Variable NF_BREAKUP_TAX_REGIME

Description Identify the attribute for breaking the NF

Valid Value Default Value: ITEM_UNDER_ST_REGIME

Variable NUMBER_FORMAT
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NF-e System Options

Description Value Field Format

Valid Value Default Value: FM9G999G999G999G990D90PR

Variable NUMBER_FORMAT_4

Description Value Field Format for 4decimal

Valid Value FM9G999G999G999G999G900D9000

Variable PACK_COMP_FISCAL_REPORTING

Description Change the way RFM and RMS handle the publication of the NFs and 
the stock position to SPED.

Valid Value PACK: by Pack

COMP: by Component

Variable PERCENT_FORMAT

Description Percentage Field Format

Valid Value Default Value: FM9G999G999G999G999G990D9000"%"

Variable QTY_FORMAT

Description Quantity Field Format

Valid Value Default Value: FM9G999G999G999G999G900D9000

Variable RECOVERABLE_TAX_CST

Description Value related to the selected CST

Valid Value Default Value: 060

Variable CEST_MANDATORY

Description Indicates if it's mandatory to inform the CEST code during NF 
receiving.

Valid Value Y: Mandatory

N: Optional

Variable DEFAULT_FREIGHT_TYPE

Description Default freight type used by the process to create an EDI document 
based on external systems.
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Valid Value 0 - Freight contracted by Sender (CIF)

1 - Freight contracted by Addressee (FOB)

2 - Freight contracted by Third Parties

3 - Own Carrier on behalf of the Sender

4 - Own Carrier on behalf of the Addressee

9 - No freight occurrence

Variable DEFAULT_NFCE_DOC_TYPE

Description Default Document Type for NFCe

Valid Value Valid document type

Variable DEFAULT_NFCE_MODEL_CODE

Description Default Document Type for Customer NFE (NFC-e)

Valid Value Default Value: 65

Variable DEFAULT_NFE_DOC_TYPE

Description Default Document Type for NF-e

Valid Value Valid document type

Variable DEFAULT_NFE_IND_TYPE

Description Active NFe (Nota Fiscal Eletrônica)

Valid Value Y: Enable

N: Disable

Variable DEFAULT_VERSAO_NFE

Description Default value to be sent in RMS tax calls for the field "VersaoNFe".

Valid Value 4.00: NF-e Version 4.00 

3.10: NF-e Version 3.10

Variable DEFAULT_NFE_MODEL_CODE

Description Default Document Type for NF-e

Valid Value Default Value: 55

Variable DEFAULT_PAYMENT_METHOD

Description Default Payment Method
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Valid Value 01 - Cash

02 - Check

03 - Credit Card

04 - Debit Card

05 - Store Card

10 - Voucher (VA - Vale Alimentação)

11 - Voucher (VR - Vale Refeição)

12 - Gift Card

13 - Voucher (VC - Vale Combustível)

15 - Bank Slip

90 - No Payment

99 - Others

Variable DEFAULT_PRENF_SERIES

Description Default PRENF series.

Valid Value Default value: PNF

Variable EXTIPI_VALIDATION

Description Indicates if EX TIPI validation is required.

Valid Value Y: Enable

N: Disable

Variable FISCAL_DOC_NO_BUFFER_SIZE

Description Size of the buffer for Fiscal Doc Numbers generated on table FM_
LOC_FISCAL_NUMBER_DETAIL

Valid Value Default Value: 10

Variable MDEST_SEFAZ

Description Indicates the number of days MDest SEFAZ.

Valid Value Default Value: 0

Variable NCM_VALIDATION

Description Indicates if NCM validation is required.

Valid Value Y: Enable

N: Disable

Variable NEXT_FISCAL_DOC_NO_RETRY_QTY

Description Number of retries to get the fiscal number if the fm_loc_fiscal_number 
table is locked

Valid Value Default Value: 5
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Orders and Complementary NF System Options

Variable NEXT_FISCAL_DOC_NO_RTRY_SLPSEC

Description Sleep seconds to retry to get the fiscal number if the fm_loc_fiscal_
number table is locked

Valid Value Default Value: 5

Variable NFE_LOC_NAME_SOURCE

Description Indicates whether the location fiscal name will be retrieved from 
transfer entity.

Valid Value Y: Enable

N: Disable

Variable NF_MAX_ITEM

Description Maximum allowable line Items on NF during the issue

Valid Value Valid number

Variable DEFAULT_COMP_57_UTIL_ID

Description Default Utilization for cost complementary CTe

Valid Value Valid utilization code

Variable DEFAULT_COMP_COST_TAX_UTIL_ID

Description Default Utilization for complementary cost NF.

Valid Value Valid utilization code

Variable DEFAULT_COMP_COST_UTIL_ID

Description Default Utilization for complementary cost NF.

Valid Value Valid utilization code

Variable DEFAULT_COMP_FREIGHT_UTIL_ID

Description Default Utilization for complementary freight NF.

Valid Value Valid utilization code

Variable DEFAULT_COMP_TAX_UTIL_ID

Description Default Utilization for complementary tax NF.

Valid Value Valid utilization code
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Variable DEFAULT_DISCREP_LEGAL_MESSAGE

Description Stores the default legal message in discrepancy resolution process.

Valid Value Default value: Valores ajustados em observância ao contrato

Variable DEFAULT_ORIGIN_CODE

Description Retrieve Origin Code from item foundation data in case user does not 
inform.

Valid Value Y: Enable

N: Disable

Variable DEFAULT_PO_TYPE

Description Default PO Type when null in ORMS (fiscal utilization code in ORFM)

Valid Value Valid utilization code

Variable DEFAULT_RURAL_PROD_DOC_TYPE

Description Default Document Type for Rural Producer

Valid Value Valid document type

Variable DEFAULT_RURAL_PROD_UTILIZATION

Description Default Utilization ID for Rural Producer NF

Valid Value Valid utilization code

Variable DEFAULT_TRIANGULATION_UTIL_ID

Description Default Utilization for triangulation NF.

Valid Value Valid utilization code

Variable DOC_TYPE_PO

Description Default fiscal doc type code

Valid Value 1 - Nota Fiscal - Modelo 1, 1A

Variable ENABLE_AUTO_UPDATE_ORIGIN_FCI

Description Enables auto update for Item-Location Origin and FCI.

Valid Value Y: Enable

N: Disable

Variable ENABLE_MANUFACTURE_UF_UPDATE

Description Indicates when manufacture UF at item/location is updated based of 
value in item/supplier after receiving PO NF
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Discrepancy Resolution and Matching Expenses for Orders System Options

Valid Value Y: Enable

N: Disable

Variable COST_MATCH_FREIGHT

Description Indicates use of the Freight in the cost discrepancies analysis.

Valid Value Y: Enable

N: Disable

Variable COST_MATCH_INSURANCE

Description Indicates use of the Insurance in the cost discrepancies analysis.

Valid Value Y: Enable

N: Disable

Variable COST_MATCH_OTHER_EXPENSES

Description Indicates use of the Other Expenses in the cost discrepancies analysis.

Valid Value Y: Enable

N: Disable

Variable COST_RESOLUTION_RULE

Description Default Resolution Action for Cost Discrepancies

Valid Value RECONCILE: when user decides discrepancy resolution.

SYS: system will automatically resolve discrepancy by system.

NF: system will automatically resolve discrepancy by NF

Variable QTY_RESOLUTION_RULE

Description Default Resolution Action for Quantity Discrepancies

Valid Value RECONCILE: when user decides discrepancy resolution.

SYS: system will automatically resolve discrepancy by system.

NF: system will automatically resolve discrepancy by NF

Variable TAX_RESOLUTION_RULE

Description Default Resolution Action for Tax Discrepancies

Valid Value RECONCILE: when user decides discrepancy resolution.

SYS: system will automatically resolve discrepancy by system.

NF: system will automatically resolve discrepancy by NF
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Deals System Options

EDI System Options

Direct Import System Options

Variable DEAL_DEF_CMPLX_TYPE

Description Default Document Type for complex deals.

Valid Value Valid document type

Variable DEAL_DEF_FXMRH_TYPE

Description Default Document Type for merchandise fixed deals.

Valid Value Valid document type

Variable DEAL_DEF_FXNMRH_TYPE

Description Default Document Type for non-merchandise fixed deals.

Valid Value Valid document type

Variable DEAL_DEFAULT_UTIL

Description Default Utilization ID for deals.

Valid Value Valid utilization code

Variable DEFAULT_DOCUMENT_TYPE

Description Default document type used by the process to create an EDI 
document based on external systems.

Valid Value Valid document type

Variable EDI_DEF_PTNR_ID

Description Indicates the default partner ID when importing EDI documents

Valid Value Valid partner ID

Variable EDI_DEF_PTNR_TYPE

Description Indicates the default partner type when importing EDI documents

Valid Value Valid partner type

Variable DEF_COMPL_CT_DI_TYPE
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Description Default document type used by DI process to create an 
Complementary DI with Cost/Tax document

Valid Value Valid document type

Variable DEF_COMPL_NM_DI_TYPE

Description Default document type used by DI process to create an 
Complementary DI with Non Merchandise Additional Cost document

Valid Value Valid document type

Variable DEF_SFTW_COMPL_CT_DI_UTIL_ID

Description Default Utilization ID for SOFTWAY Complementary NF with 
Additional Cost/Tax.

Valid Value Valid utilization code

Variable DEF_SFTW_COMPL_NM_DI_UTIL_ID

Description Default Utilization ID for SOFTWAY Complementary NF with 
Non-Merchandise Addi-tional Cost.

Valid Value Valid utilization code

Variable DEFAULT_SOFTWAY_DI_UTIL_ID

Description Default Utilization ID for SOFTWAY DI NFs.

Valid Value Valid utilization code

Variable DI_AUTO_VALIDATION

Description Enable Auto Validation for Direct Import NF

Valid Value Y: Enable

N: Disable

Variable DI_NF_SERIAL_GENERATION_IND

Description Indicates whether the fiscal number and series number are generated 
in RFM or not.

Valid Value Y: Generated by RFM

N: Generated by third-party system

Variable DI_UNIT_COST_COMP

Description Indicates which trading system being used for Importation.

Valid Value S: Softway

T: Third-party system
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Tolerance System Options

Sales and Tax Burden System Options

Stand Alone System Options

Variable PRIORITY_TSF_IPI_IMPORTED

Description Indicates the priority of import or non-imported stock on first exit

Valid Value Y: Enable

N: Disable

Variable CALC_TOL_TYPE

Description The calculation tolerance type (P/V).

Valid Value P: Percentage

V: Value

Variable CALC_TOL_VALUE

Description The calculation tolerance value.

Valid Value Number value

Variable AVERAGE_TAX_RATE_SOURCE_ENTITY

Description Name of the authorized institute that provides the average 
cumulative tax rates for op-erations to end consumers.

Valid Value Default value: IBPT

Variable DEFAULT_REF_MESSAGE_FDSHIP

Description Default legal message to inform the relation between the Shipment NF 
and the Sale NF in a future delivery scenario.

Valid Value Default value: Shipment NF related to the Sale NF number %s1

Variable END_CONSUMER_MAX_VALUE

Description Default End Customer Max Value

Valid Value Number value



System Options

2-22 Oracle® Retail Fiscal Management User Guide

Cancellation NF System Options

Variable DEFAULT_CANCEL_MESSAGE

Description Default Cancel Message for NF-e Cancellation

Valid Value Default value: NF cancelada pelo emitente

Variable DEFAULT_JUSTIF_NULLIFICATION

Description Default Justification for NF Nullification.

Valid Value Default value: Númeração Inutilizada pois não será mais utilizada

Variable ENABLE_ACCOUTING_REVERSAL

Description Indicates whether to revert accounting information for cancelled Nota 
Fiscal.

Valid Value Y: Enable

N: Disable

Variable FISCAL_CANCEL_ROLE

Description Role with privilege to NF-e cancel.

Valid Value Valid system role

Variable MANUAL_APPROVAL_PROTOCOL_MASK

Description Manual approval protocol mask.

Valid Value User defined mask

Variable MANUAL_CANCEL_ROLE

Description Role with privilege to NF-e manual cancel.

Valid Value Valid system role

Variable STOCK_REVERSAL_VIRTUAL_STORE

Description Holds the default virtual store that will be used in the inventory 
reversal process to put merchandise back to the WH.

Valid Value Valid virtual store

Variable SUGGESTION

Description Stores the justification when the Nota Fiscal is deleted by the Retailer

Valid Value Default value: NF cancelada devido a desistência da operação
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Commerce Anywhere NF System Options

Variable DEFAULT_DRSP_CO_PO_TYPE

Description Default PO Type for Drop Ship Customer Order when null in ORMS 
(fiscal utilization code in ORFM)

Valid Value Valid utilization code

Variable DEFAULT_FD_SALE_DOC_TYPE

Description Default Document Type for future delivery Customer Order SALE NF.

Valid Value Valid document type

Variable DEFAULT_FD_SALE_UTIL_ID

Description Default utilization ID for future delivery Customer Order SALE NF.

Valid Value Valid utilization code

Variable DEFAULT_FD_SHIP_DOC_TYPE

Description Default Document Type for future delivery Customer Order Shipment 
NF.

Valid Value Valid document type

Variable DEFAULT_FD_SHIP_UTIL_ID

Description Default utilization ID for future delivery Customer Order Shipment 
NF.

Valid Value Valid utilization code

Variable DEFAULT_OUTBOUND_CUST_UTIL_ID

Description Default Utilization ID for outbound customer order transfers.

Valid Value Valid utilization code

Variable DEFAULT_PRESENCE_IND_CO

Description Default presence indicator

Valid Value Valid presence indicator

Variable DEFAULT_PRESENCE_IND_NFCE

Description Default presence indicator for NFCE

Valid Value Valid presence indicator

Variable DEFAULT_PRESENCE_IND_NFE
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Description Default presence indicator for NF-e

Valid Value Valid presence indicator

Variable DEFT_MULTISITE_CO_IN_IC_DOC

Description Default Document Type for Multisite Customer Order Inbound IC 
Transfers.

Valid Value Valid document type

Variable DEFT_MULTISITE_CO_IN_IC_UTIL

Description Default Utilization ID form Multisite Customer Order Inbound IC 
Transfer.

Valid Value Valid utilization code

Variable DEFT_MULTISITE_CO_IN_TSF_DOC

Description Default Document Type for Multisite Customer Order Inbound 
Transfer.

Valid Value Valid document type

Variable DEFT_MULTISITE_CO_IN_TSF_UTIL

Description Default Utilization ID for Multisite Customer Order Inbound Transfer.

Valid Value Valid utilization code

Variable DEFT_MULTISITE_CO_OUT_IC_DOC

Description Default Document Type for Multisite Customer Order Outbound IC 
Transfers.

Valid Value Valid document type

Variable DEFT_MULTISITE_CO_OUT_IC_UTIL

Description Default Utilization id for Multisite Customer Order Outbound IC 
Transfers.

Valid Value Valid utilization code

Variable DEFT_MULTISITE_CO_OUT_TSF_DOC

Description Default Document Type for Multisite Customer Order Outbound 
Transfer.

Valid Value Valid document type

Variable DEFT_MULTISITE_CO_OUT_TSF_UTIL

Description Default Utilization id for Multisite Customer Order Outbound 
Transfer.
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Inventory Adjustment System Options

Valid Value Valid utilization code

Variable DEFT_SALE_CO_DOC_TYPE

Description Default Doc Type for Outbound Customer Order (intrastate) when 
Addressee is NOT an End Consumer or an ICMS Contributor.

Valid Value Valid document type

Variable DEFT_SALE_CO_DOC_TYPE_INTRA

Description Default Doc Type for Outbound Customer Order (intrastate) when 
Addressee must be an End Consumer and must NOT be an ICMS 
Contributor.

Valid Value Valid document type

Variable DEFAULT_DNF_STOCK_DOC_TYPE

Description Default Document Type for DNF Inventory Adjustments.

Valid Value Valid document type

Variable DEFAULT_STOCK_DOC_TYPE

Description Default Document Type for Inventory Adjustments.

Valid Value Valid document type

Variable ENABLE_SIM_WS_INTEGRATION

Description Identify if when there is a NF cancellation RFM will call the SIM Inv 
Adj Web Service.

Valid Value Y: Enable

N: Disable

Variable FM_DEFAULT_REASON_CODE_NEG

Description Default Reason Code for Negatives Stock Count NF and Auto 
Approve Option

Valid Value Valid Reason Code

Variable FM_DEFAULT_REASON_CODE_POS

Description Default Reason Code for Positives Stock Count NF and Auto Approve 
Option

Valid Value Valid Reason Code
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Invoice Receiving Layer (IRL) System Options

Variable REASON_ID_INVADJ_SIM_WS_INT

Description This variable holds the reason ID used for integration with RFM/SIM 
by WSDL for re-versing negative inventory adjustment.

Valid Value Valid Reason Code

Variable REASON_ID_INVADJ_SIM_WS_INT_IN

Description This variable holds the reason ID used for integration with RFM/SIM 
by WSDL for re-versing positive inventory adjustment.

Valid Value Valid Reason Code

Variable IRL_ALLOWS_MULTISITE

Description Indicates if IRL Monitor allows multisite treatment.

Valid Value Y: Enable

N: Disable

Variable IRL_ALLOWS_WORKSHEET

Description Indicates if WORKSHEET option will be available in NF forms that 
NFs came from IRL

Valid Value Y: Enable

N: Disable

Variable IRL_AUTO_REFUSAL

Description Indicates if IRL allows automatic refusal in Pre-validation.

Valid Value Y: Enable

N: Disable

Variable IRL_AUTO_REFUSAL_DESCRIPTION

Description Indicates the default reason description to Automatic Refusal.

Valid Value Valid reason description

Variable IRL_CNAE_VALIDATE

Description Validate the Suppliers CNAE from the XML against the system

Valid Value Y: Enable

N: Disable

Variable IRL_CODE_DEDUCTION
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Description Indicates the priority of RMS transactional code deduction.

Valid Value EAN: deduction by EAN

VPN: deduction by VPN

Variable IRL_CTE_ISSUER_DEDUCTION

Description Indicates the entity type priority in the CTe Issuer deduction.

Valid Value SUPP: deduction by Supplier

PTNR: deduction by Partner

Variable IRL_LOGICAL_DELETION

Description Indicates if IRL allows logical deletion.

Valid Value Y: Enable

N: Disable

Variable IRL_PACK_VALIDATION

Description Account for the new taxable EAN codes in IRL validation.

Valid Value COM

TRIB

Variable IRL_REASON_DESCRIPTION

Description Indicates if IRL Receipt Refusal requires reason description.

Valid Value Y: Enable

N: Disable

Variable IRL_SEFAZ_VALIDATION

Description Indicates if IRL SEFAZ validation is required.

Valid Value Y: Enable

N: Disable

Variable IRL_XML_ARCHIVE_PATH

Description Indicates the definitive path of archived XML's for database upload.

Valid Value Valid path

Variable IRL_XML_DATABASE_BKP

Description Indicates if IRL allows storing XML into database.

Valid Value Y: Enable

N: Disable
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Reclassification System Options

Transfers, Transfers IC and Repairing System Options

Variable FM_FRECLASS_ACTIVE_DATE

Description Define minimum of days of active date to item fiscal reclassification

Valid Value Valid number

Variable FM_FRECLASS_COPY_DOWN_CHILD

Description In item fiscal reclassification process, copy classification from item 
parent to child.

Valid Value Y: Enable

N: Disable

Variable FM_FRECLASS_ONLINE_IND

Description Define information that can be edit in screen.

Valid Value Y: Enable

N: Disable

Variable FM_FRECLASS_VDATE

Description Define date to be used in Reclassification batch to process records.

Valid Value N: VDATE

Y: VDATE + 1

Variable DEFAULT_IN_RET_IC_DOC_TYPE

Description Default Inbound Document Type for Return Transfers Inter Company.

Valid Value Valid document type

Variable DEFAULT_IN_RET_TSF_DOC_TYPE

Description Default Inbound Document Type for Return Transfers.

Valid Value Valid document type

Variable DEFAULT_IN_RETURN_IC_UTIL_ID

Description Default Utilization ID for Return Transfers Inter-Company.

Valid Value Valid utilization code

Variable DEFAULT_IN_RETURN_TSF_UTIL_ID
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Description Default Inbound Utilization ID for Return Transfers.

Valid Value Valid utilization code

Variable DEFAULT_INBOUND_IC_DOC_TYPE

Description Default Document Type for Inbound IC Transfers.

Valid Value Valid document type

Variable DEFAULT_INBOUND_IC_UTIL_ID

Description Default Utilization ID for Inbound IC Transfers.

Valid Value Valid utilization code

Variable DEFAULT_INBOUND_REP_DOC_TYPE

Description Default Document Type for Inbound Repairing Transfers.

Valid Value Valid document type

Variable DEFAULT_INBOUND_REP_UTIL_ID

Description Default Utilization ID for Inbound Repairing Transfers.

Valid Value Valid utilization code

Variable DEFAULT_INBOUND_TSF_DOC_TYPE

Description Default Document Type for Inbound Transfers.

Valid Value Valid document type

Variable DEFAULT_INBOUND_TSF_UTIL_ID

Description Default Utilization ID for Inbound Transfers.

Valid Value Valid utilization code

Variable DEFAULT_OUT_RET_IC_DOC_TYPE

Description Default Outbound Document Type for Return Transfers Inter 
Company.

Valid Value Valid document type

Variable DEFAULT_OUT_RET_TSF_DOC_TYPE

Description Default Outbound Document Type for Return Transfers.

Valid Value Valid document type

Variable DEFAULT_OUT_RETURN_IC_UTIL_ID
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Description Default Outbound Utilization ID for Return Transfers Inter-Company.

Valid Value Valid utilization code

Variable DEFAULT_OUT_RETURN_TSF_UTIL_ID

Description Default Outbound Utilization ID for Return Transfers.

Valid Value Valid utilization code

Variable DEFAULT_OUTBOUND_IC_DOC_TYPE

Description Default Document Type for Outbound IC Transfers.

Valid Value Valid document type

Variable DEFAULT_OUTBOUND_IC_UTIL_ID

Description Default Utilization ID for Outbound IC Transfers.

Valid Value Valid utilization code

Variable DEFAULT_OUTBOUND_REP_DOC_TYPE

Description Default Document Type for Outbound Repairing Transfers.

Valid Value Valid document type

Variable DEFAULT_OUTBOUND_REP_UTIL_ID

Description Default Utilization ID for Outbound Repairing Transfers.

Valid Value Valid utilization code

Variable DEFAULT_OUTBOUND_TSF_DOC_TYPE

Description Default Document Type for Outbound Transfers.

Valid Value Valid document type

Variable DEFAULT_OUTBOUND_TSF_UTIL_ID

Description Default Utilization ID for Outbound Transfers.

Valid Value Valid utilization code

Variable INCL_DISC_EXP

Description Indicates whether inclusion or exclusion of expenses and discounts in 
the last purchase price for Transfer NF

Valid Value Y: Inclusion

N: Exclusion
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Return Merchandise Authorization (RMA) System Options

Return to Vendor (RTV) System Options

Variable REF_NF_MANDATORY_FREIGHT

Description Indicates if it is mandatory to inform the reference NF for 
Complementary NF Freight.

Valid Value Y: Enable

N: Disable

Variable DEFAULT_RMA_DOC_TYPE

Description Default Document Type for RMA

Valid Value Valid document type

Variable DEFAULT_RMA_UTIL_ID

Description Default Utilization ID for RMA

Valid Value Valid utilization code

Variable BALANCE_CONTROL_RTV

Description Indicates whether the balance control fo RTV is hold or not.

Valid Value Y: Enable

N: Disable

Variable DEFAULT_REASN_FOR_RTRN

Description Default Reason for a Return Document.

Valid Value Valid reason code

Variable DEFAULT_REF_MESSAGE

Description Default Message for Referenced NF.

Valid Value This NF number %s1 is referenced to the original NF %s2 issued on 
%s3 respectively.

Variable DEFAULT_REF_MESSAGE_RTV

Description Default Message for Referenced Return to Vendor NF.

Valid Value Devolution ref. the NF nº %s1, issued on %s2, Value of R$ %s3

Variable DEFAULT_REF_MESSAGE_RTV_ST
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Description Default legal message for ST Return NF

Valid Value Nota Fiscal number %s1 meant for restitution of tax collected as 
substitution referenced to the original NF %s2 issued on %s3

Variable DEFAULT_RNF_DOC_TYPE

Description Default Document Type for RNFs.

Valid Value Valid document type

Variable DEFAULT_RNF_DOC_TYPE_TRIANG

Description Default Document Type for Triangular RNFs.

Valid Value Valid document type

Variable DEFAULT_RNF_ST_NF_DOC_TYPE

Description Default Document Type for Return (RNF) ST NF.

Valid Value Valid document type

Variable DEFAULT_RNF_ST_NF_DOC_TYPE_TRI

Description Default Document Type for Return (RNF) ST NF for triangulation.

Valid Value Valid document type

Variable DEFAULT_RNF_ST_NF_UTIL_ID

Description Default Utilization ID for Return (RNF) ST NF.

Valid Value Valid utilization code

Variable DEFAULT_RNF_ST_NF_UTIL_ID_TRIA

Description Default Utilization ID for Return (RNF) ST NF for triangulation.

Valid Value Valid utilization code

Variable DEFAULT_RNF_UTIL_TRIANG_CNTF

Description Default Utilization ID for Triangular Return NF CNTF

Valid Value Valid utilization code

Variable DEFAULT_RNF_UTIL_TRIANG_ID

Description Default Utilization ID for Triangular Return NF

Valid Value Valid utilization code

Variable DEFAULT_RNF_UTILIZATION_ID
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Description Default Utilization ID for Return NF

Valid Value Valid utilization code

Variable DEFAULT_RTV_DOC_TYPE

Description Default Document Type for RTVs.

Valid Value Valid document type

Variable DEFAULT_RTV_DOC_TYPE_TRIANG

Description Default Document Type for Triangulation RTVs.

Valid Value Valid document type

Variable DEFAULT_RTV_ST_NF_DOC_TYPE

Description Default Document Type ID for Return (RTV) ST NF.

Valid Value Valid document type

Variable DEFAULT_RTV_ST_NF_DOC_TYPE_TRI

Description Default Document Type ID for Return (RTV) ST NF for triangulation.

Valid Value Valid document type

Variable DEFAULT_RTV_ST_NF_UTIL_ID

Description Default Utilization ID for Return (RTV) ST NF.

Valid Value Valid utilization code

Variable DEFAULT_RTV_ST_NF_UTIL_ID_TRIA

Description Default Utilization ID for Return (RTV) ST NF for triangulation.

Valid Value Valid utilization code

Variable DEFAULT_RTV_UTIL_ID

Description Default Utilization ID for RTVs.

Valid Value Valid utilization code

Variable DEFAULT_RTV_UTIL_TRIANG_CNTF

Description RTV to Supplier Delivery related to Triangular PO CNTF

Valid Value Valid utilization code

Variable DEFAULT_RTV_UTIL_TRIANG_ID
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Purge System Options

Description Default Utilization ID for outbound RTV NF for the Supplier Delivery 
in a triangular operation purchase.

Valid Value Valid utilization code

Variable DEFAULT_ST_NF_DOC_TYPE

Description Default Document Type for Return ST NF.

Valid Value Valid document type

Variable DEFAULT_ST_NF_UTIL_ID

Description Default Utilization ID for Return ST NF.

Valid Value Valid utilization code

Variable REF_NF_MANDATORY_RTV

Description Indicates if it is mandatory to inform the reference NF for RTV NF 
issues.

Valid Value Y: Enable

N: Disable

Variable REFERENCE_RTV_RNF_RPO

Description Determine the reference NF to issue a RTV or RNF.

Valid Value Y: the reference is the NF RPO

N: the reference is the NF PO

Variable FM_FRECLASS_PURGE

Description Purge item fiscal reclassification.

Valid Value Valid number

Variable HISTORY_DAYS_GTAX_ITEM_ROLLUP

Description Number of days in the past that will be used for purge to TAX_ITEM_
ROLLUP_HIST

Valid Value Valid number

Variable HISTORY_DAYS_HIST_TABLES

Description Indicates the number of days the history table can hold the records

Valid Value Valid number
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Setting Up System Options
To set up the System Options, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select System 
Setup.

1. In the Contents Of System Setup window, select System Options. 

2. In the Contents Of System Options window, click Edit. The System Options 
window opens.

Figure 2–8 System Options Window

3. Click the Variable field LOV to view the description and variables.

4. Click Add. A new row is displayed.

Variable HISTORY_DAYS_POS_MODS_TAX_INFO

Description Number of days in the past that will be used for purge to POS_
MODS_TAX_INFO_HIST

Valid Value Valid number

Variable HISTORY_DAYS_PROCESSED_EDI

Description Indicates the number of days the EDI NFs can exist in the EDI tables 
before getting purged.

Valid Value Valid number

Variable IRL_PURGE_DAYS

Description Indicates the number of days for purge the IRL tables.

Valid Value Valid number
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5. Enter the details in the Variable and Description fields. 

6. Select the Type from the list.

7. Enter the details in the Value field.

8. Click OK to exit the window.

Tolerance Parameter
Tolerance is the variance allowed between values in NF compared with the requisition 
document. If the NF is within tolerances, then the NF can be considered matched 
(without discrepancy). Tolerance can be managed by:

■ Supplier: a tolerance value is defined to a specific supplier

■ Company: a tolerance value is defined to a specific company

■ System: a tolerance value is defined to all ORFM receiving NFs

■ Item/Merchandise Structure: a tolerance value is defined by specific item or 
merchandise structure level.

ORFM supports the following three types of tolerances:

■ Cost Tolerance: Use it when comparing the unit cost of the item on the PO as 
against the unit cost of the item on the NF. 

■ Quantity Tolerance: Use it when matching the quantity ordered, against the 
quantity provided in NF for each item.

■ Calculation Tolerance: Use it to avoid the NFs from going into discrepancies due 
to rounding or truncation issues.

Setting up Tolerances by Supplier/Company
To set up the tolerances, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select System 
Setup.

1. In the Contents Of System Setup window, select Tolerances.

2. In the Contents Of Tolerances window, click Edit. The Tolerances window opens.

Note: Adding parameters will not have any impact on the system 
functionality.

Note: The cost, and quantity tolerances can be set in the Tolerance 
Maintenance screen in ORFM, and calculation can be set as a system 
variable.
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Figure 2–9 Tolerances Window

3. In the Tolerances window, the list in the Level field has two values – Supplier and 
Company. Select the level applicable.

4. The Name field displays the list of all the Supplier names or Company names 
based on the level selected. Select the supplier or the company name.

5. Click Search. The existing tolerances for the supplier or company is displayed in 
the multi-record block. If there are no tolerances for the selected level, the 
following message is displayed: "Query caused no records to be retrieved".

6. If there are tolerances for the selected values, the following parameters are 
displayed in the multi-record block:

■ Tolerance Level – Choose from Line Quantity or Line Cost.

■ Lower Limit Inclusive – The lower limit for the range. This value is included 
in the range.

■ Upper Limit Exclusive – The upper limit for the range. This value is excluded 
from the range.

■ Tolerance Type – Select the Requisition Document Tolerance Type from the list. 
The list includes Percentage or Value.

■ Tolerance Value – Enter the tolerance value for matching between the NF and 
the requisition document of the NF.

7. Click OK to save the changes.

The other options available on the window includes:

■ Click Add to add a new row in the multi-record block.

■ Click Delete to delete the selected row from the multi-record block.

■ Click Refresh to clear the filter criteria, and the data in the multi-record block.

■ Click Cancel to not save the entered changes.

Note: Select View mode in the Contents Of Tolerances window to 
view the tolerances. The Add and Delete button in the Tolerances 
window are disabled.
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Setting up Tolerances by Item/Merchandise Structure
1. In the Contents Of System Setup window, select Tolerances.

2. In the Contents Of Tolerances window, click Edit. The Tolerances window opens.

Figure 2–10 Tolerances Window

3. In the Tolerances window, click in OPTIONS and Tolerance Exception by Item. 
Tolerance Exception by Item Setup window opens.

Figure 2–11 Tolerance Exception by Item Setup

4. In the Tolerance by Item Setup, the list in the Level field has these values: Item, 
Class, Subclass, Department and Group. Depending of selection, the next field is 
used to filter the selection.

5. 5Depending of level configured, user can define tolerance by Value or Percentage 
in the field "Tolerance Type" and the value in the field "Tolerance Value".

6. 6Click OK to save the changes

The other options available on the window includes:

■ Click OK to save records and close the window.



Location Fiscal Numbers

Foundation Data 2-39

■ Click Add to add a new row in the multi-record block.

■ Click Refresh to clear the filter criteria, and the data in the multi-record block.

■ Click Delete to delete the selected row from the multi-record block.

■ Click Cancel to not save the changes that it is entered.

Setting up Tolerances by ORFM System
Tolerance setup valid all NF receiving in any company in the system can be defined by 
ORFM System Options CALC_TOL_TYPE and CALC_TOL_VALUE.

More information about these ORFM System Options, see chapter ORFM System 
options in this document.

Location Fiscal Numbers
Location Fiscal Numbers are numbers assigned to a store/warehouse. In Brazil, the 
sequence of NF document numbers is controlled and should be correctly followed 
during the NF issuing process.

Each location controls its own sequence based on the following fields: 

■ Documentation Type

■ Serial/Sub-serial

■ Sequence

■ Effective Date

Any transaction that involves that particular store/warehouse should contain the 
fiscal numbers falling within a particular range.

Adding Fiscal Numbers
To add fiscal numbers, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then System Setup. 
From System Setup, select Fiscal Numbers. 

1. In the Contents Of Fiscal Numbers window, click Edit. The Location Fiscal 
Numbers window opens.

Figure 2–12 Location Fiscal Numbers Window
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2. To add a number, select the store/warehouse from the Location LOV. Click Add. 
In the multi-record block, a row is highlighted as shown.

Figure 2–13 Location Fiscal Numbers Window

3. Assign values to Location, Document Type, Series Number, Subseries Number, 
Minimum Fiscal Number, Maximum Fiscal Number, and Effective Date.

Deleting Fiscal Numbers
1. Select the row to delete in the Location Fiscal Numbers window.

Figure 2–14 Location Fiscal Numbers Window

2. Click Delete. The following message appears:

Figure 2–15 Location Fiscal Numbers - Delete window

3. Click Yes to delete the row.
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Viewing Fiscal Numbers
1. In the Contents Of Fiscal Numbers window, click View. The Location Fiscal 

Numbers window opens. 

In the View mode, the Add, and the Delete button are disabled. By default, the 
Location Fiscal Numbers displays the locations, and their fiscal numbers.

Figure 2–16 Location Fiscal Numbers Window

2. Select the location type from the Location Type list. The Location field is 
highlighted after selecting the location type.

3. Select the location from the Location LOV.

4. Click the filter icon. Based on the filter criteria, the multi-record block displays the 
Location Type, the Location, and the values associated with the Document Type, 
Series Number, Subseries Number, Minimum Fiscal Number, Maximum Fiscal 
Number, and Effective Date.
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3Purchase Order

Purchase Order (PO) is the regular buying process of a retailer. The retailer issues a PO 
when buying the merchandise from a supplier. When the merchandise is received, this 
merchandise is matched against the related PO in order to verify that the receiving 
merchandise has the items that the retailer has bought to the supplier.

This chapter covers the following sections:

■ Business Flow

■ Discrepancy Resolution

■ Complementary NF 

■ Complementary NF for Triangulation

■ Complementary NF for Non-Merchandise Cost

■ Complementary NF for Cost/Tax Correction

■ Deal Income Posting

Business Flow
The business flow for PO receiving is as follows:

1. Retail Fiscal Management (ORFM) system can receive Nota Fiscal (NF) by:

■ Manual

■ EDI

■ Invoice Receiving Layer

2. When the shipment arrives at the warehouse or the store, create a schedule and 
enter the NFs received.

3. After NF entry, validate the NFs. In the validation process, the ORFM application 
checks for data integrity. Match the NF with the requisition documents in the 
Retail Merchandising System (RMS). This process is called as the Fiscal Receiving.

Note:

■ You can link more than one NF to a schedule.

■ The schedule can be created before or after creating an NF.

■ An NF can be created without a schedule, but they have to be 
linked before submitting for receiving.
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If the NF and the PO does not match, the NF is in discrepancy. You can identify the 
following discrepancies with the ORFM application:

■ Unit Cost Discrepancy for each item in the NF

■ Quantity Discrepancy for each item in the NF

■ Tax Discrepancy happens between system (tax details from Tax Engine) and 
NF.

4. After validation, send the schedule to the Warehouse Management System 
(RWMS) and/or Store Inventory Management System (SIM). After physical 
receiving, both the systems publish the receipt updates to ORFM. This completes 
the NF processing. 

5. Send the transaction data in RMS and ORFM to a financial application. For fiscal 
reporting purposes, send the NF data in ORFM to the fiscal reporting system like  
SPED.

NF Processing - PO Receiving
The Receiving/Issuing module of ORFM enables you to create the required NF. This 
module enables you to validate the NF, match the NF with the PO, resolve 
discrepancy, and approve the NF with correction documents.

To create the Nota Fiscal for PO Receiving, perform the following steps:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of 
Location. The Location Login window is displayed.

1. In the Location Login window, select the store or warehouse for receiving/issuing 
the fiscal document. Click the Location LOV to obtain the list of stores or 
warehouses. Select the location and click OK.

Figure 3–1 Location Login Window

2. You are returned to the RMS main window. In Contents Of Fiscal Management, 
select Receiving/Issue. 

In Contents Of Receiving/Issue, click Edit. The Receiving/Issue Schedule window 
is displayed.
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Figure 3–2 Receiving/Issue Schedule Window

3. Select the Mode from the list. For PO receiving, select Entry. 

The other option available is Exit. This mode is for outbound flow. 

4. The Filter section in the Receiving/Issue Schedule window displays the following:

■ Location Type – This field displays the information that flows from the 
Location Login window. The list contains Store or Warehouse. 

■ Location – The sender/receiver location.

■ Schedule – Select the schedule number from the Schedule LOV or click Add to 
create a new schedule number.

■ Select the appropriate status from the list in the Status field. For PO Receiving, 
the status has to be Worksheet.

Schedules with physical receiving

For Entry type of Schedules where physical receiving is required such as PO 
receiving or TSF receiving:

Table 3–1 Status Of Schedule - Schedules with Physical Receiving

Code

Schedule Status 

Description
Status 
Type

NF Status in Receiving Process

Description

W Worksheet Inclusive Worksheet

In Discrepancy

Error

P Pending for Receiving Exclusive Validated

Calculated

S Subm. for Recv. Exclusive Verifying NF-e Status
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Entry schedule status

Inactive can be: 'Reject Entire Receiving from WMS/SIM' or 'entry NF was 
rejected'.

Schedules with shipments

For Exit type of Schedules where shipment is done in order to generate NFs:

Status Type

Inclusive:

It is considered status type Inclusive the status that does NOT depend on 
equivalence of status for all fiscal documents associated to the schedule.

Example, schedule status W: This status will accept NFs in different statuses, 
including status that associated to the next step in the process.

R Received Inclusive Received

Receipt-Verified

Manifest Pending

Post Sefaz Approve Error

A Approved Exclusive Approved

C Completed Exclusive Completed

FP Financials Posted Exclusive Financials Posted

I Inactive Exclusive Inactive

Table 3–2 Status Of Schedule - Schedules with Shipments

Code

Schedule Status 

Code_Desc
Status 
Type Code

NF Status in Shipment 
Process

Code_Desc

W Worksheet Inclusive W

V

NFE_P

RA

E

F

Worksheet

Validated

NFe Pending

Request Approved

Error

Post Sefaz Approve Error

A Approved Exclusive A Approved

Calculated

C Completed Exclusive C Completed

FP Financials Posted Exclusive FP Financials Posted

Schedule Schedule Status NF NF Status

90011 W 45001

45002

Worksheet

Validated

Table 3–1 (Cont.) Status Of Schedule - Schedules with Physical Receiving

Code

Schedule Status 

Description
Status 
Type

NF Status in Receiving Process

Description
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In the above example, one NF is in status W that belongs to the range of status 
accounted for schedule status W, but one NF was already validated and V 
status belongs to range of schedule status P.

Exclusive: 

It is considered status type exclusive the status that depends on ALL fiscal 
documents to be in the same status of the range in order to be changed.

Example, schedule status P (Pending for Receiving): This status will changed 
only if ALL NFs have status V (Validated) or CL (Calculated).

In the above example, all NFs are in status V that belongs to the range of status 
accounted for schedule status P, hence schedule status will exclusively be P in 
this scenario.

■ Enter the Start Date and the End Date in their respective fields.

■ The Action Required field reflects either at schedule or fiscal document level. 
At least one of the fiscal documents in the schedules to be with the referenced 
status is required to select yes.

Example of a Schedule with two NFs in different status:

*RV status (Received Verified) would have no action required. However, R status 
(Received) needs action so Schedule Action Required Field will be Y.

Action required info mapping versus NF status and Schedule type:

Schedule Schedule Status NF NF Status

90011 P 45001

45002

Validated

Validated

Schedule Schedule Status Action Required NF NF Status

90011 R Y 45001

45002

Received

Received 
Verified

Action Required Schedule Description Schedule Receiving/Ship

Y Worksheet Receiving/Ship

Y In Discrepancy Receiving

Y Validated Receiving/Ship

Y Calculated Receiving

N NFe Pending Shipment

N Request Approved Shipment

Y Error Receiving/Ship

N Verifying NF Status Receiving

N Submitted for 
Receiving

Receiving

Y Received Receiving
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5. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window is displayed. This screen displays all the NFs linked to that schedule.

Figure 3–3 Fiscal Docs Find Window

6. In the Fiscal Docs Find window, click Add. The Fiscal Documents window is 
displayed. 

The Fiscal Documents window is divided into three sections – Fiscal Document 
Header, Header Detail, and Line Item Level Detail.

N Receipt Verified Receiving

N Manifest Pending Receiving

Y Post Sefaz Error Receiving/Ship

N Approved Receiving/Ship

N Completed Receiving/Ship

N Financial Posted Receiving/Ship

N Inactive Receiving/Ship

N Canceled Shipment

N Nullified Shipment

N Denied Shipment

Action Required Schedule Description Schedule Receiving/Ship
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Figure 3–4 Fiscal Documents Window

In the Fiscal Document Header section, enter the details as given in table Table 3–3

Table 3–3 Fields in the Fiscal Document Header Section

Field Description

Requisition Type Select Purchase Order Requisition Type for the PO receiving transaction 
from the drop-down list. 

Utilization This field is enabled only when the Requisition Type is entered.

Select the Utilization from the list that is specific to the PO operation.

Entry CFOP This field is populated by the tax integration. 

The Entry CFOP is used for the fiscal bookkeeping and Public System 
of Digital Bookkeeping or SPED. This field is non-editable.

NF CFOP Enter the value for NF CFOP. 

CFOP is the Operations and Service-Providing Fiscal Code.

Fiscal No Enter the fiscal number. If the system option DI_NF_SERIAL_
GENERATION_IND is Y for a DI NF, then this field and series number 
are not enabled. It is generated using the location sequencing 
functionality of ORFM.
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Status Contains the possible status of the NF. When you are entering the 
details in the system, the status of NF is Worksheet.

The NF has to be in Worksheet status to edit or cancel it.

The other statuses are as follows:

■ In Discrepancy – The application displays this status, when the NF 
is in the discrepant status. Discrepancies can be in quantity, cost, 
and tax.

■ Validated – The NF status changes to Validated, if there are no data 
integrity errors.

■ Error – The application displays this status for validation related 
errors, errors in NF generation using the EDI file, errors in NF-e 
transmission or Tax Engine call for taxes.

■ Approved – Post approval.

■ Received – When the merchandise in the NF is received, the status 
of NF changes to Received.

■ Receipt Verified – This status is displayed when the merchandise 
has been verified against the NF.

■ Completed – This status is displayed when processing of the NF is 
completed.

■ NFe Pending – This is applicable for NF-e processing only. During 
the NF-e issuing process, when the NF-e has to be approved, the 
status of the NF is NFe Pending.

PO NF of DI Import Type will also be submitted for SEFAZ 
approval from RFM if the indicator DI_NF_SERIAL_
GENERATION_IND is Y.

With the fiscal document in that status, the related information is 
sent to the fiscal partner solution which captures the data, 
generates the NF-e file and submits it for approval in the Brazilian 
Governments systems.

■ Manifest Pending – During the NF-e including process, when the 
NF-e has to be approved, the status of the NF is Manifest Pending.

■ Financials Posted – This is applicable when the transaction details 
are entered in the transaction data table after NF approval.

■ Post Sefaz Approve Error – This option is displayed when the NF 
is transmitted through the internet to the SEFAZ (Secretaria da 
Fazenda–Brazilian Tax Authority) of the origin state of the issuer.

■ Inactive - Entry NF means Reject Entire Receiving from WMS/SIM' 
or 'entry NF was rejected'; Issue NF when NF was cancelled before 
get NF number.

■ Verifying NFe Status - Waiting for validated by Sefaz.

■ Calculated - Status used exclusively for Direct import scenario. 
Equivalent to Validated status, but without discrepancy 
verifications.

■ Cancel - When the NF is approved at SEFAZ and a cancelation is 
required post-approval.

■ Nullified - When the NF is in progress and it was not submitted for 
approval at SEFAZ and cancelation is required, SEFAZ returns this 
status.

■ Denied - When the NF is submitted for approval at SEFAZ but it 
gets rejected or denied.

Serial Enter the serial number for the NF.

Table 3–3 (Cont.) Fields in the Fiscal Document Header Section

Field Description
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7. In the Header Details section, enter the following details – Header Info, Header 
Taxes, Additional Info, Transportation Details, Source Details, Destination Details,  
Importation Details, and Customer Details.

■ Figure 3–5 shows the Header Info Tab and the fields and description are 
provided in Table 3–4.

Figure 3–5 Header Info Tab

Document Type Select the document type for the PO from the Document Type LOV.

Mode Type This field is populated from the Receiving/Issue Schedule window.

This field displays Entry for PO Receiving and Exit for outbound 
operations.

Sub Serial Enter the sub-serial number of the NF.

Type This is an external entity type from which NF is received. 

You can select any one of the Type from the Type LOV.

The Type LOV includes Supplier Site, Store, Warehouse, Company, 
Customer, Bank, Agent, Freight forwarder, Importer, Broker, Factory, 
Consolidator, Applicant, Consignee, Manufacturer, Distributor, 
Wholesaler. Expense Vendor, Import Authority, Escheat –State, 
Escheat-Country, External Finisher, Discharge Port, Lading Port, Entry 
Port, Return Center, Bill to Location, LC to Location, Routing Location, 
Clearing Zone. 

Schedule No This field is populated from the Receiving/Issue Schedule window. It 
could be the number of the schedule receiving or the number of the 
schedule issuing.

CNPJ/CPF CNPJ/CPF – Cadastro Nacional da Pessoa Jurídica (CNPJ) is the 
company code. Cadastro de Pessoa Física (CPF) is the personal code of 
the sender/receiver.

This field is dimmed on the NF form. It takes the CNPJ/CPF number of 
the value in Type and Name fields in the form. 

For example, if Type = SUPP, Name/Supplier Site = 1000001010, the 
CNPJ number of the supplier site is displayed in the CNPJ/CPF field.

Name Based on the Type, the user enters the values in this field. For example, 
if the Type is supplier, this field will have the supplier site value.

NFe Access Key This field is not applicable for PO Receiving.

Used to search NF-e.

Table 3–3 (Cont.) Fields in the Fiscal Document Header Section

Field Description
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Figure 3–6 shows the Header Taxes Tab and the fields and description are 
provided in Table 3–5.

Table 3–4 Fields in the Header Info Tab

Fields Description

Totals Informed and Calculated Service, Informed and Calculated 
Merchandise, Informed and Calculated Total.

Enter the details in each field. 

The Calculated Costs is obtained from the system.

Additional Costs Freight, Insurance, Other Expenses and Non-Taxable Expense.

When processing complementary NF for Freight, only these fields 
are enabled. 

Discounts Select Percentage or Value from the Type list. 

Enter the value in the Value field.

Discrepancy Three check boxes, for each type of discrepancy (Cost, Quantity and 
Tax) present. 

If the NF is in cost discrepancy, then the check box for Cost is 
selected. Likewise for Quantity and Tax. 

Dates Enter the Issue date, Entry/Exit date, Exit Hour of the NF, and 
Exchange Rate Date.

Entry/Exit: It is updated to the date and time when the schedule is 
submitted to Warehouse Management System (RWMS)/Store 
Inventory Management System (SIM) for the physical receipt of 
merchandise.

Exchange Rate Date: It is introduced to support the multi-currency 
functionality. For example, when you inform a PO NF for receiving, 
if the PO currency is different from NF currency, the exchange rate 
date keyed in will be considered for conversion into BRL on the NF. 
If left blank, the order approval will be considered.

Complement Click Complement in the Header tab to link another NF (one that 
complements the main NF).

In the ORFM application, the complement button is used for the 
following purposes:

■ For triangulation, secondary NF coming from the Delivery 
Supplier

■ Freight or non-merchandise NF

■ Complementary NF for Cost/Tax Correction

Req. Doc. Click Req. Doc. to view all the all the POs for the given supplier. 
For more details, refer to Step 8.

Note: The Exchange Rate Date is a nullable field. For example, when 
informing PO NF values, if this field is null then the PO approval date 
is considered for all exchange rate calculations.
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Figure 3–6 Header Taxes Tab

■ Figure 3–7 shows the Additional Info Tab and the fields and description are 
provided in Table 3–6.

Figure 3–7 Additional Info Tab

Table 3–5 Fields in the Header Taxes Tab

Fields Description

Tax Code The tax code that are part of the Brazilian tax system are present 
in the list.

Select the tax code from the list.

Taxable Basis Enter the taxable basis value.

Modified Taxable Basis This column displays the changed/modified taxable basis. This 
value flows from the external tax engine.

In Brazil, some items are eligible to a tax rule that modifies the 
taxable basis. The tax rate for such items is applied on the 
modified taxable basis.

Total Tax Value Enter the value.

After entering the value for one tax code, click Add to enter 
additional details.

In case, you want to delete any record, select the entry, and click 
Delete.

Table 3–6 Fields and Description of Additional Info Tab

Field Description

Sender/Receiver In this block, the following fields of the sender/receiver are auto 
populated:

■ Address

■ City

■ Neighborhood

■ ZIP

■ State

These fields are taken from the Supplier/Supplier Site Address, 
City, and so on for a PO.
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■ Figure 3–8 shows the Transportation Details Tab and the fields and description 
are provided in Table 3–7.

Figure 3–8 Transportation Details Tab

Supplier Payments In this block, enter the following details for the supplier 
payments:

■ Date – Date of payment

■ Value – Amount to be paid

Click Add to add additional details. 

Click Delete in case you want to delete a record.

Process In this block, select the Origin from the list.

The Process list includes the following values:

■ SEFAZ (State Tax Authority)

■ Federal Justice

■ State Justice

■ Secex/SRF – Importation Tax Authority

■ Others

In the Value field, enter the value.

These fields meet SPED requirements.

Comments You can capture comments or general information regarding the 
purpose behind the creation of the NF document.

Reference Type This field serves as a descriptor for data (that is the 
number/code) captured in the Reference Number field. 

The Reference Type list includes PO, Transfer, Bill of Lading 
(BOL), Shipment, Allocation, Advance Shipping Notice (ASN), 
Sale, Return, RTV, Invoice Receiving Layer.

Reference No. This field supports entry of text or alphanumeric/numeric codes 
of transactions that the NF document might wish to 
associate/reference.

Table 3–7 Fields and Description of Transportation Details Tab 

Field Description

Type You can select any one of the Type from the list. 

The Type list includes Bank, Agent, Freight Forwarder, Importer, 
Broker, Factory, Consolidator, Applicant, Consignee, 
Manufacturer, Expense Vendor, Import Authority, Escheat-State, 
Escheat-Country, Other, and External Finisher. Other Type is 
populated if the NF is a Free Form NF.

Table 3–6 (Cont.) Fields and Description of Additional Info Tab

Field Description
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The following fields are enabled only for StandAlone NFs:

– Description

– State Inscription

– Tributary State 

– Tributary Subscription No

Description  This field is auto populated with the description of the Type 
selected.

State Inscription This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Tributary State This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Tributary Subscription No This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry. 

Vehicle Plate This field is for SPED requirement.

Name This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Address This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

City This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Neighborhood This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Country This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Plate State You can specify the field if the Entity in RMS check box is not 
selected. Else the field is dimmed. 

CNPJ/CPF Enter the CNPJ/CPF number. This field is free form entry if 
Entity in RMS is not selected.

Freight Type You can either choose Cost Inclusive of Freight (CIF) and Free on 
Board (FOB) from the freight type list.  

Qty Enter the quantity of items.

UOM Enter the unit of measure.

Net Weight Enter the net weight.

Total Weight Enter the total weight.

Entity in RMS You have an option to deselect the Entity in RMS check box, for 
an NF having requisition type Free Form NF. For a Direct NF, 
the Entity in RMS check box is selected and dimmed. 

Table 3–7 (Cont.) Fields and Description of Transportation Details Tab 

Field Description
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– Neighborhood

– Country

– Entity in RMS

■ Figure 3–9 shows the Importation Details Tab.

Figure 3–9 Importation Details Tab

The Importation Details tab is divided into three blocks – Customs, DI Details, 
and Parent NF.

Table 3–8 Fields and Description of Importation Details Tab 

Field Description

Customs In this block, enter the following fields:

■ Customs Location

■ Customs State - Select the Customs State from the list of 
states.

■ Customs Date

■ Incoterm - This is the type of transport with the following 
valid list of values to identify the transportation method 
used:

■ 1 Maritime

■ 2 River

■ 3 Lake

■ 4 Airlift

■ 5 Post

■ 6 Railroad

■ 7 Road

■ 8 Transmission network/Conduit

■ 9 Own Means

■ 10 Entry/Exit fictitious

■ AFRMM Value - This is the value paid to the Navy. This 
field is mandatory, if you choose Incoterm as the Maritime 
value.

DI Details In this block, enter the DI Number, DI Issue Date, DI Type, Fiscal 
Authority ID, and Drawback Process. You can either choose 
Import Declaration or Simplified Import Declaration from the DI 
Type list.
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8. In the Line Item Level Details section, the detailed information of the purchase 
order (PO) and the items are displayed. 

You can populate the Detail Info section of PO in the following three ways:  

■ Default

■ Custom

■ UOM

■ Click PO in the Detail Info tab of the Item Level Details section. Select the PO 
details from the list or enter the PO details. 

Figure 3–10 shows the Detail Info Tab and the fields and description are 
provided in Table 3–9.

Figure 3–10 Detail Info Tab

Parent NF In this block, the following fields are enabled if you select Is 
Child Ind? check box: 

■ Fiscal Serial: Enter fiscal serial.

■ Fiscal Issue Date: Enter the fiscal issue date. 

■ Parent Fiscal No: Enter the parent fiscal number.

Note: UOM view is available and editable only when NF is in 
Worksheet status. 

Table 3–9 Fields and Description of the Detail Info Tab

Field Description

PO It is a requisition number.

Unexpected Item Check this field if the item does not belong to any PO.

Item Enter the item or items that are part of the purchase order.

Pack Ind This indicator is highlighted if the item is a pack. 

Unit The number of units of the item.

Quantity Enter the quantity of the item.

Unit Cost The unit cost of the item.

Discount Type Enter the discount type applicable.

Discount Enter the discount applicable.

Total Cost Enter the total cost applicable.

Table 3–8 (Cont.) Fields and Description of Importation Details Tab 

Field Description



Business Flow

3-16 Oracle® Retail Fiscal Management User Guide

Figure 3–11 shows the Detail Info UOM View and the fields and description 
are provided in Table 3–10.

Figure 3–11 Detail Info UOM View

Note: You can also view the Unit of Measurement (UOM) type by 
selecting UOM from the View menu.

Table 3–10 Fields and Description of the Detail Info Tab UOM View

Field Description

PO Enter the Purchase Order (PO) number.

Unexpected Item Check this field if the item does not belong to any PO.

Item Enter the item or items that are part of the purchase order.

Pack Ind Enter the packet item indicator that are part of the purchase 
order.

Description Enter the description of the item.

NF CFOP This field displays the CFOP code from Tax Engine.

UOM Type UOM type provides an option to associate an appropriate NF 
based UOM to an item.

Select the UOM type from the following list:

■ SUOM (refers to Standard Unit Of Measurement of the 
item)

■ Case

■ Pallet

Unit The unit cost of the item. 

Unit displays the corresponding SUOM if user selects UOM type 
as SUOM, Case, or Pallet.

Pack Size Enter the pack size applicable. 

You are not allowed to update the pack size during NF entry.

UOM Quantity Enter the UOM quantity applicable.

UOM Unit Cost Enter the UOM unit cost applicable.

Total Cost Enter the total cost applicable.

Note: You cannot modify the Item or PO details in the default view 
that are modified in the UOM view.
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■ Click the Req. Doc. button in the Header Details section. The Match 
Document window opens. 

An example of the Match Document window is given below.

Figure 3–12 Match Document Window

In the Match Document window, all the open POs of that particular supplier 
are displayed.

To include the PO details in the NF, do the following:

– In the Additional Filter section of the Match Documents window, you can 
select POs from different supplier sites of the same supplier. 

Click Add in the Additional Filter section of the Match Documents win-
dow to view the POs from different supplier sites of that particular sup-
plier in the multi-record block.

– Select one or more requisition documents from the list.

– Click Add to NF. The item level information from those POs is defaulted 
on the NF. This saves significant data entry efforts.

9. Select the check box for the Unexpected Item to indicate any unexpected item in 
the NF. When this check box is selected, the PO column is disabled and the value 
for the PO number is set to null. 

Enter the item quantity and cost. The cost and the quantity of the unexpected item 
is not matched with the PO.

10. Click Item. Enter the items associated with the PO. If the PO contains pack items 
the Pack Ind check box is selected. 

Note: You can search for an Item using the Vendor Product Number 
(VPN). See Searching using Vendor Product Number in the Fiscal 
Docs Find window for more information on searching for an Item 
using the VPN.
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11. In the Detail Taxes tab, enter the tax details for the item.

See Figure 3–13 for an example of the Detail Taxes tab.

Figure 3–13 Detail Taxes Tab

12. In the Additions tab, enter the additional details for the item.

Note: The Show Components, Explode, and Explode All button is 
enabled for pack items.

Table 3–11 Fields and Description of the Detail Taxes Tab

Fields Description

Type Indicates the type of tax such as ICMS, COFINS, and so on.

Tax Base Indicates whether the tax is value-based or percentage-based.

Tax Basis The basis for calculating the taxes.

Modified Tax Basis Displays the modified or changed taxable basis. The external tax 
engine provides this basis, and this value is used for tax 
calculation. 

In Brazil, some items are eligible for a tax rule that modifies the 
taxable basis, mostly lower taxable basis. For such items, the tax 
rate is applied on the modified taxable basis. Tax Engine 
calculates the modified base and then calculates the tax values 
accordingly.

Tax Rate The tax rate applied.

Total Value The informed total value for the tax.

Legal Message The legal message associated with the tax code at the line level.

Note: If you enter detail level taxes, you have to enter the detail level 
taxes for each item which are on the Item Detail grid.

The Totals on the Detail Taxes tab has to match the Header tax 
information within the tolerance level.

Table 3–12 Fields and Description of the Additions Tab

Fields Description

Po Number Enter the purchase order number.

item Enter the item or items that are part of the purchase order.

Pack Ind This indicator is highlighted if the item is a pack.

Item Description Enter the description of the item.
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Figure 3–14 shows the Additions Tab and the fields and description are provided 
in Table 3–12.

Figure 3–14 Additions Tab

13. After you have entered the relevant details, from the Options menu, select 
Validate. If there is no discrepancy, the status of NF changes to Validated. 

The different menu items of the Options menu in the Fiscal Documents window 
are given below.

Additions Number This field indicates the additions number.

Sequence Number This field indicates the sequence number.

Foreign Manufacturer This field indicates the foreign manufacturer code.

Additions Discount This field indicates the additions discounts.

Note: Additions tab is enabled for Direct Import NF.

Table 3–13 Options Menu Items and Description

Menu Item Description

Worksheet To edit the Nota Fiscal, change the status of NF to worksheet.

Validate Use this option to validate the NF after entry. 

Validation process has the following steps involved:

■ Data Integrity Validation

■ Tax Engine Call for Tax Breakup

■ Discrepancy Identification

For more information, see Discrepancy Identification and 
Resolution Process.

Verify Received Qty Use this option to review any discrepancy between the expected 
quantity as per the NF and the actual received quantity. This 
option is enabled for Inbound NFs only.

Cancel Use this option to cancel the NFs. ORFM allows cancellation for 
few types of NFs only, such as the NF for RMA.

Approve Use this option to manually approve the NF. This is not applicable 
for inbound NFs.

Table 3–12 (Cont.) Fields and Description of the Additions Tab

Fields Description
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14. Click OK. You are returned to the Fiscal Docs Find window.

15. Click OK in the Fiscal Docs Find window. You are returned to the Receiving/Issue 
Schedule window.

16. In the Receiving/Issue Schedule window, from the Options menu, select Sub. for 
Recv. The schedule is submitted for receiving.

The different menu items on the Options menu in the Receiving/Issue Schedule 
window are as given below.

Print Correction Docs. This option is enabled only if the NF had undergone discrepancy 
or there is a damaged or excess/less receiving.

This is enabled only after physical receiving.

Use this option to list the correction documents for that NF and 
print them for sending it to the supplier or for internal reference.

From the Options menu, select Print Correction Docs. The Print 
Fiscal Document window opens. This window displays the 
documents that are already printed and yet to be printed.

Error Log Use this option to view the error log in order to take corrective 
actions, if needed.

The error log can contain the following information:

■ Validation related errors.

■ Any error during the NF generation using the EDI file.

■ Errors during NF-e transmission or Tax Engine call for taxes.

Discrepancy Resolution Use this option to view all the discrepancies (resolved or 
unresolved) and resolve the unresolved discrepancies. From the 
Options menu, select Discrepancy Resolution to access the 
Discrepancy Resolution window.

Note: The NFs in Submitted for Receiving status, and greater cannot 
be changed to Worksheet status for editing.

Table 3–14 Options Menu Items and Description

Menu Items Description

Worksheet Select this option to bring the schedule to worksheet status. A schedule 
can be edited only in this status.

Validate Select this option to validate all the NFs on the schedule.

Sub. for Recv This option is enabled only when the schedule is in Validated status. 

Select this option to change the schedule status to Submitted for 
Receiving.

Print Rec. Report This option is enabled only after submission. 

Select this option to print a new report that shows the details of the 
schedule and the NF details.

Print Document Select this option to print the documents.

Approve This option is enabled only for outbound NFs. Use this option to 
manually approve NF.

Table 3–13 (Cont.) Options Menu Items and Description

Menu Item Description
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17. After the merchandise is received, ORFM uses the receipt updates, and the NF 
status is updated to Receipt Verified, if the received quantity is the same as the 
NF quantity. If there is a difference, the status changes to Received.

18. If the status is Received, from the Options menu in the Fiscal Documents 
windows, select Verify Received Qty. The Received Quantities window opens. 
Click Verify. The status changes to Receipt Verified, after reviewing the received 
quantity in this window.

19. After the receipt is verified, the NF status and schedule status changes to 
Approved. Upon approval, ORFM calculates the landed cost. The landed cost is 
determined by subtracting the recoverable taxes from the non-recoverable taxes 
and non-merchandise costs. The recoverable taxes includes ICMS, Programa de 
Integração Social (PIS), and Contribuição para Financiamento da Seguridade 
Social (COFINS). These three taxes are part of the unit cost. After removing the 
recoverable tax, add the nonrecoverable taxes like Imposto sobre Produtos 
Industrializados (IPI), and the non-merchandise cost (such as freight insurance). 

20. ORFM then publishes the receipts with the updated landed cost to RMS.

Viewing the Error Log
To view the error log, do the following:

Navigate: In the Receiving/Issue Schedule window, from the Options menu, select 
Error Log. The Error Log window opens.

Figure 3–15 Error Log Window

1. In the filter section of the Error Log, you can enter any or all of the details as given 
in the following table:

Error Log Select this option to see the Error Log associated with the schedule. For 
more information on Error log, see Viewing the Error Log.

Note: To view the error log at the NF level, in the Fiscal Documents 
window, from the Options menu, select Error Log.

Table 3–14 (Cont.) Options Menu Items and Description

Menu Items Description
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2. Click the filter button after entering the values. The multi-record block displays 
the records that meet the filter criteria along with the Error Message.

3. Select the error and click Fiscal Doc to see the Fiscal Documents window.   

4. Click Close to exit the window.

NF Processing - Link and Delink
The Receiving/Issuing module of ORFM enables you to link/delink an existing NF to 
a schedule.

Linking an NF to a Schedule
To link the Nota Fiscal to a schedule, perform the following steps:

Navigate: From the RMS Start Menu, select Fiscal Management. In the Contents Of 
Fiscal Management, select Receiving/Issue. In the Contents Of Receiving/Issue, click 
Edit. The Receiving/Issue Schedule window opens.

1. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window opens. This window displays all the NFs linked to that schedule.

2. Click Link to link another NF to the schedule. The Fiscal Docs Find window 
opens.

3. Enter the query criteria in the Fiscal Docs Find window and execute the query. All 
NFs meeting the query criteria are displayed in the Fiscal Docs Find window.

4. In the Fiscal Docs Find window, check the NF to be linked to the schedule, and 
click OK. The Fiscal Docs Find window displays the list of NFs linked to the 
schedule.

Table 3–15 Error Log Window Fields and Description

Field Description

Filter section

Schedule No Enter the schedule number here.

Document No Enter the number of the fiscal document.

Document Type The document type list includes Purchase Order, Sell, Return 
Merchandise Authorization, Transfer, Return to Vendor, Stock Out, EDI 
Doc.

Select the document type.

Error Type This list contains two values: Warning and Error.

Error Date Enter the date.

Error Status The error status can be Open or Closed.

Note: You can Link and Delink the NF on schedules of "Submitted 
for Receiving" status.

Note: You can search for an item using fiscal number, or the VPN. 
See Searching using Vendor Product Number in the Fiscal Docs Find 
window for more information on searching for an Item using the 
VPN.
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Figure 3–16 Fiscal Docs Find window - Linking an NF

5. Click Close to exit the window. 

Delinking an NF and a Schedule
To delink the Nota Fiscal and the schedule, perform the following steps:

Navigate: From the RMS Start Menu, select Fiscal Management. In the Contents Of 
Fiscal Management, select Receiving/Issue. In the Contents Of Receiving/Issue, click 
Edit. The Receiving/Issue Schedule window opens.

1. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window opens. This window displays all the NFs linked to that schedule.

2. Select the NF and click Delink to delink the NF from the schedule. The following 
message is displayed:

Figure 3–17 Delinking an NF

3. Click Yes to delink the NF.

4. Click Close to exit the window. You are returned to the Receiving/Issue Schedule 
window.

Discrepancy Resolution
The NF processing for PO Receiving described in the section — NF Processing - PO 
Receiving works when there is no discrepancy. When there is a difference between the 
NF cost and PO Cost or NF quantity and PO Quantity, or NF tax and tax details from 
Tax Engine, the NF is said to be discrepant or in the In Discrepancy status.

Note: Click OK + Repeat to add another NF to the schedule.
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The two approaches that are supported in ORFM for the resolution of discrepancies 
are as follows:

■ Centralized Discrepancy Resolution – In the centralized discrepancy resolution 
process, the quantity discrepancies identified during the discrepancy identification 
has to be resolved before submitting the NF for receiving. The quantity 
discrepancy can be resolved at the receiving location or at the centralized location. 
However, the cost and tax discrepancy can be resolved at the central location after 
the physical receipt of the merchandise. The centralized location may refer to 
company headquarter or the regional office. 

The status of NF or schedule in centralized receiving flow is as follows:

The NF status will not change to Approved unless all the discrepancies are 
resolved.

In addition, the Discrepancy Resolution item on the Options menu in the Fiscal 
Documents window is enabled till all the discrepancies are resolved. The check 
box in the Discrepancy section of the Header Details section is selected for the 
unresolved discrepancy.

■ De-centralized Discrepancy Resolution – In the de-centralized discrepancy 
resolution approach, all the discrepancies are resolved at the location where the 
merchandise is to be received. The receiving location may be a warehouse or store.

In this approach, the NF status is set to In Discrepancy if any discrepancy exists 
after validation.

You cannot submit the NF for receiving until all the discrepancies are resolved, 
and hence physical receiving before discrepancy resolution is not possible. Only 
after all the discrepancies are resolved, will the NF status change to Validated, and 
you can submit the NF for receiving.

User Interface Indicators for Discrepancy
The Fiscal Docs Find displays the status of NF as In Discrepancy as shown below:

Note: The discrepancy resolution and matching process does not 
address the identification of discount discrepancy and landed cost 
component discrepancy. The Nota Fiscal values for the landed cost 
component has to be apportioned to individual items.

Table 3–16 Status of the NF for Centralized Discrepancy Resolution

Quantity Discrepancy Cost Discrepancy Tax Discrepancy Status

Yes No No In Discrepancy

Yes Yes No In Discrepancy

Yes No Yes In Discrepancy

No Yes Yes Validated

No No Yes Validated

Yes Yes Yes In Discrepancy
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Figure 3–18 Fiscal Docs Find Window

If there is quantity, cost or tax discrepancy, the Fiscal Documents window displays the 
status of NF as In Discrepancy.

Figure 3–19 Fiscal Documents Window with NF In Discrepancy status

In the Header area of the Fiscal Documents window, the check box is selected for the 
discrepancy that is present on the NF as shown in Figure 3–20.

Figure 3–20 Header Info Tab of the Fiscal Documents Window

Centralized Resolution Discrepancy Process
In the centralized discrepancy resolution process, the quantity discrepancy is resolved 
at the receiving location or at the centralized location. The cost and tax discrepancies 
may not be resolved, but the nota fiscal will be in Validated status. The process to 
resolve quantity discrepancy is given below. 

Quantity Discrepancy
In order to resolve quantity discrepancy, do the following: 

1. From the Options menu in the Fiscal Documents window, select Discrepancy 
Resolution. The Discrepancy Resolution window opens.
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Figure 3–21 Discrepancy Resolution Window

As highlighted in Figure 3–21, the check box for Qty is selected to indicate 
quantity discrepancy.

2. Click Resolve Qty in the Discrepancy Resolution window to resolve only quantity 
discrepancy. The Discrepancy Resolution window displays the quantity details.

Figure 3–22 Discrepancy Resolution (Quantity)

3. In the Discrepancy Resolution window, the list in the Resolution Action field has 
two options – System or Nota Fiscal. Select one of the options. Click Resolve Disc. 

Note: It is not necessary for the all the discrepancies to exist together.

Note: Depending on the system options set, ORFM decides the 
action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal 
option is disabled. You have to select System to resolve the 
discrepancy.
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4. The message – "Selected Resolution Action will be applied to all the discrepant 
records. Are you sure you want to continue?" is displayed. Click Yes. You are 
returned to the Discrepancy Resolution window. Notice that the check box for 
quantity is not selected, and the Resolve Qty button is disabled as highlighted in 
Figure 3–23.

Figure 3–23 Discrepancy Resolution with Resolved Quantity 

5. Click OK. You are returned to the Fiscal Documents window. The status of the 
Nota Fiscal is changed to Validated, if no other discrepancies exist.

6. In the Receiving/Issue Schedule window, from the Options menu, select Sub. for 
Recv.

7. The status of schedule changes from Validated to Subm. for Recv.

8. After the items are received, the status of the nota fiscal changes to Received.

9. Since there is a quantity discrepancy, you have to review the received quantities, 
before the nota fiscal can be approved. From the Options menu, select Verify 
Received Qty. The Received Quantities window opens. 

Figure 3–24 Received Quantities Window
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10. In the Received Quantities window, click Verify.

In this window, review the quantity of merchandise received. After reviewing the 
quantity of merchandise received, the status of the NF changes to Approved if 
there are no pending discrepancies to be resolved.

11. A correction document is generated, depending on what you have selected while 
resolving the quantity.

Return NF and Merchandise without NF Report Generation  

Return NF and Merchandise without NF report can be generated at every NF level in 
the schedule. These reports are generated only if there is any return NF quantity or 
merchandise without NF quantity for any item on the NF.

The Return NF is sent to the supplier for the extra or damaged quantities. The cost and 
the tax details for the quantity of merchandise to be returned to the supplier are 
calculated.

To generate merchandise without NF, do the following: 

1. In the Fiscal Documents window, from the Options menu, select Print Correction 
Docs. The Correction Documents List window opens.

Figure 3–25 Correction Documents List Window

The Correction Documents grid section lists all the correction document types that 
can be generated for the NF. The list may include the following, and depends on 
the corrective action taken:

■ Return NF - To return the stock to the supplier that was either received in 
excess or was damaged and hence rejected by Warehouse Management 
System (RWMS) or Store Inventory Management System (SIM), a Return NF is 
generated.

After excess or damaged receiving, if system generates Return NF report and 
auto generates Return NF in Exit mode with the reference number of main NF.

■ Merchandise without NF – If any item is received without mention on the NF, 
it is listed in the merchandise without NF report. This is an internal report that 
need not be sent to the supplier. Any such inventory is handled outside the 
system and it is not accounted as on-hand inventory.

■ Discrepancy Report – This document is generated when there are 
discrepancies. You can send the discrepancy report to correct the cost, quantity 
and tax discrepancies.

■ Complementary NF Request – This document is generated when the supplier 
has incorrectly charged lower taxes than system calculated taxes. Print this 
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document and send it to the supplier requesting the complementary NF with 
corrected taxes.

2. To print the document, select the check box for merchandise without NF. 

3. Click Print. The merchandise without NF is printed.

De-centralized Discrepancy Resolution Process
In the de-centralized discrepancy resolution approach, all the discrepancies are 
resolved at the location where the merchandise is to be received. The receiving location 
may be a warehouse or store.

The cost and tax discrepancy resolution processes are described below.

Cost Discrepancy
In order to resolve cost discrepancy, do the following:

1. From the Options menu in the Fiscal Documents window, select Discrepancy 
Resolution. The Discrepancy Resolution window is displayed.

Figure 3–26 Discrepancy Resolution Window

As shown in Figure 3–26, if there is cost, and tax discrepancy, the check boxes for 
Cost, and Tax are selected.

2. Click Resolve Cost in the Discrepancy Resolution window to resolve the 
discrepancy in cost.

3. The Discrepancy Resolution window displays the cost details. In this window, the 
list in the Resolution Action field has two options – System or Nota Fiscal. Select 
one of the options. Click Resolve Disc.

Note: To know more about resolving quantity discrepancy, refer to 
Quantity Discrepancy.
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Figure 3–27 Discrepancy Resolution Window

4. The message – "Selected Resolution Action will be applied to all the discrepant 
records. Are you sure you want to continue?" is displayed. Click Yes. You are 
returned to the Discrepancy Resolution window. Notice that the check box for 
Cost is not selected, and the Resolve Cost button is disabled as highlighted in 
Figure 3–28.

Figure 3–28 Discrepancy Resolution with Resolved Cost

5. Click OK. You are returned to the Fiscal Documents window. The status of the NF 
changes to Validated.

6. Click Close. You are returned to the Receiving/Issue Schedule window. From the 
Options menu, select Sub. for Recv.

7. After the items are received, the status of the nota fiscal changes to Received, if 
there are any overages/damages and under-receiving. Else, the status of NF 
changes to Approved.

Printing Correction Documents  

If the System Option is set to System, then a correction document is generated 
whenever a discrepancy occurs. The NF has to be in Approved status.

Note: Depending on the system options set, ORFM decides the 
action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal 
option is disabled. The list for resolution is disabled and the default 
method of resolution then becomes 'System'.
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1. From the Options menu in the Fiscal Documents window, select Print Correction 
Docs. The Corrections Document List is displayed.

Figure 3–29 Corrections Document List Window

2. Select the check box for Discrepancy Report.

3. Click Print. The correction document for the cost discrepancy is printed.

Tax Discrepancy
In order to resolve tax discrepancy, do the following:

1. From the Options menu, select Discrepancy Resolution. The Discrepancy 
Resolution window is displayed.

Figure 3–30 Discrepancy Resolution window with Tax Discrepancy

2. Click Resolve Tax in the Discrepancy Resolution window. The system and 
informed tax are displayed in the Discrepancy Resolution window.

The system tax includes:

■ Base Value – The basis for calculation of the tax

Note: The Print Correction Docs option is enabled only for 
approved NFs. 
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■ Modified Base Value – Contains the taxable basis changed by external tax 
engine for tax calculation. This happens when a tax rule modifies the taxable 
basis, mostly in the form of a lower taxable basis. It reflects the taxable basis 
the tax rate is actually applied on by external tax engine

■ Value – The total value 

The informed tax includes

■ Base Value – Informed calculated basis for the tax

■ Modified Base Value – The changed basis, which flows from the external tax 
engine. This value is applicable for only certain items that are eligible for a tax 
rule, which modifies the basis on which the tax rate is calculated.

■ Value – The informed total value for the tax 

Figure 3–31 Tax Discrepancy Window

3. In this Discrepancy Resolution window, click Item Details. The Item Tax Details is 
displayed in the Discrepancy Resolution window.

Figure 3–32 Item Tax Details Window

Table 3–17 Item Tax Details Fields and Description

Fields Description

Tax Code The tax code returned by the external tax engine
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4. In the Resolution By field, click the list, and select from resolve by either System or 
Nota Fiscal. Click Resolve Disc.

5. The message – "Selected Resolution Action will be applied to all the discrepant 
records. Are you sure you want to continue?" is displayed. Click Yes. You are 
returned to the Discrepancy Resolution window. Click Close.

System Taxable Base Value The total basis on which the tax is calculated

System Tax Value The total tax value returned calculated by the tax engine

Informed Taxable Base 
Value on NF 

The total taxable basis apportioned to the line level by the 
application

Informed Tax Value on NF The total taxable value apportioned to the line level by the 
application

Item Tax Details Section

Item The merchandise number

Order No The purchase order number

Base Value System Tax – The basis used while calculating the tax

Apportioned Tax on NF – The apportioned tax basis value 
calculated for the fiscal line using the header tax basis values

Modified Base Value System Tax – Modified Base Value is applicable to items that are 
eligible to a tax rule that modifies the taxable basis

Apportioned Tax on NF – Modified apportioned tax basis value 
calculated for the fiscal line using the modified header tax basis 
values.

Rate System Tax – The tax rate at the item level

Apportioned Tax on NF – The apportioned tax rate calculated at 
the fiscal line level

Value System Tax – The system tax value of the individual item

Apportioned Tax on NF – The apportioned tax value calculated 
for the fiscal line using the header tax value

Value/Unit System Tax – The unit tax amount calculated

Apportioned Tax on NF – The apportioned unit tax amount 

Resolution By The resolution can be either as per the System or as per the Nota 
Fiscal

Reason The reason for the resolution action (optional) 

Note: Depending on the system options set, ORFM decides the 
action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal 
option is disabled. The list for resolution is disabled and default 
method of resolution is set as 'System'.

Table 3–17 (Cont.) Item Tax Details Fields and Description

Fields Description



Complementary NF

3-34 Oracle® Retail Fiscal Management User Guide

In the Discrepancy Resolution window, notice that the check box for Tax is not 
selected, and the Resolve Tax button is disabled as highlighted in Figure 3–33. The 
Status of the Nota Fiscal is changed to Validated.

Figure 3–33 Discrepancy Resolution Window

6. Click Close in the Discrepancy Resolution window. You are returned to the Fiscal 
Documents window. The status of the NF is changed to Validated. 

7. Click OK in the Fiscal Documents window. The Fiscal Docs Find window opens. 
The status of the NF is displayed as Validated.

8. Click Close in the Fiscal Docs Find window. The Receiving/Issue Schedule 
window opens. From the Options menu, select Sub. for Recv.

9. After the items are received, the status of the nota fiscal changes to Received, if 
there are any overages/damages and under-receiving. Else, the status of NF 
changes to Approved.

10. After the NF is approved, a correction document or complementary NF for tax is 
generated, based on what you have selected while resolving the discrepancies. 

Complementary NF 
In the following scenarios, the supplier may issue an additional (complementary) NF 
in addition to the regular NF and may impact the total amount payable and landed 
cost (WAC) of the item.

■ The utilization attributes are set up to one of the below values to differentiate the 
type of Complementary NF: Triangulation Purchase (additional NF from Delivery 
Supplier)

■ Non-merchandise cost charged by a different supplier that is, partner 
(non-merchandise NF)

Note: If more than one component of the tax is in discrepant state, 
then the Discrepancy Resolution window displays the details of all the 
tax components. Follow the procedure listed in steps three to five to 
resolve the tax discrepancy.
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■ NF for Cost Correction

■ NF for Tax Correction

■ NF for Transfers

For more information on the set up, see Fiscal Utilization Attributes Window.

Complementary NF for Triangulation
While creating the purchase order, the user can mention a supplier (referred to as the 
main supplier) to whom the payment is made and another supplier (a distributor or 
facilitator) who actually delivers the stock on behalf of the main supplier (referred to 
as the delivery supplier). This mechanism is referred to as the triangulation purchase.

The main supplier and the delivery supplier may be located in different states. In such 
cases, the state level taxes like ICMS and ICMS-ST are calculated based on the location 
of the delivery supplier.

In triangulation purchases, the retailer receives two NFs for the same inventory. One 
from the main supplier, which primarily serves as an invoice for making the payment 
and another from the delivery supplier, which serves as a bill of lading document. This 
document is referred to as the complementary NF for triangulation. Since ICMS and 
ICMS-ST depend on the delivery supplier's location, they appear on the delivery 
supplier's NF.

Complementary NF Processing for Triangulation
To create a complementary NF for triangulation, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Contents 
Of Fiscal Management.

1. In Contents Of Fiscal Management, select Login of Location. The Location Login 
window opens.

2. In the Location Login window, select the store or warehouse of the main supplier. 
Click the Location LOV to obtain the list of stores or warehouses. Select the 
location and click OK.

3. In Contents Of Fiscal Management, click Receiving/Issue. In Contents Of 
Receiving/Issue, click Edit. The Receiving/Issue Schedule window opens.

4. In the Receiving/Issue Schedule window, click Add. A new NF is created in the 
Entry mode. 

5. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window opens.

6. Click Add in the Fiscal Docs Find window. The Fiscal Documents window opens. 
Enter the Utilization code for triangulation.

7. Enter the other values in the Fiscal Documents window. The NF is created in the 
Worksheet status.

8. Click OK. You are returned to the Fiscal Docs Find window. The Fiscal Docs Find 
window displays the NF that is created in the worksheet status.

9. Create another NF using the same process as given above. This is the 
complementary NF, and it has to be in the same schedule as the main NF. It should 
have the same item details as the main NF.
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10. After creating another NF, return to the Fiscal Docs Find window, and select the 
first NF created for the main supplier. 

11. Click Complement on the Fiscal Document window. The Complement Fiscal Doc 
window opens.

Figure 3–34 Complement Fiscal Doc Window 

12. In the Complement No column, select the complementary NF. Click Add to link 
this NF with the main NF.

13. Click OK to return to the main NF. From the Options menu, select Validate. The 
status of NF changes to Validated, if there is no discrepancy between the two NFs. 
You are returned to the Receiving/Issue Schedule window.

14. In the Receiving/Issue Schedule window, select the NF and submit it for receiving. 
From the Options menu, select Sub. for Recv.

Complementary NF for Non-Merchandise Cost
Complementary NF for non-merchandise cost is generated to account for the freight 
charges incurred during transportation of merchandise. The non-merchandise cost 
refers to Freight Cost, Insurance Cost, and Other Expenses. Non-merchandise cost is 
charged by a different supplier (or partner). In such cases, the supplier has to issue an 
additional NF or complementary NF in addition to the regular NF. 

In Complementary NF for non-merchandise cost, NFs can have multiple main NFs or 
none. Once the main NFs are associated to the Complementary NF for 
non-merchandise cost NF, the cost components are apportioned to the items that are 
present in the main NF.

Note: The data integrity validation has to display an error if either of 
the NF is not entered in the application.
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Complementary NF Processing for Non-Merchandise Cost 
To do the NF Processing for non-merchandise cost, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Login of 
Location. The Location Login window is displayed.

1. Select the location from the Location LOV in the Location Login window.

2. Click OK to exit the window.

3. From the RMS Start Menu, select Receiving/Issue. In the Contents Of 
Receiving/Issue, click Edit. The Receiving/Issue Schedule window is displayed.

4. Click Add in the Receiving/Issue Schedule window.

A new schedule is created.

5. Select the new schedule and click Fiscal in the Receiving/Issue Schedule window. 
The Fiscal Docs Find window is displayed.

6. In the Fiscal Docs Find window, click Add.

The Fiscal Documents window is displayed.

7. In the Fiscal Documents window, select Purchase Order as the Requisition Type 
from the list. 

8. In the Utilization field, set the Utilization field for both Comp NF for Merchandise 
and Non-Merchandise.

After you enter the Utilization as Comp NF for Merchandise and 
Non-Merchandise, in the Header Details of the Fiscal Documents window, the 
Service and Merchandise Cost fields are disabled. Requisition Doc button is 
disabled.

The Additional Costs fields that include Freight, Insurance, and Other Expenses 
are enabled. In the Line Item Detail section, the fields in the Detail Info tab and 
Detail Taxes tab are disabled.

9. Enter the expenses incurred for freight and insurance in their respective fields. If 
other expenses are present, enter the details in the Other Expenses field. 

The Totals in the Header Details section is also enabled.

10. Click Complement to associate this NF with the main NF.

11. In the Fiscal Documents window, from the Options menu, click Validate. 

During the validation process, the total cost is validated. After the validation, 
status automatically changes to Approved.

Note: You can link the Complementary NF for Non-Merchandise 
Cost to a schedule. The Complementary NF for Non-Merchandise 
Cost can remain without a schedule. 

Multiple main NFs can be attached to one Complementary NF for 
Non-Merchandise Cost. However, you cannot associate the 
Complementary NF to any main NFs. 
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Complementary NF for Cost/Tax Correction
Complementary NF for Cost/Tax is generated by the Supplier when there is 
additional costs to be paid by the Retailer because of some discrepancies in the original 
NF generated for the Purchase Order. 

There can be multiple complementary NFs for cost and tax correction that correspond 
to one main NF. But one complementary NF cannot correspond to more than one main 
NF. In case of cost and tax discrepancy in one main NF, the supplier may send one 
complementary NF for cost correction and one complementary NF for each tax code 
correction; or the Supplier may send single complementary NF for the correction of 
cost and all the taxes.

The complementary NF for cost and tax will result in updating the cost in RMS. 

Complementary NF Processing for Cost/Tax Correction
To do the NF Processing for cost/tax correction do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Login of 
Location. The Location Login window is displayed.

1. Select the location from the Location LOV in the Location Login window. Click 
OK to exit the window.

2. From the RMS Start Menu, select Receiving/Issue. In the Contents Of 
Receiving/Issue, click Edit.

The Receiving/Issue Schedule window is displayed.

3. Click Add in the Receiving/Issue Schedule window. 

A new schedule is created.

4. Select the new schedule and click Fiscal in the Receiving/Issue Schedule window. 
The Fiscal Docs Find window is displayed.

5. In the Fiscal Docs Find window, click Add. The Fiscal Documents window is 
displayed.

6. In the Fiscal Documents window, select Purchase Order as the Requisition Type 
from the list. 

7. In the Utilization field, set the Utilization to Comp NF for Cost/Tax Correction.

After you enter the Utilization as Comp NF for Cost/Tax Correction, in the Header 
Details of the Fiscal Documents window, the Service and Merchandise Cost fields 
are disabled. Requisition Doc button is disabled.

The Additional Costs fields that include Freight, Insurance, and Other Expenses 
are enabled. In the Line Item Detail section, the fields in the Detail Info tab and 
Detail Taxes tab are disabled.

8. Enter the expenses incurred for freight and insurance in their respective fields. If 
other expenses are present, enter the details in the Other Expenses field. 

The Totals in the Header Details section is also enabled.

9. Click Complement to associate this NF with the main NF.

Note: You can associate only one main NF to a Complementary NF 
for Cost/Tax Correction. 
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10. In the Fiscal Documents window, from the Options menu, click Validate.

During the validation process, the total cost is validated. After the validation, 
status automatically changes to Approved.

Importation
Oracle Retail Fiscal Management module have the capacity to support the NF related 
as-pects of the importation process in Brazil, although it is not in scope to support the 
entire importation process from the purchase, transport, customs, and so on. More 
specifically RFM module has the capacity to handle the processing of the NF (nota 
fiscal) and inven-tory updates, with restrictions that will be explained in this 
document.

Integration to an importation specialist solution is required for the tasks not supported 
in RFM. Before getting into these details, some concepts must be clarified:

Localization Fiscal Attributes 
RMS supports the creation of foreign (non-Brazil) suppliers. All localization fiscal 
attrib-utes are disabled for this type of supplier. Item master data and localization 
attributes at item/country level are required even if the item/supplier link is not made 
with a Brazilian supplier. 

Item Costing and PO Tax Breakup 
Item costing and PO tax breakup are not performed using the tax integration layer in 
case of non-Brazil suppliers. 

Advanced Payment Invoices 
It is normal to have an invoice being sent to the retailer for advanced payment or, in 
sev-eral cases, just after shipment, an invoice is sent from the vendor to the importer. 
This type of invoice is meant for payment only and it is not used for inventory updates 
or even for the clearance process.

The assumption in Oracle Retail is that this type of invoice should be sent directly to 
fi-nance system. There should not be any posting of this type of invoice in RFM/RMS.

The advanced payment invoice may have different currency rates from the final 
docu-ment generated and used to transport the goods (DI - Import Declaration). The 
stock ledger would always be updated based on the final document (DI).

The payments will be considered out of RFM/RMS scope. The letter of credits should 
be controlled by the finance system and the assumption in RFM/RMS is that this type 
of purchase will be always pre-paid.

Receiving of Importation Purchases 
In Brazil there are different ways for a retailer to manage and process the importation, 
especially the clearance process. It is possible for a retailer to do the clearance process 
himself and be responsible for all activities involved, and also be possible for a retailer 
to hire a third-party company to handle the clearance and all paper work involved. In 
that case, this third-party company will handle the importation from a NF stand point. 

Considering the different ways to handle clearance, we can list: 

■ Direct Import: When the retailer is responsible for the clearance process and for 
issuing the NF necessary to move the goods. 
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■ Import on behalf of thirds: When a third-party company or trading is in charge of 
handling the clearance process on behalf of the retailer (buyer). From the NF 
perspective this trading company will be in charge of issuing an internal domes-tic 
NF to the retailer in a specific transaction code (CFOP) that reflects this 
im-portation mode. 

■ Import by Order: When a trading company makes the importation from 
documentation, clearance and NF aspects, but the destination of the goods is a 
pre-defined company (retailer). In this case the NF from this company to the 
retailer will be a regular domestic sale.

Direct Import NF 
Assuming a third-party solution is in charge of the importation, clearance and the 
generation of the entry domestic NF for the imported products, RFM will be able to 
receive this NF in two different modes: 

1. NFe generated by RFM: third-party trading system provides the necessary 
in-formation for the NFe generation in RFM, using NFe sequence number 
main-tained in RFM and from there it will be authorized by the SEFAZ through 
NFe integration, and follow with the physical receiving flow. 

2. NFe generated by external system: third-party trading system provides NFe 
information already generated and authorized so that RFM doesn't need to do it. 
RFM will just follow with the fiscal and physical receiving flow. 

It is important to note that the system does not recognize, in fiscal document lev-el, if 
the NF was generated by RFM or external system. It is managed by RFM system 
option 'DI_NF_SERIAL_GENERATION_IND', which determines the be-havior of the 
process. There's no way to have both operating scenarios simulta-neously. 

Another important assumption is that in any of the scenarios above, the NF data 
coming from third party trading system must have all necessary information, taxes, 
recoverable taxes, fiscal codes, and so on. The reason for that is RFM will not perform 
tax calls for direct import receiving process. 

The direct import NF can be inserted in RFM via EDI tables or manually via screen. 
The EDI and screen have specific data related to this type of NF. The direct import 
domestic NF must have specific fields that are based on the clearance process and a 
document called Import Declaration or DI. 

All needed data from DI is placed in Importation NF in RFM system, in tab 
"Importation Detail".

Multiple Deliveries for the Same Importation (DI) 
In case of Direct Import, one DI should normally result in one Entry NF, however the 
DI is issued based in the entire order. It can happen that all entire order needs to be 
transported in more than one vehicle. In reason of legal inspection, each truck that 
transports merchandise needs to have the printed DANFE NF related only with 
merchandises that are being transported in that particular vehicle, so Import Order NF 
should be break in "child" NFs. 

All NFs must be entered in the system (main NF and child NFs). As the goods will be 
received partially, the stock should be updated based on each child NF. These child 
NFs have specific CFOP codes and must be related to the main NF. 

The sum of all partial NFs issued for transportation must match with the total of the 
main NF. On approval of all child NFs, the main NF would automatically be 
approved. 
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In RFM system, only one DI NF (parent or child) is allowed per schedule. If a second 
Direct Import NF is associated with a schedule with an existing NF, sys-tem will show 
an error message: "For Direct Import NF there can be only one NF per schedule". The 
fiscal reporting of these NFs (main and child) requires the re-lationship between them 
and the identification of each one as main or child. 

For an Import Order, there must be one parent NF and at least two child NFs 
as-sociated with it. If there is only one child NF associated with a DI Parent NF, 
sys-tem will show a warning message: "DI Parent NF must have at least two child 
NFs". 

First, a parent NF is created, and then validated successfully. Next, two child NFs are 
created. After the two children have been created in Worksheet status, they must be 
validated. 

Receiving Process for Direct Import NF 
Manual entry (via screen) 

In case DI PO NF is captured using RFM UI, user would use the existing flow to 
capture NF. Following details will be distinct for DI NFs: 

1. NF Requisition: Purchase Order requisition would be leveraged for DI PO NF 
capture.

2. Each DI NF would be associated to individual schedule. A schedule will not be 
shared between many NFs, there will always be one schedule per DI NF. Reason 
being that it is not known whether a DI NF has child NFs or is a single DI NF 
during schedule creation, hence the need to limit the association of NF to 
sched-ule. If a schedule is already associated to a DI NF, another NF cannot be 
associ-ated to that schedule. 

3. Utilization: There can be two types of NF captured as part of Direct Import. There 
can be a main NF and multiple child NFs. User needs to associate appro-priate 
utilization code to DI NFs (both main and child) based on Import Order Type, 
such as, Direct Import. 

4. When utilization attached to the NF has Import Order Type set as Direct Im-port. 
RFM would allow NF Issuer and NF addressee to be set up as follows: 

5. NF Addressee / Sender: Foreign supplier. Addressee/Sender field is a dual use 
field, and foreign supplier is "Sender".

6. Following fields to be captured for both main and child DI NFs under a new tab 
"Importation Details" (when utilization ID has Direct_Import_Indicator as TRUE): 

■ DI number: Import Declaration number at NF header level. 

■ DI Issue Date: Import Declaration issue/register date at NF header level 

■ DI Type: 0 for Import Declaration, 1 for Simplified Import Declaration 

■ Customs details:

– Customs Place: Location where customs happened 

– Customs State: State where customs happened 

– Customs Date: Date on which customs happened 

■ Fiscal Authority ID: Identification of the fiscal authority that approved the 
clearance process at NF header level. 
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■ Exchange Rate: Exchange rate will be captured for each NF line level on Main 
NF only. Same importation may have products with different origins (Europe, 
Asia, and so on) and the DI issued may have different rates for each item 
de-pending on the currency of the origin of those items (Euro, Dollar, and so 
on). NF will have a rate at line level. It is assumed that exchange rate date 
would come in EDI NF details. Exchange rate date would be disabled post NF 
validation of manual or EDI NF. 

■ Child NFs indicator: Indicator at NF header level on Importation Details tab 
under Parent NF section to identify a DI NF as child NF, such as, NF with a 
par-ent NF.

– When "Is Child Ind" indicator is unchecked (by default), the main NF LOV 
would remain disabled. It would be assumed that DI NF is the main NF 
(with or without child).

– When "Is Child Ind" indicator is checked, such as, TRUE, Parent NF LOV 
would be enabled. It is expected that child NF is associated with one 
parent NF. LOV would show only those parent NFs which are not 
approved and belong to the same supplier. Validations will be in place to 
associate child NF with aren't NF. If any of these validations fails, then 
RFM should not allow association of child NF with Parent NF. 

■ DI number and date on child NF should be same as main NF's 

■ Child NF should hold the main NF's number, serial and issue date 

■ Fiscal authority ID on child NF should be same as main NF's 

■ RFM to perform line level check between child and Main NF when child NF is 
validated: 

– If any item exists on child NF but do not exist on parent NF, then child NF 
would not be processed. RFM would throw an error that "One or more 
items on child NF is/are not present on parent NF" 

– Quantity check at line level: If parent NF has item X with quantity 
specified as P, then total quantity of item X on all child NFs should not go 
beyond P, for example, at a given time total quantity of X on child NFs 
should be less than equal to P. If total quantity of an item on all child NFs 
is more than specified on parent NF, RFM would not process the last child 
NF and would throw an error that "One or more items on child NF 
has/have more than expected quantity" 

– In case system option DI_UNIT_COST_COMP is "S", RFM should match 
unit cost on child NF with main NF. RFM should also ensure that total 
merchandise value of main NF should be greater than or equal to sum of 
merchandise value of related child NFs. Once all child NFs are referenced 
to main NF, the total product line value of main NF should be equal to 
sum of product line values of child NF. In case child NF has different unit 
cost or sum of child NF merchandise value is more than parent NF 
merchandise value, RFM should not allow child NF to be validated and 
should bring it to error status. Rejection reason should be logged. 

– In system option DI_UNIT_COST_COMP is "T", RFM should only match 
total value of Parent NF with total value summed of all child NFs. In case 
sum of child NF value is more than parent NF value, RFM should not 
allow child NF to be validated and should bring it to error status. 
Rejection reason should be logged. 



Importation

Purchase Order 3-43

■ Once child NF is associated to a parent NF, parent NF cannot be moved back 
to worksheet status. 

1. Following fields will be captured at line level on Direct Import NF: 

■ Additions details will be captured at item line level under a new tab 
"Additions": 

– Addition Number

– Sequence Number of the item in the addition 

– Foreign Manufacturer Code 

– Value of the discount of the item of DI - addition 
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2. DI NF will be validated. Once Main NF is in validated status, it can be associated 
to child NFs. 

■ Validation for Main DI or Child NF will not have tax calls. 

■ Comparison with PO will happen for cost and quantity, but in case of any 
discrepancy, the NF will be put in "Calculated" status as there will be no 
discrepancy treatment for direct import scenario. Cost and quantity 
dis-crepancy treatment between NF and PO will always result in NF informed 
value as being correct. User will not be required to treat discrepancy. RFM will 
display a soft warning message whenever there is a cost or quantity 
discrepancy to state that discrepancy is being resolved by considering NF 
informed value as correct value. As there is no discrepancy identification or 
treatment, in case there are items on NF without a valid PO. It would be a 
manual business process to include such line items on a PO before receipt. 
Also there will not be any merchandise without NF report as it is assumed that 
NF information is always correct. If there are any discrepancies, all would be 
handled separately through retailer's business process. 

■ User would have an option to navigate to discrepancy resolution option and 
view drm_header screen. Further user would have an option to navigate to 
Resolve Cost option and view drm_detail screen. If user clicks on Item 
De-tails, the system shows Item Tax Details, but it is not allowing any user 
driven resolution. By default, RFM will perform resolution by Nota Fiscal and 
reason as "Importation Scenario". This would not be allowed to be fur-ther 
changed by user. To summarize, the resolution would always be in favor of NF 
informed values. 
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■ User would further have an option to approve NF once NF is in "Calculated" 
status. 

The user will be able to view discrepancy resolution in Discrepancy Resolution 
window, but no action will be allowed.
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Quantity Resolution Window 

Taxes Resolution Window 

3. After validation, the schedule can be submitted for receiving. 
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■ If main NF is associated to a child NF as parent NF, main NF cannot be 
submitted for receiving. Submit for receiving functionality would be disabled 
in such a case. 

■ RFM would not allow user to submit NF for receiving until NFe is validated 

■ In case main NF is related to child NFs, once all child NFs associated to Main 
NF are approved, the main NF will automatically move to approved status. 

■ No receipt will be processed or posted for Main NF with child NFs. Schedule 
of main NF would not be sent to WMS/SIM for receipt. 

■ If main NF is not related to child NF and user tries to submit main NF for 
receiving, RFM would display a message to confirm whether the main DI NF 
has any child NFs: 

– If user's response is YES, then RFM will not allow main DI NF to be 
submitted for receiving. 

– If user's response is NO, then main NF would be submitted for receiving 
and will not be applicable to be related as a parent NF to any child NFs in 
future. 

■ Each child NF would be associated to its individual schedule which would be 
sent for receiving to WMS/SIM. 

■ Once schedule is submitted for receiving; WMS/SIM will receive based on 
appointed quantity. Post receipt, in case of any discrepancy between 
appointed quantity and received quantity, there will not be any receipt 
verification. 
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– NF quantity will be posted as received quantity to RMS as part of receipt 
de-tails. Receipt details will be posted to RMS like any PO receipt posting. 
It is assumed that any receipt discrepancy will later be handled in WMS 
through inventory adjustments. RFM will move NF to approved status 
post receipt. Normal procedure for importers is to receive the goods and 
update system based on the Entry NF. Possible discrepancies or damaged 
items encountered in the WH/ST are normally treated as manual 
inventory adjustments 

Complementary NF for import duties 
Besides the entry NF necessary to transport and include all items in the system, there 
are additional costs in the clearance process that must be added to the product cost 
and val-uate the inventory. These costs are related to services hired in the clearance 
process. A complementary Entry NF must be generated, with all items from the main 
NF and the additional costs to be apportioned to each item. This NF meant only for 
cost adjustments must be sent for fiscal reporting. GL postings would happen in RMS 
for cost correction. 

RFM should allow association of complementary cost and tax NFs to main DI NFs 
only. Child NF will not have complementary cost and tax NFs. RFM should continue 
to post complementary cost and tax details to RMS, like normal PO process.

Import on Behalf of Thirds (Conta e Ordem) 
The clearance process in this type of importation will be handled by a third-party 
com-pany. That company will only take care of the paper work and clearance activities 
at the customs. The Entry NF in this case is issued by the third-party company that 
will use it to enter all goods in their own location. After that, the third-party company 
will generate another NF that will have all taxes already calculated but the issuer will 
be the third party and the addressee will be the retailer. That NF will be issued with a 
specific CFOP code that will represent this type of transaction. 

This NF coming from the domestic partner will be associated to the correspondent 
import PO originally created for the foreign supplier. To support this requirement, 
RFM will al-low capture of supplier other than the foreign supplier on PO when 
Import Order Type is "CONTA E ORDEM". NF capture would be similar to regular PO 
NF. User would be re-quired to select appropriate utilization and import supplier. 
RFM would further allow user to lookup for import POs with the same utilization 
code although supplier on the PO may be different from supplier on NF. Match doc 
functionality can also be utilized to filter out POs. 

Receiving Process for Import on Behalf of Thirds 
Expected process flow would be as follows: 

1. User captures NF details along with informed taxes in RFM 

2. User validates the NF by clicking on Validate from option menu 

3. RFM will call 3rd party tax engine to calculate taxes on NF 

Note: IPI tax captured on DI NF should be captured as recoverable 
tax. Placeholder on screen would still remain the same. Import IPI 
would be recoverable tax, hence RFM would exclude IPI from 
Extended Basis Cost (EBC) in importation order scenarios.
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4. In case of any discrepancy between informed and calculated taxes, RFM will not 
move the NF to "In Discrepancy" status but will move the NF to "Calculated" 
status (New sta-tus). Although the tax discrepancy check box on header info tab 
would be checked in case there is any tax discrepancy. User would have an option 
to navigate to discrepancy reso-lution option screens, but they will not allow any 
user driven resolution. By default, RFM will perform resolution by Nota Fiscal and 
reason as "Importation Scenario". This would not be allowed to be further changed 
by user. To summarize, the resolution would always be in favor of NF informed 
values. 

5. User would further have an option to approve NF once NF is in "Calculated" 
status. 

6. User will submit NF for receipt, post receipt RFM will not show any receipt 
verification in case of any discrepancy between appointed and received quantity. 
RFM will override receipt quantity with NF informed quantity in the receipt, and 
post the receipt to RMS. Any quantity difference must be treated through 
inventory adjustments or stock counts. 

Import By Order (Encomenda) 
The clearance process in this type of importation will be handled by a third-party 
company. That company will take care of the paper work and clearance activities at the 
customs and will play the role of the importer but with a pre-defined destination of all 
imported goods. The Entry NF in this case is issued by the third-party company that 
will use it to enter all goods in their own location. After that, the third-party company 
will generate another NF that will have all taxes already calculated but the issuer will 
be the third party and the addressee will be the retailer. That NF will be issued as a 
regular domestic sale. Import By Order NF would be similar to "Conta e Ordem" NF. 

The main difference between Import by Order and "Conta e Ordem" is about taxation. 
In the previous one, all taxes except ICMS are based on the DI document and cannot 
be corrected by the retailer in case of a discrepancy. In the import by order, only the IPI 
is based on the DI value. ICMS, PIS, COFINS are calculated by the third-party 
company in the sale transaction. Also, the PO in this case is issued to the domestic 
supplier and the payment is also made to him. 

From a process stand point, RFM will have exact same behavior for this type of 
importation and for "Conta e Ordem".

Imported Items Balance Control 
In Brazil, all products manufactured in domestic market are subject to the IPI in the 
sales transaction from the manufacturer to wholesaler or retailer. In this case the 

Note: As PO would be in foreign supplier currency and NF in BRL, 
RFM would convert PO cost in supplier currency to BRL currency 
when PO and items are selected for NF entry. To support this 
requirement, RFM will leverage the exchange rate field that can be 
informed similarly to the Direct Import scenario. This attribute will 
capture the date to be considered to determine exchange rates for 
currency conversions from PO currency to BRL. By default, this 
exchange rate date field on NF header will be blank, and default 
exchange rate date would be PO approval date for individual PO lines 
on the NF. In case user records a value for exchange rate date, then 
exchange rate calculations for all POs on the NF
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manufacturer is responsible to collect this tax to the government. In a scenario of 
importation, the im-porter would play the same role as a manufacturer from the 
perspective of the tax inci-dence. In that way, even if the importer is a wholesaler or a 
retailer, the IPI is calculated for all imported items in the Entry NF and in the 
subsequent transaction (sale, transfer, and so on). 

Normally, in regular domestic purchases done by retailers, the IPI is considered a 
non-creditable tax because it was already collected to the Government by the 
manufac-turer; hence from the perspective of the retailer that is purchasing these 
products, the IPI is considered a cost and it is included in the inventory valuation and 
WAC calculation. In the case of importation this behavior is different. IPI will be 
considered as creditable tax for the importer (wholesaler or retailer). The imported 
items must have the IPI calculated and collected in the first "exit" transaction whatever 
it would be (transfers, sales, and so on). Normally, when a retailer imports goods to a 
distribution center, the subsequent transaction would be a transfer. So the IPI must be 
calculated for this transfer. 

It is only on the first transfer of an imported item that IPI should be calculated. If the 
initial transfer is done to another DC, the subsequent transfer to the stores should not 
have IPI calculated (because it was already collected by the first DC). In the same way, 
if the second DC returns the same product to the importer DC and another transfer 
takes place from there, IPI should not be calculated, even the item being the same 
(because collection of IPI happens just once). 

In order to have this control, it is necessary to know which items were imported and 
which stock of these items are being transferred. There may be situations where same 
item can be imported and also purchased from domestic market. In that case, if the DC 
has inventory from both sources, only the quantities imported would have IPI 
calculated in the transfer 

In order to identify the stock as Imported, RFM tracks the inventory stock leveraging 
the table ITEM_LOC_SOH. This "bucket for imported stock" is controlled at item 
location level. The "bucket" is incremented or decremented based on following 
transactions: 

■ Whenever physical receipt of imported order is processed (utilization has Import 
Indicator as TRUE for any PO receipt, such as, for Direct Import, Conta e Ordem 
and Import by Order scenarios), RFM would increment it with the received 
quantity. 

■ Whenever stock is transferred out of a location (transfers or customer order) or 
there is a negative adjustment, RFM would check the value of "Imported" bucket. 
If there is any stock in imported bucket, imported bucket stock value would be 
decremented based on a new RFM level system option "PRIORITY_TSF_IPI_
IMPORTED" it would have valid value as TRUE to decrement imported stock first 
and then decrement non-imported stock on first exit, valid value as FALSE to 
decrement non-imported stock first and then decrement imported stock on first 
exit.

Note: Item retail sale if not through customer NF functionality will 
not be tracked in RFM.
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As suggested above, RFM splits the NFs for imported and non-imported stock based 
on bucket value. The tax calculation for imported stock NFs will be han-dled in 
TaxRules. In case of imported stock first exit NF, RFM should communi-cate the 
following additional details to TaxRules: 

■ Destination Retail: Retail price at destination is sent to TaxRules for the IPI basis 
determination. Basis can't be less than 90% of the retail price. The application of 
this percentage (90%) can't result in a taxable value smaller than the current price 
valid in the wholesale market from the is-suer region. 

■ Current market price: Retail price defined in the origin location is used as the 
market price. Normally source location will be a DC and retail price set for the DC 
(RPM can set the DC location as "priceable") can be considered the market price. 

Legislation states that the basis for IPI calculation will be "current price at wholesale 
market" OR "retail price", whatever is higher. TaxWeb will take the two prices and use 
the higher one. 

TaxRules will calculate IPI for the first exit of imported item along with other valid 
taxes. As retailer will play the role of a manufacturer in this transaction and will be IPI 
contributor in this case, the IPI will be at detail level, summed at header level.

Average Cost Calculation 
In a PO, the currency used is the currency defined in supplier foundation data. For 
importation POs, a foreign currency is used, however the invoice will always be in 
BRL currency. During the NF validation process, to perform cost discrep-ancy 
calculation, the item cost informed in NF is compared with unit cost in-formed in PO. 
As the currencies are different, a conversion is made from the for-eign currency to the 
local currency (BRL). 

The conversion from foreign currency to local currency is done in two ways. 

■ In the NF, it may contain the conversion rate used by the supplier. 

■ If there is any currency rate defined, it will be used currency rate defined in a 
conversion table in the system to perform the calculation. 

After physical receipt, the update of the unit cost of the item received will be the same 
for all transactions, which is at average cost. 

Deal Income Posting
ORFM takes care of posting all finance related documents (NFs) for merchandise 
inventory/goods movement and finance invoicing. For Deal Income, though there is 
no inventory movement, financial documents are generated to post the deal income to 
finance. 

Notes:

■ There is no stock update in FM_ITEM_LOC_SOH at destination 
location after transfers because this item is already nationalized, 
and the transfer is between locations in the same country.

■ For transfer, it always generates 2 NFs (one with only imported 
item quantity and another with only regular item) because 
imported items manage different taxes, as IPI.
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You need to define the default utilization in ORFM system options for deal NF. The 
Deal NF Utilization should be of requisition type PO. 

Deal NFs are auto-generated and are not editable through ORFM User Interface. You 
can view the NF and print it if needed. 

Deal Types
RMS supports the following three types of deals:

■ Off-Invoice

■ Fixed (Merchandise and Non-merchandise)

■ Complex

RMS generates the following two types of fixed deal:

■ Fixed deal with Merchandise and location information associated

■ Fixed deal non-merchandise with no location and merchandise information 
associated

RMS deal batches generate the deal income on fixed deals in RMS staging tables, based 
on the income calculation and invoicing frequency.

For non-merchandise fixed deals, ORFM will always generate NF details at the Set Of 
Books (SOB) level.

A Complex Deal is created and approved in RMS with a Deal Income calculation 
frequency and an invoicing frequency. Once the Deal Income calculation frequency is 
met, RMS calculates the Deal Income through deal batches and stores them in Deal 
Income related tables. Once the invoicing frequency period for the deal is reached, 
RMS deal batches make this information available in the RMS staging tables to be 
processed by ORFM.

For a deal income processing that happens in RMS, a deal NF is generated in ORFM 
after running the fmdealinc batch.

For more information on Deal Income Batch Processing, see Oracle Retail Fiscal 
Management/RMS Brazil Localization Implementation Guide.
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4Return to Vendor

The Return to Vendor (RTV) operation is considered as the cancellation of the original 
purchase from a fiscal stand point. In order to revert a purchase operation it is 
necessary to associate the RTV NF to the original PO NF that is being returned. Costs 
and taxes from the referenced PONF are taken and proportionally used in the RTV NF 
in order to revert the transaction in all necessary aspects.

It is part of Brazilian legislation, the control of the quantities returned regarding the 
original purchase NFs associated. A balance control is necessary to avoid scenarios 
where same PONF is referenced to multiple RTV NFs exceeding the quantity returned 
in comparison with the quantity purchase.

To initiate the RTV flow in ORFM, the inventory that has to be returned is picked and 
shipped in Warehouse Management System (RWMS) and Store Inventory 
Management System (SIM). 

After the RTV shipment details are available in the ORFM application, it generates an 
outbound schedule and NF.

Business Flow
The process is similar for both the RTV from a store or RTV from a warehouse. The 
business process can include the following:

■ Create an outbound NF from the shipment details. This is automatic step.

■ Enable the auto-approve parameter of the utilization code to validate and approve 
the NF immediately.

■ For manual validation, and approval process, disable the auto-approve parameter 
of the utilization code. Manually edit the NF to resolve the errors that occur 
during the validation process. Here, the validation process includes sending the 
NF to Tax Engine for CFOP determination. For each item being returned, the 
system selects the last received PO related NF for that item from the same supplier 
as the reference NF for the RTV NF. If the last reference NF is found, the taxes on 
RTV NF are copied from that NF. If the last reference NF is not found, the Tax 
Engine call returns the taxes applicable on the RTV transaction.

■ In utilization code, the parameter ’choose NF’ enables users to manually select the 
referenced NF for each line.

■ The new system option, BALANCE_CONTROL_RTV can be used to 
enable/disable the quantity balance control in ORFM. Once enabled, the process 
of automatic or manual reference NF selection will take into consideration the 
quantities received and returned in order to determine which PONF will be taken 
as reference for the RTV.
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■ During NF approval, it is interfaced to NF-e integration that will have the NF-e 
approved in governments system. NF will be turned to status Approved and the 
inventory is updated in RMS. 

NF Processing for RTV with Balance Control Disabled
To create a NF for RTV, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of 
Location. The Location Login window opens.

1. In the Location Login window, select the store or warehouse for receiving/issuing 
of the fiscal document. Click the Location LOV to obtain the list of stores or 
warehouses. Select the location, and click OK.

2. In Contents Of Fiscal Management, click Receiving/Issue. In Contents Of 
Receiving/Issue, click Edit. The Receiving/Issue Schedule window opens. 

Figure 4–1 Schedule Window

3. In the Receiving/Issue Schedule window, set the Mode as Exit. A list of schedules 
will be displayed accordingly to the pre-defined filters. If the schedule you are 
looking for is not displayed, use different filters.

4. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window opens. 

Figure 4–2 Fiscal Docs Find Window

5. Click Detail. The Fiscal Documents window opens.
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Figure 4–3 Fiscal Documents Window

In the Fiscal Documents window, the details of the shipment that is created in 
warehouse management system, and that flows to ORFM are displayed.

In the Fiscal Documents window, the fields that are specific to RTV are covered 
below.

6. If the reference NF for RTV NF issues is set to 'Yes', it is mandatory to inform the 
reference NF for RTV. The Fiscal Doc Ref field will bring a reference NF number 
automatically associated to the RTV being generated. If no reference is there, it was 
not possible to find any PONF to associate and being the reference NF mandatory, 
you will not be able to approve this NF.

7. If the Auto Approve parameter for the utilization code is set to ’Yes’, the NF will 
likely be issued in NFe Pending status or directly in Approved status if the 
integration with NF-e is already completed. 

8. If the Auto Approve parameter for the utilization code is set to 'NO', the NF will 
be in Worksheet status and user has to validate and approve it. From the Options 
menu in the Fiscal Documents window, select Validate. If there are no errors, the 
status of NF changes to Validated.

The NF will be in Error status, if errors occur during the validation process. You 
have to manually edit the NF to resolve validation errors.

9. From the Options menu in the Fiscal Documents window, select Approve. RTV 
NF will be changed to status NFe Pending until NF-e integration is processed. 

Table 4–1 Differences in values for RTV on the Fiscal Documents window

Field Value

Fiscal Document section

Requisition Type This field displays Return to Vendor.

Utilization This field displays the utilization code configured for RTV.

Document Type This field displays the document type configured for RTV.

Mode Type Exit

Header Details section

Transportation Details Tab The Type list displays External Finisher.

Line Item Details section

Detail Info Tab RTV details are displayed in the RTV secondary tab.
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Once that happens, NF will be changed to status Approved. The schedule will be 
changed to status Approved as well. Once NF is approved, inventory is updated 
in RMS.

NF Processing for RTV with Balance Control Enabled
To create a NF for RTV, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of 
Location. The Location Login window opens.

1. In the Location Login window, select the store or warehouse for receiving/issuing 
of the fiscal document. Click the Location LOV to obtain the list of stores or 
warehouses. Select the location, and click OK.

2. In Contents Of Fiscal Management, click Receiving/Issue. In Contents Of 
Receiving/Issue, click Edit. The Receiving/Issue Schedule window opens. In the 
Receiving/Issue Schedule window, set the Mode as Exit. A list of schedules will be 
displayed accordingly to the pre-defined filters. If the schedule you are looking for 
is not displayed, use different filters.

3. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window opens. 

4. Click Detail. The Fiscal Documents window opens. In the Fiscal Documents 
window, the details of the shipment that is created in warehouse management 
system, and that flows to ORFM are displayed.

5. If the reference NF for RTV NF issues is set to 'Yes', it is mandatory to inform the 
reference NF for RTV. The Fiscal Doc Ref field will bring a reference NF number 
automatically associated to the RTV being generated. If no reference is there, it was 
not possible to find any PONF to associate and being the reference NF mandatory, 
user will not be able to approve this NF.

6. If the Auto Approve parameter for the utilization code is set to 'YES' the NF will 
likely be issued in NFe Pending status or directly in Approved status if the 
integration with NF-e is already completed. In this case, and considering the 
Balance Control enabled, there will be at least one reference NF number associated 
to each item of the NF. It is also possible that more than one reference NF got 
associated to the same line item, depending on the balance of quantities available 
in each reference NF versus the quantity being returned. 

7. If the Auto Approve parameter for the utilization code is set to 'NO', the NF will 
be in Worksheet status and you have to validate and approve it. You can also 
manually select the reference NF for each item. This is possible through a new 
popup window created for balance control.

Note: Based on the NF-e line limit set and the item having the 
grouping attribute flagged or not (ST break out), the shipment is 
broken into multiple NFs in ORFM.
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Figure 4–4 Fiscal Documents Window - Fiscal Doc Ref button

8. By clicking the Fiscal Doc Ref button, you will see a working popup window 
where you can manage the Reference NF selection process. This window will list 
all PONFs available to be selected as reference. You can also break the selection 
having multiple NFs being selected based on the quantity returned and the 
balance available in each NF.

Figure 4–5 Fiscal Documents Window - Balance Control Popup Window

9. Once the reference NF selection is complete, you can view the reference NFs for 
each item in the new tab in Fiscal Documents window.

Note: The PO NFs available in this popup window are the ones that 
were received and approved for the item in the location that is 
creating the RTV. Only purchase order related NFs will be displayed 
in this list. It is also possible that Triangulation related NFs appear. 
Users will be able to select triangulation PO NFs, but in this case 100% 
of the item quantity must be linked to a triangulation NF and all other 
items in the RTV must belong to same triangulation NF as well. No 
mix and match will be allowed between Triangulation and Regular PO 
NFs for the reference field.
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Figure 4–6 Fiscal Documents Window - Detail Reference Tab

10. With all items associated to a reference NF, you can validate the RTV NF. From the 
Options menu in the Fiscal Documents window, select Validate. If there are no 
errors, the status of NF changes to Validated.

The NF will be in Error status, if errors occur during the validation process. You 
have to manually edit the NF to resolve validation errors.

11. From the Options menu in the Fiscal Documents window, select Approve. RTV 
NF will be changed to status NFe Pending until NF-e integration is processed. 
Once that happens, NF will be changed to status Approved. The schedule will be 
changed to status Approved as well. Once NF is approved, inventory is updated 
in RMS.
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5Inventory Control

ORFM supports the following inventory functionalities:

■ Transfers

■ Inventory Adjustment

■ Customer Delivery NF

Transfers
Transfer is the movement of merchandise from one location to another, either a 
warehouse or a store. When a transfer is initiated, ORFM creates and issues the related 
NF (based on the transfer information) for the merchandise to be transferred out. After 
the merchandise is shipped, the NF that was created, is matched with the related 
transfers in order to receive the merchandise in the receiving location.

Transfers can be of two types:

■ Transfers (Regular, Intra-company and Inter-company, single-legged transfers)

■ Two-legged Transfers (for finishing and repairing)

Business Flow
The NF processing flow of intra-company transfers is identical to intercompany 
transfers. The process flow for Transfers can be divided into the following 
subprocesses:

■ Transfers Creation in RMS

■ Transfer Shipment at Warehouse

■ Transfer Receiving at Store

Transfer Creation in RMS
1. Create the transfer in RMS either manually or automatically through APIs or 

allocation or replenishment.

2. For the manually-created transfers, enter a valid utilization code.

3. The transfer is interfaced with warehouse management system. If the transfer is 
initiated in warehouse management system as a stock order, it flows to RMS. If the 

Note: For information on creating transfers in RMS, see the Oracle 
Retail Merchandising User Guide.
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RMS initiated transfer is modified in warehouse management system, the 
modifications flows back to RMS. 

Transfer Shipment at Warehouse
1. Create an outbound NF in ORFM after the merchandise are shipped in warehouse 

management system.

The NF is based on the information provided by Warehouse Management System 
(WMS), which includes the transfer cost, and other master data.

2. The cost on the outbound NF generated is configurable based on the system 
option TSF_PURCHASE_PRICE. If this is set as Y, the last purchase price is the 
cost on the NF, else WAC if set as N. 

3. Validate this NF. This NF is sent to Tax Engine to retrieve the CFOP, and for each 
line item and tax breakup details.

4. After the CFOP and tax breakup details are retrieved, approve the NF. 

5. If the Auto-Approve indicator is enabled for the Utilization Code, the NF 
validation and approval is automatic. 

6. As the outbound NF is approved, an inbound NF is created in the background in 
Validated status.

7. Print the NF and send it along with the shipment. The inventory in RMS has to be 
updated after the outbound NF is generated and approved.

Transfer Receiving at Store
1. After the shipment reaches the destination, retrieve the inbound NF that is 

available in ORFM.

2. Since the NF is in Validated status, submit the NF for receiving.

3. The NF receiving process is similar to the NF Processing for receiving except that 
there is no discrepancy and resolution process for transfers.

Note: For seamless NF processing, transfer information has to be 
available in the Oracle Retail Merchandising System (RMS) before the 
transfer is shipped from the shipping location.

Note: The above configuration is valid for intra company transfers 
only.

Note: Because the inbound NF is created using the outbound NF, 
validation exclusively for data integrity is not required. The tax 
breakup and CFOP information for the inbound NF is available as it is 
generated. The NF is created in Validated status.
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NF Processing for Transfers
Create the transfer, and set the utilization code for transfers in RMS. After the 
merchandise is shipped in warehouse management system, create the NF in Exit mode 
for the warehouse. 

For Store to Store Transfers/Store to Warehouse Transfers/Warehouse to Store 
Transfers/Warehouse to Warehouse Transfers, the outbound NF is automatically 
generated on shipment. Here the NF status would be worksheet or approved 
depending on Auto Approve Indicator value set at utilization level. After NF 
approval, ORFM sends shipment details along with calculated cost to RMS. RMS 
updates inventory and post transaction data for stock ledger updates and financial 
postings. The Inbound NF is auto created in Validated status. To process shipment 
receipt, you need to manually trigger publishing of NF Schedule/ASN to receiving 
location through Submit NF for Receiving option on NF window.

To create the NF in the warehouse, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of 
Location. The Location Login window opens.

1. In the Location Login window, select the store/warehouse that is transferring the 
merchandise from the location list. Click OK. You are returned to the main menu.

2. From the RMS Start Menu, select Fiscal Management, then Receiving/Issue. In 
Contents Of Receiving/Issue window, click Edit. The Receiving/Issue Schedule 
window opens.

3. Select the schedule that is created in worksheet status. The Mode is Exit. 

ORFM creates an outbound NF based on the information that flows from 
warehouse management system.

4. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find 
window opens.

5. In the Fiscal Docs Find window, click Add. The Fiscal Document window opens.

In the Fiscal Document window, the differences in values of the fields are as 
follows:

6. In the Fiscal Documents window, from the Options menu, select Validate. The 
CFOP and tax breakup is retrieved from Tax Engine.

The Header Taxes details are as shown below:

Figure 5–1 Header Taxes Tab

Table 5–1 Fields and values for transfers

Fields Values

Requisition Type Transfers. This field is disabled.

Mode Exit
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The Details tab of the Fiscal Documents window displays the line item detail taxes.

Figure 5–2 Detail Taxes Tab

7. If the Auto-Approve indicator is enabled for the Utilization Code, the validation 
process needs no manual intervention.

8. Print the approved outbound NF, and send it along with the shipment. The 
on-hand inventory is reduced at the source warehouse.

9. As the outbound NF is approved, an inbound NF is created in the background in 
Validated status with a new NF number.

Transfers at the Receiving
1. At the receiving store, select the location from the location list in the Location 

Login window.

2. Validated inbound NF is generated based on the approved outbound NF for the 
transfer.

3. In the Receiving/Issue Schedule window, select the schedule with the inbound 
NF. The schedule is in Pending for Receiving status.
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Figure 5–3 Receiving/Issue Schedule Window

4. In the Receiving/Issue Schedule window, click Submit. The receiving process is 
similar to that of PO Receiving, except that there is no discrepancy identification 
and resolution process available for transfers.

5. As the merchandise is received, the status of NF changes to Approved.

Business Flow for Two-Legged Transfer
The business flow for two-legged transfer can be divided into three sub-processes as 
follows:

■ Transfer Creation

■ Two-Legged Transfer Shipment

■ Two-Legged Transfer Receiving

Transfer Creation
■ For two-legged transfers, create the transfer in RMS. If the transfer type is repair, 

the context type is Repairing. After the transfer is approved, RMS creates the 
second leg of the transfer as a separate transfer.

■ RMS publishes the first transfer to Warehouse Management System (RWMS) or 
Store Inventory Management System (SIM).

■ If the context type is Repair, warehouse management system takes in the message 
and creates a stock order, where type = Repair.

Note: Stock orders where type = Repair are not selected in Wave. 
Repair stock orders are handled separately.
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■ In order to repair the merchandise, initiate a transfer in either WMS or RMS. If the 
transfer is used for stocking or finishing the merchandise, you must initiate the 
transfer in RMS only.

Two-Legged Transfer Shipment
■ After the merchandise is sent from either the Warehouse Management System 

(RWMS) or the Store Inventory Management System (SIM), the shipment 
information is published. ORFM uses this shipment information. A NF is 
generated in Exit mode.

■ The transfer cost on the exit NF is equal to the weighted average cost (WAC). The 
taxes and CFOP are retrieved from Tax Engine.

■ After the approved NF is printed, the shipment is ready to move out of the 
location. The inventory in RMS is updated as the outbound NF is approved.

■ If the auto-receiver indicator is enabled at the finisher location, the in-transit 
quantities at the finisher location are automatically cleared. If the indicator is not 
enabled, RMS receives the receipt details.

It is assumed that the shipment quantity has been received at the finisher.

Two-Legged Transfer Receiving
■ When the finished/repaired merchandise is to be returned to the supplier, a valid 

NF has to be generated.

■ Enter the NF in the system that is generated by the repairer/finisher. This is 
inbound flow.

■ Validate the NF for data integrity, and send it to Tax Engine for inbound CFOP 
determination. Tax Engine does not return the taxes, as there is no discrepancy 
identification done for this transaction.

■ Submit the schedule containing this NF to Store Inventory Management System 
(SIM) or Warehouse Management System (SIM).

■ After physical receipt, ORFM uses the receipt message to process the NF. The 
application processes the NF as any other entry NF.

NF Processing for Two-Legged Transfers
For processing of two-legged transfers in ORFM, you have to create the transfer in 
RMS with the context type as Repairing. The warehouse management system has to 
publish the shipment information before the NF processing for two-legged transfer is 
initiated in ORFM. ORFM generates a outbound NF in Approved status, based on the 
shipment information provided by warehouse management system.

For Two legged transfers with finisher, Outbound NF is automatically generated on 
shipment. Inbound NF needs to be manually generated. While capturing Inbound NF 
details in ORFM, you need to identify 'from' location as finisher.

NF Processing for Two-Legged Transfer Shipment  

To process NF for the two-legged transfer shipment, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of 
Location. The Location Login window opens.

1. In the Location Login window, select the store or warehouse that has to receive the 
shipment for repairing/finishing. Click the Location LOV to obtain the list of 
stores or warehouses. Select the location, and click OK.
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2. In Contents of Fiscal Management, click Receiving/Issue. In Contents of 
Receiving/Issue, click Edit. The Receiving/Issue Schedule window opens. On the 
Receiving/Issue Schedule window, click the outbound NF generated by ORFM.

3. Click Fiscal. The Fiscal Docs Find window opens.

4. Click OK. The Fiscal Documents window opens.

In the Fiscal Document section, the Requisition Type is displayed as Repairing, 
and the Utilization field displays the values set in the RMS Transfer Maintenance 
window.

If the Auto Approve parameter is set to ’Y’, the NF is automatically approved. 
Otherwise, the NF has to be manually approved.

5. The inventory in RMS is updated, after the NF is approved. 

NF Processing for Two-Legged Transfer Receiving  

1. In the Location Login window, select the location that receives the merchandise 
after the repairing/finishing work is done.

2. To receive the repaired/finished merchandise, create the schedule in worksheet 
status. Click Add in the Receiving/Issue Schedule window. The NF is created in 
Entry mode.

3. Select the schedule and click Fiscal in the Receiving/Issue Schedule window. The 
Fiscal Docs Find window opens.

4. Click Add. The Fiscal Documents window opens. Select Repairing from the 
Requisition Type LOV for this NF. Select the Utilization from the list. Set the Sub 
Type to External Finisher.

5. From the Options menu, select Validate. If there are no errors, the NF status 
changes to Validated.

6. Click OK. You are returned to the Receiving/Issue Schedule window. In the 
Receiving/Issue Schedule window, from the Options menu, select Sub. for Recv. 
The NF is submitted for receiving.

7. If there are no errors, from the Options menu, select Approve. The NF is 
approved, and the merchandise that has been repaired/finished can be received.

Entry Complementary NF Receiving for Transfers and Intercompany Transfers
The Fiscal Documents window has been adjusted for the receiving of Complementary 
NF for the Requisition Types TSF (Transfer) and IC (Intercompany Transfers).

Therefore you can select entry utilizations for the Transition Types TSF (Transfer) and 
IC (Intercompany Transfers) while entering a CNF.

The Complement button in opens the Complement Fiscal Doc window to associate the 
Complementary NF with the Main NF. 

Note: Based on the NF-e line limit set and the item having the 
grouping attribute flagged or not (ST break out), the shipment is 
broken into multiple NFs in ORFM.

Note: The Main NF associated with the Complementary NF must be 
in status Approved for TSF (Transfers) and IC (Intercompany 
Transfers).
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Transfer Return
The following fiscal utilization setups have been created to distinguish Transfer 
Returns from conventional Transfers:

■ Transfer Return Outbound

Setup:

– Requisition Type is Transfer.

– Issue type is Issue.

– Mode type is Exit, since it is an exit transaction.

– The Nature of Operations is associated with the NOP used to identify the 
transaction as Transfer Return.

■ Transfer Return Inbound

Setup:

– Requisition Type is Transfer.

– Issue type is Include.

– Mode type is Entry, since it is an entry transaction.

– The Nature of Operations is associated with the NOP used to identify the 
transaction as Transfer Return.

■ TSF (Transfer) Return Inter Outbound, for Exit Return Transfer Inter-company

Setup:

– Requisition Type is Inter Company (IC).

– Issue type is Issue.

– Mode type is Exit, since it is an exit transaction.

– The Nature of Operations is associated with the NOP used to identify the 
transaction as Transfer Return Inter-company.

■ TSF (Transfer) Return Inter Inbound, for Entry Return Transfer Inter-company

Setup:

– Requisition Type is Inter Company (IC).

– Issue type is Include.

– Mode type is Entry, since it is an entry transaction.

– The Nature of Operations is associated with the NOP used to identify the 
transaction as Transfer Return Inter-company.

Inventory Adjustment
Inventory adjustments allows total stock-on-hand (SOH) adjustments or unavailable 
(un-sellable) inventory for one or more item/locations.

In Brazil:

■ Stock outs may have taxes associated and requires the generation of a NF to 
properly account for them.

■ NFs can be generated based on inventory adjustments with proper setup through 
the link of a reason code in the Utilization configuration window. The reason code 
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must be the same code used in the inventory adjustment coming from inventory 
management system.

■ NFs generated based on a negative inventory adjustment are restricted to stock 
out transactions. For this type of transaction, the NF is issued in 'Exit' mode with 
source and destination being the same location that created the inventory 
adjustment.

■ Retailers can use inventory adjustment functionality associated to NF generation 
in order to support different fiscal processes such as 'donation' where the NF must 
be generated similarly to a stock out, but the destination is a third-party entity, not 
the same as the source location. In this scenario the setup of the Utilization and 
Reason code is different and the NF is generated using the Standalone NF mode. 
This type of transaction supports negative and positive inventory adjustments.

Business Flow
Negative Stock Out Inventory Adjustments

Figure 5–4 Utilization Setup Form

1. The Utilization options are as follows:

■ Requisition type "Stock Out"

■ Issue "Issue"

■ Nature of Operation (must be configured accordingly to Tax Engine)

■ Mode "Exit"

2. Select Reason Code under Options menu.
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Figure 5–5 Utilization Reason Codes Setup Form

3. The Reason code to be used must have same value of the inventory adjustment 
reason code set in RWMS or SIM.

Processing Flow
1. The Store Inventory Management System (SIM) or Warehouse Management 

System (RWMS) publishes the details of the negative inventory adjustment with 
the reason code previously configured in ORFM.

2. ORFM consumes the inventory adjustment and based on the utilization setup, 
creates an Exit NF.

3. If the auto-approve parameter of the utilization code is set to 'Yes', validation, and 
approval of the NF happens automatically. If the auto-approve parameter of the 
utilization code is set to 'No', validate and approve the NF manually.

4. After the NF has been approved, the inventory is updated in RMS.

Inventory Adjustments with NFs generated to third parties
The configuration necessary in order to generate a standalone NF based on an 
inventory adjustment are as follows:

Figure 5–6 Utilization Setup Form

Note: Based on the stock out Utilization setup, only negative 
inventory adjustments will generate a NF. Positive inventory 
adjustments are not supported in this type of setup.
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1. The Utilization options are as follows:

■ Requisition type "Direct NF"

■ Issue "Issue"

■ Nature of Operation (must be configured accordingly to Tax Engine)

■ Mode "Exit"

2. Select Reason Code under Options menu.

Figure 5–7 Utilization Reason Codes Setup Form

3. The Parameters option in Options menu must only have the following options 
enabled for this type of setup:

■ ICMS-ST Recovery

■ Item Utilization

4. All other options must be disabled.

Processing Flow
1. The store inventory management system, or the warehouse management system 

publishes the details of the negative or positive inventory adjustment with the 
reason code previously configured in ORFM.

2. ORFM consumes the inventory adjustment and based on the utilization setup, 
creates a Standalone NF.

3. You need to access the NF form and complete the source or destination entity data 
in order to validate and approve the NF. In this scenario there is no auto-approve 
option.

4. After the NF has been approved, the inventory is updated in RMS.

Note: The option Doc Type in Options menu must be configured 
accordingly.

Note: If an ORFM user selects the option "ICMS-ST Recovery", the 
system cannot allow the deletion of the reason code associated.
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In case of a negative inventory adjustment configured to generate standalone NF:
1. ORFM will automatically create an exit Standalone NF considering the utilization 

associated to the inventory adjustment reason code.

Figure 5–8 NF Header Form

2. ORFM user will be able to choose whatever third party as the 'addressee' of this 
Standalone NF.

Figure 5–9 NF Header Form

In case of a positive inventory adjustment configured to generate standalone NF:
1. The fields in the tab Destination Details are automatically filled with the location 

data that is creating the Entry NF and to which the goods will be received.
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Figure 5–10 NF Header Form

2. The tab Source Detail will be left for user to complete and will represent the origin 
of the transaction.

Figure 5–11 NF Header Form

Customer Delivery NF
Brazilian retailers dealing in hard lines (electronics and furniture) or selling through 
e-commerce channel often take customer orders and ship merchandise directly to 
customers. For every customer order delivery of merchandise, they issue a Customer 
Nota Fiscal document to accompany the delivery.

Customer Orders are generated in external Customer Order Management (COM) 
system. Customer Orders are based on special orders created at a physical (brick and 
mortar channel) store or a virtual (e-commerce channel) store. Virtual e-commerce 
channel stores may be defined by client as per their business requirements. For 
example, they may be defined based on FedEx, United Parcel Service (UPS) delivery 
methods.

External COM system custom interfaces customer order details to RMS for further 
processing. In response to this request, RMS generates a Customer Order Transfer 
between warehouse and virtual store. RMS publishes this customer order transfer to 
the warehouse management system for picking and shipping of inventory for 
customer delivery. The warehouse management system  communicates shipment 
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details by publishing an ASN Out to ORFM/RMS. ORFM consumes this ASN Out and 
auto-generates a Customer Delivery NF of sales requisition type to accompany the 
shipment. This NF may be printed and included in the delivery. Processing of 
Customer Order Shipment is similar to transfer shipment. Primary difference is that 
only exit NF is generated in case of Customer NF, whereas both exit and entry NFs are 
generated for transfer shipments.  

ASN Out is custom interfaced to External COM system and the External COM further 
interfaces customer order fulfillment sale transaction details to Oracle Retail Sales 
Audit (ReSA) for special order fulfillment sale posting. 

Figure 5–12 Fiscal Documents (fiscal_header) window with Sales Requisition Type

Customer Delivery NF - Future Delivery Flow
A Future Delivery is the requirement where a customer places an order and receives 
the NF (Sale/Invoice), but the product is delivered on a future date. Therefore it is 
necessary to issue a second NF (Shipment). One or multiple shipments can be related 
to same Sale/Invoice NF. The Delivery covers the total of goods, just one NF for the 
Shipment will be issued.

The Future Delivery transaction can be a choice by the customer (end consumer) for 
convenience, or by the retailer mainly when there is not enough stock on hand but is 
expected to be on hand sometime in the future.

The following enhancements have been made in ORFM to handle Customer Order - 
Future Deliveries:

The Customer Order is captured by the OOC and then sent to OMS. OMS requests the 
Sale/Invoice NF from RFM, indicating that it is a Future Delivery CO, which is created 
with no association to a shipment. Only one NF can be issued for each Customer 
Order Future Delivery Sale.

Specific utilizations for each NF (Invoice and Shipment) are created to identify this 
transaction for tax calls purposes.

Later on, OMS submits a Customer Order fulfillment to a physical location (SIM or 
WMS), that results in a delivery NF requested to RFM. This request states that it is 
only a regular Sale.

Note: Customer Delivery NF is generated in Validated status and 
requires manual intervention for approval, if Auto Approve Indicator 
for its utilization is N (No). Customer Delivery NF is validated and 
generated in Approved status, if Auto Approve indicator is Y (Yes). 
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6Return Merchandise Authorization

The Return Merchandise Authorization (RMA) process occurs when the customer 
wants to return the merchandise without visiting the store.

In order to implement the RMA process, the Retail Merchandise System (RMS) and 
Warehouse Management System (RWMS) applications have to be integrated with a 
third-party Customer Order Management (OMS) system. OMS is the application that 
is responsible for managing customer orders throughout their lifecycle and 
communicates with RWMS and RMS and other applications the details of customer 
orders for fulfillment, sales and return processing. Once the return authorization is 
sent to RWMS, it is expected that the information related to the physical receiving of 
the goods is sent from RWMS to RMS and OMS. Based on the physical receiving, OMS 
will provide information to ORFM for the generation of the inbound Nota Fiscal for 
RMA.

Business Flow
1. In case the integration with OMS happens through web service, the RMA NF will 

be created in worksheet or approved status. The validation depends on the 
auto-approve parameter for the utilization for that NF. If the Auto-approve 
parameter for the utilization is set to 'Y', then the NF is validated automatically. 
Otherwise, the validation has to be done manually. 

2. Validate the NF either manually or automatically.

3. Approve the NF if applicable. The NF changes to NFe Pending. Once the NF-e 
integration returns the NFe approval, the NF will be in Approved Status.

NF Processing for RMA
To process NF for RMA, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of 
Location. The Location Login window opens.

1. In the Location Login window, select the store or warehouse for issuing the fiscal 
document. Click the LOV in the Location field to obtain the list of stores or 
warehouses. Select the location, and click OK.

2. In Contents of Fiscal Management, click Fiscal Documents. In Contents Of Fiscal 
Documents, click Fiscal Documents. The Fiscal Find window opens. 
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Figure 6–1 Fiscal Find Window

3. Click Action. From the LOV, select Edit.

4. Use the filters to search for RMA NFs to work.

Figure 6–2 Fiscal Find Search Results Window

5. Click Detail in the selected RMA NF. The selected document is displayed in the 
Fiscal Docs Header window.

Figure 6–3 Fiscal Documents Window

6. Depending on the status of the RMA NF, you can either validate or approve it and 
follow the next status flow. 
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Note:

■ The RMA NF steps of the above flow does not depend on the 
integrations between OMS and RMS/RWMS that are part of the 
base RMA process, however it is expected that the steps required 
in base process happen even in a localization scenario.

■ The inventory updates in RWMS and RMS that are the result of 
these base integrations are expected to happen irrespectively of 
the RMA NF flow. The RMA NF will not update inventory, nor 
will have any impact on the RMS inventory postings (trandata).

■ Approved NFs can be taken by FM TRANDATA and financial 
posting batches. Once RMA NF is in FP status, it will be enabled 
for fiscal reporting.
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7Fiscal Documents

Fiscal Documents for all the requisition types discussed in the previous chapters can 
be accessed using the Fiscal Docs Find window.

Accessing Fiscal Documents
You can access the individual NFs from the schedule window or directly from the 
main menu.

To access the NF from the main menu, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Fiscal 
Documents. The Fiscal Docs Find window opens.

Figure 7–1 Fiscal Docs Find Window

In the Fiscal Docs Find window, the Action field has a list, which contains the 
following: 

Table 7–1 Fields in the Fiscal Docs Find window

Field Description

Action

New To create a new NF, select this Action.

View Only to view the NF. The NF cannot be edited when the Action 
is View.

Edit To edit the NF, select this Action.

Fiscal Document Section
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Creating a New NF
To create a new NF, do the following:

1. In the Fiscal Docs Find window, select New from the Action field, and click OK.

2. In the Fiscal Documents window, enter the details given in Fields in the Fiscal 
Document Header Section.

3. From the Options menu, select Validate. This will validate the details entered in 
the Fiscal Documents Details section.

4. Click OK. The Fiscal Docs Find window opens.

5. Click Close to exit the window. You are returned to the Fiscal Docs Find window.

Searching Fiscal Documents
To search the Fiscal Documents, do the following:

1. In the Fiscal Docs Find window, select Edit from the Action field.

Fiscal No Enter the fiscal number here.

Schedule No Enter the schedule number in this field.

Mode Type The mode type can be either Entry or Exit. Select from the list.

Document Type Select the document type from the list.

Status Select the status of the NF.

Utilization Select the Utilization from the list.

CFOP Enter the CFOP number.

NFe Access Key Applicable only for NF-e.

Sender/Receiver Section

Type This is external entity type from which the NF is received. 

The list includes Supplier, Partner, Location, Outside Location, 
Company, and Customer.

Name Enter the name of the sender/receiver

Sub Type Select the value from the list.

CNPJ/CPF Select the CNPJ/CPF from the list.

Dates Section

Issue Date of issue or stock receipt. Select from the date editor.

Entry/Exit The date the NF was entered.

Exit Hour The exit time of the NF.

Doc Detail Section

Requisition Type Select the Requisition Type.

Doc If the requisition type is PO, the Doc list includes the list of POs.

Item Select the items on the PO.

Table 7–1 (Cont.) Fields in the Fiscal Docs Find window

Field Description
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2. After entering the search criteria, click Search. The Fiscal Docs Find window 
opens. All the NFs that meet search criteria are displayed.

Figure 7–2 Fiscal Docs Find Window

3. Select the NF and click OK. The Fiscal Documents window opens. Here you can 
view and edit the NF details.

4. The following buttons are enabled only when the Fiscal Docs Find window is 
accessed through Schedule window:

■ Add – Click Add to add NF details in the Fiscal Document window.

■ Link – Click Link to link an NF to a schedule.

■ Delink – Click Delink to remove an NF from a schedule.

5. Click Refresh to return to the previous window and enter the criteria again. 

6. Click Close to exit the window. You are returned to the Fiscal Docs Find window.

Searching using Vendor Product Number in the Fiscal Docs Find window
To search using the Vendor Product Number (VPN) in the system, do the following:

1. In the Fiscal Docs Find window, select Edit from the Action field.

2. Click in the Item field, in the Doc Details section.

3. From the Options menu, select Item Number Type. The Item Number Find 
window opens. The fields and descriptions are given below:

Table 7–2 Item Number Find Fields and Description

Field Description

Reference Item The reference item ID and description.

VPN The Vendor Product Number and description.

Line The Line ID and description.

Item The Item ID and description.
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Figure 7–3 Item Number Find Window

4. Enter the VPN number. The VPN description, Line ID, and Line description fields 
are pre-populated.

5. Click OK. The Fiscal Docs Find window opens with the item number and 
description fields pre-populated.

Searching using Vendor Product Number in the Fiscal Documents window
To search using the Vendor Product Number (VPN) in the system, do the following:

1. In the Fiscal Docs Find window, click Add.

2. In the Fiscal Documents Window, enter the details in the Fiscal Documents Details 
section, and Header section. 

3. Select Item in the Line Item Details section. From the Options menu, select Item 
Number Type. The Item Number Find window opens. The fields and descriptions 
are given below:

4. Enter or select the VPN number. The VPN description, Line ID, and Line 
description fields are pre-populated.

5. Click OK. The Fiscal Documents window opens. 

Exit Complementary NF
Exit Complementary NF is generated when taxes or any additional cost is required to 
augment the value of a previously generated NF that by any reason had incorrect 
values. The Exit complementary NF can be generated in ORFM and linked to any 
previously generated NF. Free Form Standalone NF is leveraged to generate exit 
complementary NF and proper setup in utilization is required to enable this 
functionality.

Table 7–3 Item Number Find Fields and Description

Field Description

Reference Item The reference item ID and description.

VPN The Vendor Product Number and description.

Line The Line ID and description.

Item The Item ID and description.

Note: The item number and description fields are pre-populated.
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New Behavior for Exit Complementary NF
To facilitate the NF creation process and avoid errors when entering required data for 
the generation of NF, the system leads you through the form.

The Detail Info tab only displays the required fields for generating the Exit CNF:

■ NF CFOP

■ Quantity

■ UnitCost

■ PIS

■ COFINS

■ Classification CST 

■ Fiscal Doc Ref

■ Total Cost

New Behavior for Associating Exit Complementary NF with Main NF
The Exit Complementary NF is a FFNF but you can associate the NF with a Main NF.

To associate the Exit Complementary NF with the Main NF, follow the steps below.

1. In the Header Info tab, enter the Main NF number directly in the Comp No field, 
or use the Complement button to open the Complement Fiscal Doc window.

Figure 7–4 Complement Fiscal Doc

2. Use the Utilization filter to search for the Main NF by operation or transaction to 
associate with the Exit Complementary NF. 
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3. Select the appropriate utilization and press OK.

4. You are prompted if you want to copy the data from the Main NF, or if you want 
to manually enter the Exit CNF data. 

Figure 7–5 New Prompt for Exit CNF

a. If you select Yes, the system automatically loads all data form the Main NF.

b. If you select No, you have to enter the following information manually in the 
Fiscal Document window.

– In the Fiscal Document section, enter the NF CFOP.

– In the Destination Details tab, enter all information associated with the 
destination.

– In the Detail Info tab, enter all information associated with the items. 

– In the Header Taxes tab, enter all information associated with header 
taxes.

– In the Detail Taxes tab, enter all information associated with item taxes.

5. Click OK to save your entries.

New Validation Rules for Exit Complementary NF
The following validation rules for Exit Complementary NF have been implemented.

Complement Number Required
If you do not enter the Main NF in the Comp No field, the system displays the 
following error message when you are trying to navigate to other windows.

Figure 7–6 Comp No Required for Exit CNF

Fiscal Doc Ref Automatically Entered
In the Detail Info tab, the Fiscal Doc Ref field displays the Complement Number 
automatically. You cannot enter any value.

Note: The system also displays this prompt when you enter the Main 
NF number directly in the Comp No field.
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No Values Permitted
In the Detail Info tab, you are not permitted to enter any values in the Quantity and 
Unit Cost field.

Only One Exit CNF associated with One Main NF
You can only associate one Exit CNF with one Main NF. Therefore, the Main NF is 
displayed in the Comp No field of the Header Info tab and not in the Fiscal Doc Ref 
field in the Detail Info tab.
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8NF-e Cancellation

If a user decides, for any reason, that a NF-e issued by ORFM must be cancelled or 
inactivate, it is possible to do it in ORFM, with the following conditions:

■ It is possible to cancel an NF-e only by issuer location. So it is not possible to 
cancel another NF-e that was issued by another entity or location.

■ The destination location cannot have received the NF-e.

In the same way, when an NF-e is electronically signed by SEFAZ, the NF-e is also 
electronically signed by SEFAZ when it is cancelled.

A user can cancel the NF invoice during the process of NF creation, approval, and after 
the NF is approved through the Fiscal Docs Find form.

An internal sequence is used during NF creation in the ORFM database. The internal 
sequence associated with the NF is stored in the database even when you submit the 
NF. NFs not associated to the official sequence are called pre-NF.

You will be able to see the pre-NF number in the Fiscal Documents form in the same 
field of the NF Fiscal Number. The label of this field will be dynamically updated 
while the Pre-NF Number is displayed. Once the NF is sent for approval, this field will 
be renamed to Fiscal Number and will hold the official NF-e number consumed by the 
sequence. Serial and sub-serial fields will also be updated only when the official 
sequence is consumed. 

The NF can be cancelled in the following scenarios:

■ When the NF is in progress and it was not submitted for approval at SEFAZ

■ When the NF is submitted for approval at SEFAZ but it gets rejected or denied

■ When the NF is approved at SEFAZ and a cancelation is required post-approval

To cancel the NF, do the following: 

From the RMS Start Menu, select Fiscal Management, then Fiscal Documents. 

1. In Contents Of Fiscal Documents, select Fiscal Documents. The Fiscal Docs Find 
window opens.

2. Select either View or Edit from the Action list.

3. From the Options menu, select NF Cancelation as shown in Figure 8–1. 
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Figure 8–1 Cancelling NF-e through Options Menu

The NF Cancelation window opens. 

Figure 8–2 NF Cancelation Window

Table 8–1 NF Cancelation Fields and Description

Fields Description

Schedule This field displays the schedule number if available.

Location ID This field displays the location ID.

Location This field displays the description of the location that issued the 
NF-e or created the schedule. 

User: This field displays the User ID logged in the form.

Pre NF No This field displays the pre-NF sequence number.

Fiscal No This field displays the fiscal document number.

Status This field displays the fiscal document status. 

Requisition Type This field displays the requisition type.

Issue Date This field displays the fiscal document issue date.

Canc.Status This field displays the status of the cancelation action.
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4. Click NF Cancelation. The list displays the NFs that are scheduled to be cancelled.

5. Click OK. The NFs and schedule displays the Cancelation in Progress status and 
the form will be closed. 

6. Click Cancel to cancel the transaction.

Canc.Protocol This field displays the cancelation protocol number returned by 
the NF-e integration. 

Canc.Req.Date This field displays the date for when the NF-e cancelation 
request was submitted to NF-e solution.

Logs This field displays the error log message returned by NF-e 
integration.

Inventory Reversal Steps This field will be dynamically populated with the pre-defined 
inventory reversal step for each type of transaction.

Result This field will be updated with the status of the step execution 
(success or failed).

Logs This field displays the error log for each step.

Table 8–1 (Cont.) NF Cancelation Fields and Description

Fields Description
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9Financial Postings

The Oracle Retail Merchandising System records each transaction (such as PO, 
Transfers, and RTV) in a transaction table. Each transaction may post one or more 
transaction codes into the transaction table. ORFM offers option to map these 
transaction codes with the accounts payable or the general ledger accounts.

The Account Payables (AP) interface has been designed to accept data that will be 
used to create Payment Vouchers and initiate a payment to a vendor. NFs for Purchase 
Orders, RTVs, and complementary NFs related to purchases as well as any for 
non-merchandise costs must be posted to the AP Interface. However, any NFs that are 
not intended to pay an outside party must be posted to General Ledger (GL) interface. 
For example, these would include NFs for Transfers and Inventory Adjustments. 

In ORFM, the postings to AP and GL modules of Enterprise Business Suite (EBS) could 
depend on attributes like utilization code, Tax Code, Cost Component, and Reason 
Code on the NF based on the transaction. For example, for purchases, different AP 
accounts may be impacted based on the utilization code on the NF. Also, the 
recoverable and non-recoverable taxes could be maintained in separate accounts 
depending on the Tax Code.

In addition, new documents like Return NF and the Correction Letter that are 
generated during the discrepancy resolution process, will also have to be interfaced 
with AP.

The ORFM application uses predefined parameters to pass the relevant values to the 
accounts of AP.

Business Flow
The business flow for how ORFM does the transaction data posting is given below:
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Figure 9–1 Process Flow for Financial Postings

The overall process is divided into the following two sub-processes:

1. Define Transaction Codes—The ORFM application provides a table with the list of 
predefined transaction codes used for transaction data posting. For each 
transaction, the transaction code, and the information that is posted vary. For 
different transaction type, the postings are as given below:

■ For PO Receiving the merchandise cost exclusive of taxes, recoverable taxes, 
non-recoverable taxes, and the non-merchandise cost exclusive of taxes are 
posted as a part of transaction data.

■ For Transfers, only the recoverable, and non-recoverable taxes are posted.

■ For rural producers, only the corrected NF is posted to the transaction table. 
The original NF is not posted.

■ For triangulation NF, the original NF along with the ICMS/ICMS-ST details 
based on the complementary NF are posted.

2. Transaction Data Posting—The ORFM application provides a batch program to 
post all the approved NFs in the transaction table. 

The process is divided into the following two broad areas: 

Note: For the different transaction codes, refer to the RMS 
Implementation Guide.
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■ Account Setup

■ Financial Posting 

Figure 9–2 displays the process flow for Account Setup. 

Figure 9–2 Process Flow for Account Setup

Figure 9–3 displays the process flow for Financial Posting.
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Figure 9–3 Process Flow for Financial Posting

Dynamic Segment Setup 
The Dynamic Segment Setup form is used to dynamically determine the account code 
by using data from the transaction level and using the same to derive the segment 
values for individual entity IDs.



Business Flow

Financial Postings 9-5

Editing and Viewing the Dynamic Segment Configuration 
To edit or view the Dynamic Segment Configuration, do the following: 

1. Choose the RMS Start Menu. 

2. Select Fiscal Management > Finance. 

3. In the Contents of Finance, select Dynamic Segment Setup. 

4. In the Contents of Dynamic Segment Setup, click Edit/View.

The Dynamic Segment Configuration window opens. 

Figure 9–4 Dynamic Segment Configuration Window

Table 9–1 Dynamic Segment Configuration Fields and Description

Field Description

Chart of Account Enter the Chart of Account ID or select from the List of Chart Accounts.

Financial System Select the Financial System list to setup the following dynamic 
mappings:

■ Accounts Payable

■ General Ledger 

Search ORFM will search for the existing dynamic mapping records for the 
specified Chart of Accounts ID.

Entity Type You can select the Entity Type for which the dynamic segment values are 
required from the list of Entity Type. 

Following are the values displayed in the list of Entity Type: 

■ Department

■ Class

■ Subclass

■ Location 

■ Transfer Entity

Entity ID The Entity ID is populated based on the Entity Type selected. You can also 
select the Entity ID for which the segment value needs to be defined from 
the List of Values. 

Segment No The Segment No is populated based on the segment number in the COA 
that holds the dynamic values based on the entity types. You can also 
select the Segment Number from List of Segment Numbers.

Segment Value The Segment Value is populated from the account setup based on the 
segment number selected.
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5. Click OK to exit. 

The Contents of Dynamic Segment Configuration Setup window opens.

6. Click Refresh to add new COA setup. 

7. Click Add to add an Entity Type from the Entity Type list.

8. To delete the record, select the record from the multi-record block, and click 
Delete.

The following message opens. 

9. Click Yes to delete the record or, click NO to retain the record. 

10. Click Cancel to undo the changes you specified in the multi-record block.

General Ledger (GL) Cross Reference 
ORFM maps transactions to appropriate accounts in GL and AP system. 

Creating General Ledger Cross Reference 
To create the General Ledger Cross Reference, do the following: 

1. Choose the RMS Start Menu. 

2. Select Fiscal Management > Finance. 

3. In the Contents of Finance, select GL Cross Reference. 

The General Ledger Search window opens.

Figure 9–5 General Ledger Search Window

4. In the Action field, select New. 

The Set Of Books (SOB) field is enabled.
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5. Enter the Set Of Books ID, or select from the List of Set of Books. 

6. Click OK. 

The GL Cross Reference window opens. 

Figure 9–6 GL Cross Reference Window

Note: The Financial System field is editable only to search an 
existing cross reference setup. The Financial System field is not 
applicable for New option.

Table 9–2 GL Cross Reference Fields and Description

Field Description

Sequence No. It is an identifier for selecting a particular cross reference setup.

Financial System It is used to select the Financial System for which cross reference 
is defined. Valid values for Financial System are Accounts 
Payable or General Ledger.

Set Of Books Displays the SOB ID.

Transaction Code It is an unique identifier for the TYPE of transaction. The 
Transaction Code description is displayed when you enter a 
Transaction Code. The LOV can also be used to select a 
Transaction Code. 

Utilization Utilization is displayed based on the Transaction Code selected. 

The description of Utilization is displayed by default.

You can also select Utilization from the List of Utilizations.

Tax Code The Tax Code is displayed based on the Transaction Code 
selected. 

The description of Tax Code is displayed by default.

You can also select Tax Code from the List of Tax Codes.

Reason Code The Reason Code is displayed based on the Transaction Code 
selected. 

The description of Reason Code is displayed by default.

You can also select Reason Code from the List of Reason Codes.
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7. Click OK. 

The General Ledger Search window opens.

8. Click Ok+Repeat.

Clears all the fields to configure a new segment setup with the dynamic attributes 
for a new selected SOB.

9. To delete the record, select the record from the action block, and click Delete. The 
Delete field is available to the user in Edit mode. 

The following message is displayed. 

Cost Component Select the Cost Component from the following list:

■ Freight

■ Insurance

■ Other Expenses

Credit Account Section

Segment The following fields are displayed in the Segment column:

■ Natural Account

■ Company

■ Department

■ Class

■ Sub class

■ Location

■ Transfer Entity

Dynamic Indicator Select the check box. This signifies whether the segment is 
dynamic or generic.

Dynamic Attribute This field is enabled if Dynamic Indicator is selected as Y.

Value This field is enabled if Dynamic Indicator is selected as N.

Debit Account Section

Segment The following fields are displayed in the Segment column:

■ Natural Account

■ Company

■ Department

■ Class

■ Sub class

■ Location

■ Transfer Entity

Dynamic Indicator Select the check box. This signifies whether the segment is 
dynamic or generic.

Dynamic Attribute This field is enabled if Dynamic Indicator is selected as Y.

Value This field is enabled if Dynamic Indicator is selected as N.

Table 9–2 (Cont.) GL Cross Reference Fields and Description

Field Description
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10. Click Cancel to undo the changes you specified in the multi-record block.

Chart of Accounts 
Chart of Accounts (COAs) is the grouping of data elements that define how the 
company’s financial statements are structured and managed. Some of the elements in 
the COAs include Natural Account (Assets, Liabilities, and so on), Cost Center, 
Company, Affiliate, Ledger, and so on. The structure of the General Ledger (GL) is 
based on the financial COAs. 

For more information on set up of Chart of Accounts, see Oracle Retail Fiscal 
Management/RMS Brazil Localization Implementation Guide.

Note: Only the fields that are setup in FM_TRAN_CODES table in 
the REF_NO fields are enabled as shown in Figure 9–5. That is, if tran_
code 100 has REF_NO_1 field set as T - Only Tax code field is enabled. 
Other possible configurable values include, CC for Cost components, 
R for Reason Codes, U for Utilization Code.
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10StandAlone NF

The Direct NF and Free Form NF Requisition types distinguish StandAlone NFs from 
other NFs created within ORFM.   

You can choose Direct NF Requisition type to create StandAlone NF using items, 
locations, and other fiscal entities (supplier, partner, finisher, transporter, and so on) 
that are defined in RMS. 

You can choose Free Form NF Requisition type to add generic items or services that 
are not present in RMS to the NF, or use fiscal entities that are not defined in RMS. The 
Free Form NF allows you to enter a description for each item or service added to the 
NF. 

The Source Details and Destination Details tabs in the Fiscal Documents Window are 
enabled only for both Free Form and Direct NF. The Additional Taxes Info tab is 
enabled only for Free Form NF. 

The following fields are dimmed for requisition types other than Direct and Free Form 
NFs: 

■ Description

■ State Inscription

■ Tributary State

■ Tributary Subscription No

■ Neighborhood

■ Country 

■ Entity in RMS

For more information on the Transportation Details tab, see Chapter 3, "Purchase 
Order".

This chapter covers the following links:

■ Source Details Tab

■ Destination Details Tab

■ Detail Info Tab

■ Additional Taxes Info Tab

Source Details Tab
Figure 10–1 shows the Source Details Tab and the fields and description are provided 
in Table 10–1.
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Figure 10–1 Source Details Tab 

Table 10–1 Fields and Description of Source Details Tab 

Field Description

Source Type You can select any one of the Source Type from the LOV. 

The Source Type LOV includes Agent, Applicant, Bank, Bill To 
Location, Broker, Clearing Zone, Consignee, Consolidator, 
Customer, Discharge Port, Entry Port, Escheat - Country, Escheat 
- State, Expenses Vendor, External Finisher, Factory, Freight 
Forwarder, Import Authority, Importer, LC To Location, Lading 
Port, Return Center, Routing Location, Store, Supplier Site, 
Warehouse.

Source Description This field is auto populated with the description of the Type 
selected.

State Inscription This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Tributary State  This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Tributary Subscription No This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Name This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Address This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

City This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Zip This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Neighborhood This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

State You can specify the field if the Entity in RMS check box is not 
selected. Else the field is dimmed.

Country This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

CNPJ/CPF Enter the CNPJ/CPF number. This field is free form entry if 
Entity in RMS is not selected.
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Destination Details Tab
Figure 10–2 shows the Destination Details Tab and the fields and description are 
provided in Table 10–2.

Figure 10–2 Destination Details Tab

Entity in RMS You have an option to deselect the Entity in RMS check box, for 
an NF having requisition type Free Form NF. For a Direct NF, 
the Entity in RMS check box is selected and dimmed.

Note:

■ The Source Details tab is enabled only if Requisition Type is Direct 
NF or Free Form NF.

■ It is mandatory to capture both Source and Destination Details for 
all StandAlone NFs.

Table 10–2 Fields and Description of Destination Details Tab 

Field Description

Destination Type You can select any one of the Destination Type from the LOV. 

The Destination Type LOV includes store and warehouse.

Destination Description This field is auto populated with the description of the Type 
selected.

State Inscription   This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Tributary State  This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Tributary Subscription No This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Name This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Address This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Table 10–1 (Cont.) Fields and Description of Source Details Tab 

Field Description
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Detail Info Tab
Figure 10–3 shows the Detail Info Tab and the fields and description are provided in 
Table 10–3.

Figure 10–3 Detail Info Tab for Free Form NFs

City This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Zip This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Neighborhood This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

State This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

Country This field is auto populated based on the name or CNPJ/CPF 
selected if Entity in RMS is selected. Else, the field is a free form 
entry.

CNPJ/CPF Enter the CNPJ/CPF number. This field is free form entry if 
Entity in RMS is not selected.

Entity in RMS You have an option to deselect the Entity in RMS check box, for 
an NF having requisition type Free Form NF. For a Direct NF, 
the Entity in RMS check box is selected and dimmed.

Note: The Destination Details tab is enabled only if Requisition Type 
is Direct NF or Free Form NF. 

Table 10–3 Fields and Description of Detail Info Tab for Free Form NFs

Field Description

Service This field is available only for Free Form NFs.

Service Code This field is available only for Free form NFs and if the Service 
check box is selected.

Table 10–2 (Cont.) Fields and Description of Destination Details Tab 

Field Description
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For more information on Detail Info tab, see Chapter 3, "Purchase Order".

Additional Taxes Info Tab
Figure 10–4 shows the Additional Taxes Info Tab and the fields and description are 
provided in Table 10–4.

Figure 10–4 Additional Taxes Info Tab for Free Form NFs

Product Type This field is available only for Free form NFs. 

The Product Type LOV are Goods for Resale, Raw Materials, 
Pack Items, Processed Products, End Products, By Products, 
Intermediate products, Material Use and Consumption, Fixed 
Assets, Services, Other Supplies, Others.

Table 10–4 Fields and Description of Additional Taxes Info Tab for Free Form NFs

Field Description

Type You can select the type from the list. It contains all type of taxes.

Mod.BC Enter the mode of calculation value.

% MVA Enter the value added margin percentage. 

% Reduc.Base Enter the reduced based percentage value.

Table 10–3 (Cont.) Fields and Description of Detail Info Tab for Free Form NFs

Field Description
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11Item Fiscal Reclassification

Item reclassification changes an item’s foundation fiscal attributes. This update is 
necessary when there is a change in an item classification by the government or special 
tributary legislation to specific item class. 

This change in item fiscal attributes can leverage item tax calculation. So a tax call 
happens, recalculating all taxes for this item. However, it is possible to set up the 
system to make a tax call only to some item fiscal attributes.

The Item Reclassification process is flexible, because it is possible to reclassify just one 
item or a set of items at the same time. This set can be grouped by location, supplier, 
merchandise hierarchy, item list or common item fiscal attribute.

Item Reclassification Configuration
In the Item Reclassification Configuration window, a user can define which Item fiscal 
attributes will be displayed in the Item Reclassification Maintenance screen and which 
one will call a tax engine to update fiscal taxes.

Item Reclassification Lot Maintenance
In the Item Reclassification Configuration window, a user can maintain 
(include/change/view) item reclassification change lots. Each lot contains one or more 
item reclassifications.

Users can combine filters on the top to find a specific lot.
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Table 11–1 Fields in the Fiscal Attributes Lot Maintenance

Field Description

Item Field for free insertion, or selection through the "List of Items" to 
search lots with this item.

Country Field for free insertion, or selection through the "List of 
Countries", the country related to the item for which you want to 
search. 

Note: The system should always automatically load, by default, 
the Country of the item defined in the location.

Type Field for selecting, through a list of values, the type of entity 
(Location or Supplier Site) for which you want to search.

Sub Type Field for selecting, through a list of values, the sub type of entity 
(Store or Virtual Warehouse) for which you want to search. 

Note: This field should only be enabled if the Location option 
has been selected in the Type field.

ID Field for free insertion, or selection through the "List of Supplier 
Sites" or "List of Locations" (depending on the selection made in 
the Type field) of the entity for which you want to search.

Lot ID Field for free insertion, or selection through the "List of Lots" 
component, of the number of the Lot to be consulted.

Status Field for selecting, through a list of values, the status of the Lot 
(New, Processing, In Queue, Processed with Errors, Processed 
Successfully or Canceled).

From Create Date Field for free insertion, or selection through the "Date Entry" 
component, of the initial date of creation of the change lot to be 
consulted. 

Note: The system should always load SYSDATE automatically, 
by default.

To Create Date Field for free insertion, or selection through the "Date Entry" 
component, of the final date of creation of the Lot to be 
consulted. 

Note: The system should always automatically load, by default, 
SYSDATE.

Active Date Field for free insertion, or selection through the "Data Entry" 
component, of the activation date of the lot to be consulted.
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Click OK to save the changes.

The other options available on the window includes:

■ Click Add to add a new lot in the multi-record block.

■ Click Detail to open Fiscal Attribute Maintenance window.

■ Click View Error to open a window to see error message of lot with status = error.

■ Click Delete to delete the selected row from the multi-record block.

■ Click Cancel to not save the changes that it is entered.

Item Reclassification Maintenance
The Item Reclassification Maintenance is used to make a reclassification of item or 
group of item. User can verify current fiscal attribute and define new value.

Create User Field for free insertion, or selection through the "List of User Ids" 
component, of the user responsible for creating the lot to be 
consulted.

Lot ID Lot ID

Status Lot status.

Active Date Defines the date of activation of the change (registration and 
reclassification). It must be after the VDate + X days, defined in 
the System Options.

Processed Date Lot processing date.

Create Date Lot creation date.

Create User Lot creation user

Online Indicates whether the change in fiscal attribute should occur 
immediately, without being linked to the reclassification. The 
use of this flag is subject to a System Option.

Bulk Indicates whether the change batch handles bulk change.

Table 11–1 (Cont.) Fields in the Fiscal Attributes Lot Maintenance

Field Description
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Table 11–2 Fields in Fiscal Attributes Maintenance

Field Description

Lot ID Field for free insertion, or selection through the "List of Items" to 
search lots with this item.

Item Field for free insertion, or selection through the "List of 
Countries", the country related to the item for which you want to 
search. 

Note: The system should always automatically load, by default, 
the Country of the item defined in the location.

Item List Field for selecting, through a list of values, the type of entity 
(Location or Supplier Site) for which you want to search.

Division Field for selecting, through a list of values, the sub type of entity 
(Store or Virtual Warehouse) for which you want to search. 

Note: This field should only be enabled if the Location option 
has been selected in the Type field.

Group Field for free insertion, or selection through the "List of Supplier 
Sites" or "List of Locations" (depending on the selection made in 
the Type field) of the entity for which you want to search.

Department Field for free insertion, or selection through the "List of Lots" 
component, of the number of the Lot to be consulted.

Class Field for selecting, through a list of values, the status of the Lot 
(New, Processing, In Queue, Processed with Errors, Processed 
Successfully or Canceled).

Subclass Field for free insertion, or selection through the "Date Entry" 
component, of the initial date of creation of the change lot to be 
consulted. 

Note: The system should always load SYSDATE automatically, 
by default.

Group Field for free insertion, or selection through the "Date Entry" 
component, of the final date of creation of the Lot to be 
consulted. 

Note: The system should always automatically load, by default, 
SYSDATE.

Attribute Field for free insertion, or selection through the "Data Entry" 
component, of the activation date of the lot to be consulted.

Value Field for free insertion, or selection through the "List of User Ids" 
component, of the user responsible for creating the lot to be 
consulted.

Type Lot ID

Sub Type Lot status.

Id Defines the date of activation of the change (registration and 
reclassification). It must be after the VDate + X days, defined in 
the System Options.

Table 11–3 Available Data in "Item/Country" Items Results Grid (to Left)

Field Description

Checkbox Flag that indicates that a change in the value of the tax attribute 
was made for the item. In a list of several items, it informs the 
user which items have already been treated.
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Item Item Code that met the selection criteria defined for creating the 
change batch.

Description Description of the Items that met the selection criteria defined 
for the creation of the change batch.

Table 11–4 Available Data in "Item/Country" Items Results Grid (to Right)

Field Description

Attribute Attributes related to the item selected in the results grid (left).

OLD Value Current values (before the change) of the attributes related to the 
item selected in the results grid (on the left).

New value New values (after the change) of the attributes related to the 
item selected in the results grid (on the left).

This value can be overlaid using the "Apply" button (below the 
grid).

The "Apply" button must work together with the other two 
fields that are on the left: In the first, the user must select the 
attribute to change, and in the second, through free insertion, 
selection through component, or list of values (as provided for in 
the LFAS), you must define the new attribute value.

Reclass Flag that identifies whether the change in the attribute will 
require a tax reclassification

Table 11–5 Available Data in "Item/supplier" Supplier Results Grid (to Left)

Field Description

Item Item code previously selected in the "Item/Country" tab.

Description Description of the item previously selected in the 
"Item/Country" tab.

Checkbox Informative flag that indicates that a change in the value of the 
tax attribute was made for that particular supplier. In a list of 
several suppliers, it is used to let the user know which suppliers 
have already been treated.

Supplier Code of suppliers that are associated with the item previously 
selected in the "Item/Country" tab.

Description Corporate name of suppliers that are associated with the item 
previously selected in the "Item/Country" tab.

Table 11–6 Available Data in "Item/supplier" Supplier Results Grid (to Right)

Field Description

Attribute Attributes related to the supplier selected in the results grid 
(left).

OLD Value Current values (before the change) of the attributes related to the 
selected supplier in the results grid (on the left).

Table 11–3 (Cont.) Available Data in "Item/Country" Items Results Grid (to Left)

Field Description
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NEW Value New values (after the change) of the attributes related to the 
supplier selected in the results grid (on the left).

This value can be overlaid using the "Apply" button (below the 
grid).

The "Apply" button must work together with the other two 
fields that are on the left: In the first, the user must select the 
attribute that he wants to change, and in the second, through 
free insertion, selection through component, or list of values (* as 
provided for in the LFAS), you must define the new attribute 
value.

Reclass Informative flag that identifies whether the change in the 
attribute will require or not a tax reclassification.

Table 11–7 Available Data in "Item/location" Supplier Results Grid (to Left)

Field Description

Item Item code previously selected in the "Item/Country" tab.

Description Description of the item previously selected in the 
"Item/Country" tab.

Checkbox Informative flag that indicates that a change in the value of the 
tax attribute was made for that particular location. In a list of 
several locations, it serves to let the user know which locations 
have already been treated

Location Code of the locations that are associated with the item 
previously selected in the "Item/Country" tab.

Location Type Type of locations (Store / Warehouse) that are associated with 
the item previously selected in the "Item/Country" tab.

Description Corporate name of the locations that are associated with the item 
previously selected in the "Item/Country" tab.

Table 11–8 Available Data in "Item/location" Supplier Results Grid (to Right)

Field Description

Attribute Attributes related to the location selected in the results grid 
(left).

OLD Value Current values (before the change) of the attributes related to the 
selected supplier in the results grid (on the left).

NEW Value New values (after the change) of the attributes related to the 
supplier selected in the results grid (on the left).

This value can be overlaid using the "Apply" button (below the 
grid).

The "Apply" button must work together with the other two 
fields that are on the left: In the first, the user must select the 
attribute that he wants to change, and in the second, through 
free insertion, selection through component, or list of values (* as 
provided for in the LFAS), you must define the new attribute 
value.

Reclass Informative flag that identifies whether the change in the 
attribute will require a tax reclassification.

Table 11–6 (Cont.) Available Data in "Item/supplier" Supplier Results Grid (to Right)

Field Description
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Click OK to save the changes.

The other options available on the window includes:

■ Click OK + Repeat to confirm maintenance actions and continue in the same 
screen to create a new lot.

■ Click Cancel to not save the changes that it is entered and exit current screen.
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12Invoice Receiving Layer Monitor

The Invoice Receiving Layer (IRL) monitor is designed to capture and support NF-e 
XML files in receiving processes, provided by PO based.

It is supported on NF-e version 3.10 and 4.00 and CT-e v2.00 and v3.00.

The IRL monitor allows you to follow the status and consult any error messages; 
adjust inconsistent data, insert missing data or associate documents that require 
manual association; revalidating a previous fiscal document has required intervention; 
or refuse a fiscal document preview that you do not want to adjust.

Depending on your system's settings you may access all records regardless of the 
location or you must log in to a specific location.

Navigate: From the RMS Start Menu, select Fiscal Management > Invoice Receiving 
Layer. In the Contents of Invoice Receiving Layer, select IRL Monitor. The IRL Monitor 
window opens.

Figure 12–1 Invoice Receiving Layer Option

The IRL Monitor is a monitoring and intervention tool, and can be used in a 
centralized or decentralized way. A localized System Option, IRL_ALLOWS_
MULTISITE is created to define the form.

If the contents of the System Option is "Y", the system displays and allows access to all 
records, from any location.

If the contents of the System Option is "N", before displaying the IRL Monitor form, 
the system requests to log in to a specific location. Consequently, the system only 
displays and allows access to the records of the location to which the login was made.
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Figure 12–2 Location Login (loc_login) Window

Figure 12–3 IRL Monitor Window

Table 12–1 Fields in the IRL Monitor Window

Field Description

Search Criteria Section

Fiscal No. Enter the fiscal document number.

Model You can check through the list of values, the fiscal document 
model: 55-NF-e or 57-CT-e.

NFe Access Key Enter the fiscal document access key.

From Receipt Date Enter or select through "Date Entry" component, the initial date 
of receipt of the fiscal document XML file.

To Receipt Date Enter or select through "Date Entry" component, the end date of 
receipt of the fiscal document XML file.

From Issue Date Enter or select through "Date Entry" component, the initial issue 
of the fiscal document date.
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Click OK, to access Fiscal Documents Preview window for consultation and 
maintenance of fiscal document preview detail.

Click Doc. Fiscal, to access Fiscal Documents window or maintenance of fiscal 
document.

Click Close, to exit the IRL Monitor window.

Options Menu
The Options menu contains the following functions:

To Issue Date Enter or select through "Date Entry" component, the end date of 
issue of the fiscal document.

Issuer Enter or select through component "List of Supplier Sites", the 
code and description of the issuer of the fiscal document.

CNPJ/CPF Issuer Enter or select through component "List of CNPJ/CPF", of the 
CPF or CNPJ of the issuer of the fiscal document.

Receiver Enter or select through component "List of Supplier Sites", the 
code and description of the issuer of the fiscal document.

CNPJ/CPF Receiver Enter or select through component "List of CNPJ/CPF", of the 
CPF or CNPJ fiscal document recipient.

Shows Unidentified 
Receivers 

Check box to define whether or not the records for which it has 
not been possible to identify the recipient.

Order No. Enter or select through component "List of POs", PO code 
associated with the fiscal document.

IRL Status Enter or select through component "List of IRL Status".

Search Results Section

Check box Allows you to select or un select the record listed in grid.

NFe Access Key Fiscal document access key listed in grid.

Issuer Code and description of the issuer of the fiscal document listed 
in grid (ascending or descending).

Receiver Code and description of the recipient of the fiscal document 
listed in grid (ascending or descending).

IRL Status Status of fiscal document preview listed in grid (ascending or 
descending).

File Name File name of fiscal document preview listed in grid.

Table 12–2 Options Menu Function and Description

Function Description

View Status Log Provides, through the canvas "IRL Status Log", access to the 
history of prior validation of selected fiscal document.

View Error Log Provides, through the canvas "IRL Error Log", access to critical 
validation of prior history of fiscal document selected.

Revalidate Allows to resubmit a fiscal document to a new validation 
process.

Table 12–1 (Cont.) Fields in the IRL Monitor Window

Field Description
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Status History Log
The Status History Log option allows you to access the status history by which the 
XML file passed, from inception to physical receipt. You can access the status history 
log by selecting the specific record, and from the Options menu, choose View Status 
Log option.

Figure 12–4 IRL Monitor Window - View Status Log Option

The status are listed in descending order by the date they were registered, so the status 
displayed at the top of the query is the most recent status.

Figure 12–5 IRL Status Log Window

Refusal Allows, through the new decision message "IRL Receipt Refusal" 
to refuse receipt of the prior fiscal document selected which 
has/have been examined and that you do not wish to adjust.

XML Download Allows to download the original XML file.

Table 12–2 (Cont.) Options Menu Function and Description

Function Description
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Click OK, to close the IRS Status Log window.

Figure 12–6 Invoice Receiving Layer - XML Status Flow

Validation Error Log
The Validation Error Log option allows you to access all messages resulting from any 
criticism of the validation. The messages allow you to analyze and decide to intervene 
in the document flow.

Accessing the View Error Log
To access the view error, follow the steps listed below.

Navigate: From the RMS Start Menu, select Fiscal Management > Invoice Receiving 
Layer. In the Contents Of Invoice Receiving Layer, select IRL Monitor. The IRL 
Monitor opens.

1. Select a record from the Search Results section.

2. From the Options menu, select View Error Log option.

Table 12–3 Fields in the IRL Status Log Window

Field Description

ID Displays the status ID.

Status Description Displays the description of the status.

Status Date Displays the date and time when the status was registered.
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Figure 12–7 IRL Monitor Window - View Error Log Option

The system provides the history of errors through which the XML file has passed.

Errors are listed in descending order of the date they were recorded, so the errors 
displayed at the top of the query are errors resulting from the last validation 
performed.

Figure 12–8 IRL Error Log Window

Click OK, to close the IRL Error Log window.

Table 12–4 Available columns in the IRL Error Log Window

Column Description

NFe Information Validated information that was obtained from the XML file.

System Information Validated information that was obtained from the RMS/RFM 
system.

Error Description Description of the error identified during the validation steps.

Error Date Date and time when the error listed in the grid was registered.

Status Displays the date and time when the status was registered.

Status Date Displays two type of errors: Open (error that has not been 
treated), Close (error that has been taken care of).
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Fiscal Document Preview Detail View
You can consult the detail of information extracted from the XML file serving as a basis 
for the generation of the fiscal document. Depending on the status of the preview, you 
can edit information. You can edit documents holding one of the following status:

■ Rejected In Pre-Validation

■ Waiting Associate Document

■ Rejected in EDI Validation

Accessing the Fiscal Document Preview
To access the fiscal document preview, follow the steps listed below.

Navigate: From the RMS Start Menu, select Fiscal Management > Invoice Receiving 
Layer. In the Contents Of Invoice Receiving Layer, select IRL Monitor. The IRL 
Monitor window opens.

1. Select a record and press OK. The Fiscal Document Preview window opens.

Figure 12–9 Fiscal Document Preview Window

Table 12–5 Fields and Description of NFe Section

Field Description

Fiscal No. Displays the number of the fiscal document.

Serial No. Displays the serial of the fiscal document.

NFe Access Key Displays the access key of the fiscal document.

NOP Displays the operation nature of the fiscal document.

Model Displays the fiscal document model.

Finality Displays the purpose of the fiscal document.

Table 12–6 Fields and Description of NFe Maintenance Section

Field Description

IRL Status Displays the status in currently the fiscal document preview.
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Issue Date Displays the date of issuing the fiscal document.

Exit Date Displays the date of the fiscal document.

Table 12–7 Fields and Description of Issuer Section

Field Description

CNPJ/CPF Displays the CNPJ/CPF of the recipient of the fiscal document.

Name Displays the name of the recipient of the fiscal document.

State Displays the recipient's fiscal document UF.

Table 12–8 Fields and Description of Receiver Section

Field Description

CNPJ/CPF Displays the CNPJ/CPF of the recipient of the fiscal document.

Name Displays the name of the recipient of the fiscal document.

State Displays the recipient's fiscal document UF.

Table 12–9 Fields and Description of Payments Section

Field Description

Date Displays the date of payment of invoices.

Value Displays the value of invoices.

Table 12–10 Fields and Description of Header - Total Costs Section

Field Description

Service Displays the total value of services contained in the fiscal 
document.

Merchandise Displays the total value of merchandise contained in the fiscal 
document.

Discount Displays the total value of the discounts contained in the fiscal 
document.

Total Displays the total value of the fiscal document.

Table 12–11 Fields and Description of Header - Additional Costs Section

Field Description

Freight Displays the total amount of freight is contained in fiscal 
document.

Insurance Displays the total amount of insurance contained in the fiscal 
document.

Other Expenses Displays the total amount of other expenses contained in the 
fiscal document.

Table 12–6 (Cont.) Fields and Description of NFe Maintenance Section

Field Description
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Table 12–12 Fields and Description of Header - Purchase Order Section

Field Description

PO No. Enter or select through component List of POs, PO code 
associated, or if you want to associate, to the fiscal document.

Apply Click Apply to confirm the Association of PO to the fiscal 
document replicating the number of PO for all items that are 
attached to the fiscal document.

Table 12–13 Fields and Description of Details - Items Section

Field Description

Line Displays the sequence number of the item within the fiscal 
document.

PO Enter or select through component List of POs, PO code 
associated, or if you want to associate, to the item.

Unexpected Item Flag to display if the item has not been requested (without PO).

VPN Displays the vendor code that identifies the item within the 
fiscal document.

EAN Displays the EAN Code that identifies the item within the fiscal 
document.

Item Enter or select through component List of Items, the internal 
code that identifies the item in RMS.

Description Displays the description that identifies the item within the fiscal 
document.

Unit Displays the SKU of the item unit within the fiscal document.

Qty Displays the SKU of the item quantity within the fiscal 
document.

Unit Cost Displays the SKU unit cost of the item within the fiscal 
document.

Discount Displays the discount on the SKU unit cost of the item within the 
fiscal document.

Total Cost Displays the total cost of the item within the fiscal document.

FCI Number Displays the FCI code of the item within the fiscal document.

Table 12–14 Buttons and Description of NFe Maintenance Section

Button Description

OK Click OK to confirm any changes made in Fiscal Document 
preview.

Refresh Click Refresh to undo any changes made in Fiscal Document 
preview.

Close Click Close to close the window maintenance fiscal document 
preview.

Table 12–15 NFe Maintenance Options Menu Function and Description

Function Description

Worksheet Provides fiscal document preview for editing.
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Figure 12–10 Fiscal Document Preview Window - Header Taxes and Detail Taxes Section

View Status Log Provides, through the canvas "IRL Status Log", access to the 
history of fiscal document preview validation.

View Error Log Provides, through the canvas "IRL Error Log", access to the 
critical history of validation of fiscal document preview.

Revalidate Allows to submit to a new validation fiscal document preview. 

Refusal Allows you to refuse the receipt of fiscal document preview.

XML Download Allows to download the original XML file.

Delete Allows to logically delete a fiscal document preview.

Table 12–16 Fields and Description of Header Taxes - Total Taxes Section

Field Description

ICMS Basis Displays the value of the basis of ICMS in the fiscal document.

ICMS Value Displays the value of the ICMS in the fiscal document.

ICMS ST Basis Displays the value of the basis of ICMS ST in the fiscal 
document.

ICMS ST Value Displays the value of the ICMS ST in the fiscal document.

IPI Value Displays the value from the basis of IPI in the fiscal document.

PIS Value Displays the value of PIS in the fiscal document.

COFINS Value Displays the value of COFINS in the fiscal document.

II Value Displays the value of II in the fiscal document.

ISS Basis Displays the value from the basis of ISS in the fiscal document.

ISS Value Displays the value of the ISS in the fiscal document.

Fiscal Additional Info Displays the additional information from the fiscal document.

Table 12–15 (Cont.) NFe Maintenance Options Menu Function and Description

Function Description
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Table 12–17 Fields and Description of Detail Taxes - Item Taxes Section

Field Description

Line Displays the sequence number of the item within the fiscal 
document.

Description Displays the description that identifies the item within the fiscal 
document.

CFOP Displays the CFOP of the item within the fiscal document.

NCM Displays the NCM of the item within the fiscal document.

Origin Displays the origin code of the item within the fiscal document.

ICMS CST Displays the code of the item's ICMS CST within the fiscal 
document.

ICMS Basis Displays the value of the item´s ICMS basis within the fiscal 
document.

ICMS Value Displays the value of the item´s ICMS within the fiscal 
document.

ICMS ST Basis Displays the value of the item´s ICMS ST basis within the fiscal 
document.

ICMS ST Value Displays the value of the item´s ICMS ST within the fiscal 
document.

IPI CST Displays the item's code of IPI CST within the fiscal document.

IPI Value Displays the value of the item´s IPI within the fiscal document.

PIS CST Displays the item's code of PIS CST within the fiscal document.

PIS Value Displays the value of the item´s PIS within the fiscal document.

COFINS CST Displays the item's code of COFINS CST within the fiscal 
document.

COFINS Value Displays the value of the item´s COFINS within the fiscal 
document.

II Value Displays the value of the item´s II within the fiscal document.

Custom Value Displays the value of the item´s custom within the fiscal 
document.

ISS Basis Displays the value of the item´s ISS basis within the fiscal 
document.

ISS Value Displays the value of the item´s ISS within the fiscal document.
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Figure 12–11 Fiscal document Preview - Associated Documents

Table 12–18 Fields and Description of Fiscal Document Preview Window - Associated 
Documents Section

Field Description

NFe Access Key Enter the access key fiscal document that will be supplemented.

CNPJ/CPF Enter the CNPJ/CPF of the issuer of the fiscal document that 
will be supplemented.

Fiscal No. Enter the fiscal document number that will be supplemented.

Serial No. Enter the fiscal document series that will be supplemented.

Table 12–19 Buttons and Description of NFe Maintenance Section

Button Description

Add Click Add to manually add to the list a fiscal document that will 
be supplemented.

Delete Click Delete to delete the list and a fiscal document that would 
be complemented.

Link Click Link to select by component, and add to the list, a fiscal 
document which will be complemented.
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Figure 12–12 Fiscal Document Preview Window - Transportation Section

Table 12–20 Fields and Description of Transportation - Transporter Section

Field Description

CNPJ/CPF Displays the CNPJ/CPF of the carrier of the merchandise 
described in the fiscal document.

Name Displays the name of the carrier of the merchandise described in 
the fiscal document.

State Inscription Displays the State Inscription of the carrier of the merchandise 
described in the fiscal document.

Address Displays the address of the carrier of the merchandise described 
in the fiscal document.

State Displays the State of the carrier of the merchandise described in 
the fiscal document.

City Displays the city of the carrier of the merchandise described in 
the fiscal document.

Plate State Displays the vehicle plate of the carrier of the merchandise 
described in the fiscal document.

Vehicle Plate Displays the State vehicle Board of the carrier of the 
merchandise described in the fiscal document.

Freight Type Displays the type of Freight used by the carrier of the 
merchandise described in the fiscal document.

Table 12–21 Fields and Description of Transportation - Volumes Section

Field Description

Qty. Displays the amount of volumes transported the merchandise 
described in the fiscal document.

UOM Displays the volumes transported unit of the merchandise 
described in the fiscal document.

Net Weight Displays the net weight of the transported volume of 
merchandise described in the fiscal document.

Total Weight Displays the gross weight of transported volumes of the 
merchandise described in the fiscal document.
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Figure 12–13 Fiscal Document Preview Window - Refusal Section

Fiscal Document Preview Inconsistent Information Maintenance
An XML file may not have all the necessary information for the continuity of the fiscal 
document generation process, and may be blocked by the pre-validation process. You 
can maintain some inconsistent data, insert some missing data, or associate documents 
that require manual association.

Accessing the fiscal document preview inconsistent information maintenance
To access the fiscal document preview inconsistent information maintenance, follow 
the steps listed below.

1. From the Options menu, select Worksheet option.

Table 12–22 Fields and Description of Refusal Section

Field Description

Code Displays identifying the type of refusal (CODE_DETAIL: code_
type = 'IRLR').

Refusal Date Displays the Date and time of the refusal.

Description Displays the reason for the refusal.
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Figure 12–14 Fiscal Document Preview - Worksheet Option

You can only edit the fiscal document preview that are in one of the following three 
status: 301- REJECTED IN PRE-VALIDATION, 302- WAITING ASSOCIATE 
DOCUMENT or 307- REJECTED IN EDI VALIDATION.

The treatment of other rejection status, which occur already with the fiscal document 
generated and linked to the preview (402- REJECTED IN COMERCIAL VALIDATION 
or 501- REJECTED IN FISCAL VALIDATION), continues to be done through the 
treatment of discrepancies, or adjusted (401- REJECTED IN COMERCIAL/FISCAL 
VALIDATION), or even recused (702- REJECTED IN SEFAZ VALIDATION) through 
the fiscal document maintenance form.

Records linked to status indicating refusal cannot be processed (101- REFUSED IN 
STRUCTURAL VALIDATION, 202- REFUSED IN SEFAZ VALIDATION, 304- 
REFUSED BY UNKNOWN OPERATION, 305- REFUSED BY DISAGREEMENT, 306- 
REFUSED AUTOMATICALLY AFTER PRE-VALIDATION or 6- REFUSED 
RECEIVING).

Not all data is available for maintenance, only those that do not interfere with the 
integrity of the fiscal document authorized by SEFAZ and that are essential to the 
process of deduction for fiscal receiving. The list of data that can be adjusted are as 
follows:

The status of the XML associated with the document adjusted through this 
functionality is: 303- ADJUSTED AND WAITING REVALIDATION.

PO Maintenance
The fiscal document issued by the supplier is the result of attending to a PO, which 
was previously generated and that contains the terms of the negotiation, including the 
items that were negotiated.

In the XML file this information may have been set at the fiscal document level or at 
the item level. It is also possible for the supplier to enter the PO code at both levels. 
These possibilities are foreseen and, in the maintenance, can be treated when they 
present some type of inconsistency that results in rejection in the pre-validation.
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PO Maintenance in Fiscal Document Level
You can inform or select a PO and click Apply, to replicate at the item level. In RFM 
the PO code must always be set at the item level.

Figure 12–15 Fiscal Document Preview Window - Purchase Order in Fiscal Document 
Level

PO Maintenance in item Level
You can inform or select the PO for a certain item.

Figure 12–16 Fiscal Document Preview Window - Purchase Order in Item Level

Item Code Maintenance
You can inform or select an item. The Item Code Maintenance field is enabled only if 
there is an informed PO. Or if the Unexpected Item flag is checked.
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Figure 12–17 Fiscal Document Preview - Item Code Maintenance

Unexpected Item Definition
This flag is enabled only if there is no PO informed in the item line. You can indicate 
that it is an item for which it will not be informed PO and that, therefore, it will be 
returned in a Return NF in the end of this PO Receiving.

When the flag is enabled, you can enter or select any item.

Figure 12–18 Fiscal Document Preview - Unexpected Item

Pack Number Definition
You can use VPN to identify the Pack associated with the Item invoiced, when it is an 
item purchased by the Pack and invoiced by the Components.
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Figure 12–19 Fiscal Document Preview - VPN 

Associated Document Maintenance
This maintenance is only allowed for fiscal document preview whose status, after 
rejection in the pre-validation, is 302- WAITING ASSOCIATE DOCUMENT. For other 
records, both the grid and the action buttons are disabled.

You can enter directly into the grid, through the Access Key or through the 
composition CNPJ+NF+Series, the reference document that you wish to associate with 
the complementary NF, or select it by clicking Add. You can even enter or select 
multiple reference documents.

Figure 12–20 Fiscal Document Preview - Associated Document Maintenance

Other Available Functions
The available options for the IRL Monitor main window are also available in the Detail 
window of the Fiscal Document Preview.

The available options are as follows:
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Figure 12–21 Fiscal Document Preview - Other Functions

■ View Status Log: To view the status history

■ View Error Log: To view the history of errors resulting from validations

■ Revalidate: To revalidate the preview that has been adjusted

■ Refusal: To refuse a preview rejected in the validations and do not want to adjust

■ XML Download: To download the XML file that gave rise to the previous

■ Delete: To logically delete a refused preview that you want to receive again

Fiscal Document Preview Revalidation
To revalidate an XML file that has already been validated and adjusted, use the 
Revalidate option to submit the file again. You can only revalidate fiscal document 
previews which are holding the status Adjusted and Waiting Revalidation.

You can access by selecting one or more records and in Options menu, choose the 
Revalidate.

Figure 12–22 IRL Monitor Window - Revalidate Option
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If you confirm revalidation, the system submits the record to a new validation.

The status of the XML associated with the document revalidated through this 
functionality is: 1- RECEIVED.

Thus, the fiscal document preview is once again available for processing by the 
pre-validation process, which has already been described previously.

XML File Refused by IRL_PO_SUPP_NOT_EQUAL Revalidation
If the PO indicated in the XML file is not associated with the same supplier branch 
indicated in the XML file as the issuer, but both belong to the same supplier, the 
system allows you to decide to receive the XML file, even with this "divergence" 
Through a decision message displayed at the time of revalidation.

Refusal of Receiving
During the XML pre-validation process, you may conclude that the document should 
not be received. 

Figure 12–23 IRL Monitor - Refusal Option

Only the fiscal document preview that are in one of the following three status can be 
refused: 

■ 301 - Rejected in Pre-Validation

■ 302 - Waiting Associate Document

Note: Only the fiscal document preview that are in the status 303- 
Adjusted and waiting revalidation can be revalidated.

Note: This exception exists because commercially it may be 
convenient for the PO to be addressed to a branch of the supplier and 
delivered by another branch, but it can also be an inconvenience. For 
this reason an XML file in this condition is rejected in the 
pre-validation, however you may conclude that the document should 
not be received.
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■ 307 - Rejected in EDI Validation

The other rejection statuses must be handled through the cancellation available on the 
fiscal document form.

Refused by Operation Unknown
Refusal of receipt may occur due to lack of knowledge of the operation. For example, 
why the issuer of the XML file is not recognized as a supplier of the recipient.

The system displays option for you to select the reason.

Figure 12–24 Refusal Reason Select with Unknown Operation

The status of the XML associated with the document refused due to unknown of the 
operation is: 304- REFUSED BY UNKNOWN OPERATION.

Refused by Commercial Disagreement
Or the refusal can also be motivated by commercial disagreement. For example, why 
merchandise referenced by the issuer in XML is not recognized as a recipient's order.

The system displays option for you to select the reason.

Figure 12–25 Refusal Reason Select with Not Agreed Reason

The XML status associated with the document refused due to commercial 
disagreement is: 305- REFUSED BY DISAGREEMENT.

Refused Reason Detail Option
The system provides the possibility for the user to justify in more detail the reason for 
the refusal. This is an optional possibility, which can be defined through a System 
Option, IRL_REASON_DESCRIPTION.

If the contents of the System Option is "N", the system does not require to justify in 
more detail the reason for the refusal.
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If the contents of the System Option are "Y", at the time after the reason for the refusal 
is selected, the system must justify in more detail the reason for the refusal.

Figure 12–26 Optional Reason Description

Automatic Refusal Parameterizable
The system also provides the possibility for the user to define the automatic refusal of 
invoice exams that have been rejected in the pre-validation stage and that may require 
analysis and intervention, being at the discretion of each client to opt or not for its use 
through System Option Configuration, IRL_AUTO_REFUSAL.

If the System Option content is "Y", after registering the status indicating the rejection 
in the pre-validation process, the system automatically rejects the XML file, assuming 
the Automatic Refusal.

If the contents of the System Option is "N", the system disregards automatic refusal.

The status of the XML associated with the automatically refused document is: 306- 
REFUSED AUTOMATICALLY AFTER PRE-VALIDATION.

The system also allows the user to define a default description to justify automatic 
cancellation in more detail. This description is defined through a System Option, IRL_
AUTO_REFUSAL_DESCRIPTION.

XML File Download
If the System Option that indicates that the XML file is processed and without error in 
the database is enabled, you have the option to download the XML file to a local 
folder.

You can access one or more records by clicking Options, XML Download option.

Note: The automatic refusal process provides a settings table (FM_
IRL_OPTIONS) that can be used to indicate which rejection reasons 
will be considered in automatic refusal.
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Figure 12–27 IRL Monitor Window - XML Download option

The system displays option you to define the destination folder of the files.

Figure 12–28 XML File Download

Logical Deletion
The common rule implemented defines that an XML file can be received only once. 
Once it has been approved and rejected in one of the validation steps, it can only be 
adjusted and revalidated, or refused.

If, for example, the process receives an XML file without authorization protocol, the 
status will be Refused in Structural Validation.

In this situation, even if the provider sends a second XML file containing the 
authorization protocol, it will be rejected in the pre-validation by the uniqueness rule, 
which in no way allows re-entry of the same access key (or combination 
CNPJ/NF/Series).

The logical deletion allows rejected XML files to be allowed to re-enter, being at the 
discretion of the user to allow it to happen, when it is deemed necessary.

A System Option has been created to define whether or not the new Logical Deletion 
feature is available for use on the IRL Monitor, IRL_LOGICAL_DELETION.

If the content is set to "N", the new logical deletion process is not available for use 
through the IRL Monitor.

If the defined content is "Y", the new logical deletion process is available for use 
through the IRL Monitor.
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To access the new logical deletion feature, select a record in the grid, and in Options 
select Delete.

Figure 12–29 IRL Monitor Window - Delete Option

Only the fiscal document preview that are in one of the following three status can be 
rejected: 

■ 101 - REFUSED IN STRUCTURAL VALIDATION

■ 202 - REFUSED IN SEFAZ VALIDATION

■ 304 - REFUSED BY UNKNOWN OPERATION

■ 305 - REFUSED BY DISAGREEMENT

■ 306 - REFUSED AUTOMATICALLY AFTER PRE-VALIDATION

■ 6 - REFUSED RECEIVING

■ 802 - PHYSICAL RECEIVING REFUSED

Rejection status should be handled through the maintenance and refusal options 
already available on the IRL Monitor.

The status of the XML associated with the deleted document is: 9- DELETED BY 
USER.

Physical Receiving of Merchandise Associated with the XML File
After fiscal document passed for all IRL receiving status, this NF is in Validated status 
in ORFM. This NF can be linked to a schedule and starts the receiving process.
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The only intervention needed is a new request is sent to SEFAZ before submitting for 
receiving to the physical receiving, to ensure that it has not been canceled.
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